About the Tutorial

The Microsoft Foundation Class (MFC) library provides a set of functions, constants, data types, and classes to simplify creating applications for the Microsoft Windows operating systems. In this tutorial, you will learn all about how to start and create Windows-based applications using MFC.

Audience

This tutorial is designed for all those developers who are keen on developing best-in-class applications using MFC. The tutorial provides a hands-on approach with step-by-step program examples, source codes, and illustrations that will assist the developers to learn and put the acquired knowledge into practice.

Prerequisites

To gain advantage of this tutorial you need to be familiar with programming for Windows. You also need to know the basics of programming in C++ and understand the fundamentals of object-oriented programming.

Disclaimer & Copyright

© Copyright 2016 by Tutorials Point (I) Pvt. Ltd.

All the content and graphics published in this e-book are the property of Tutorials Point (I) Pvt. Ltd. The user of this e-book is prohibited to reuse, retain, copy, distribute or republish any contents or a part of contents of this e-book in any manner without written consent of the publisher.

We strive to update the contents of our website and tutorials as timely and as precisely as possible, however, the contents may contain inaccuracies or errors. Tutorials Point (I) Pvt. Ltd. provides no guarantee regarding the accuracy, timeliness or completeness of our website or its contents including this tutorial. If you discover any errors on our website or in this tutorial, please notify us at contact@tutorialspoint.com.
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About the Tutorial</td>
<td>i</td>
</tr>
<tr>
<td>Audience</td>
<td>i</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>i</td>
</tr>
<tr>
<td>Disclaimer &amp; Copyright</td>
<td>i</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>ii</td>
</tr>
<tr>
<td>1. MFC - OVERVIEW</td>
<td>1</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>1</td>
</tr>
<tr>
<td>What is MFC?</td>
<td>1</td>
</tr>
<tr>
<td>MFC Framework</td>
<td>1</td>
</tr>
<tr>
<td>Why MFC?</td>
<td>2</td>
</tr>
<tr>
<td>2. MFC - ENVIRONMENT SETUP</td>
<td>3</td>
</tr>
<tr>
<td>3. MFC - VC++ PROJECTS</td>
<td>8</td>
</tr>
<tr>
<td>4. MFC - GETTING STARTED</td>
<td>9</td>
</tr>
<tr>
<td>Create Project Using Project Templates</td>
<td>9</td>
</tr>
<tr>
<td>Create Project from Scratch</td>
<td>14</td>
</tr>
<tr>
<td>5. MFC - WINDOWS FUNDAMENTALS</td>
<td>19</td>
</tr>
<tr>
<td>Window Creation</td>
<td>24</td>
</tr>
<tr>
<td>Main Window</td>
<td>25</td>
</tr>
<tr>
<td>Windows Styles</td>
<td>27</td>
</tr>
<tr>
<td>Windows Location</td>
<td>29</td>
</tr>
<tr>
<td>Windows Size</td>
<td>30</td>
</tr>
<tr>
<td>Windows Dimensions</td>
<td>31</td>
</tr>
<tr>
<td>Windows Parents</td>
<td>32</td>
</tr>
</tbody>
</table>
11. MFC - WINDOWS CONTROLS ................................................................. 128

Static Control ....................................................................................... 128
Animation Control ................................................................................ 128
Button .................................................................................................... 134
Bitmap Button ....................................................................................... 137
Command Button .................................................................................. 139
Static Text ............................................................................................. 142
List Box .................................................................................................. 144
Combo Boxes .......................................................................................... 153
Radio Buttons .......................................................................................... 159
Checkboxes ........................................................................................... 164
Image Lists ............................................................................................ 178
Edit Box .................................................................................................. 182
Rich Edit .................................................................................................. 187
Group Box .............................................................................................. 198
Spin Button ............................................................................................ 199
Managing the Updown Control ............................................................. 201
Progress Control ................................................................................... 206
Progress Bars ......................................................................................... 210
Timer ...................................................................................................... 213
Date & Time Picker ............................................................................... 217
Picture .................................................................................................... 222
Image Editor ........................................................................................... 225
Slider Controls ....................................................................................... 228
Scrollbars ............................................................................................... 235
Tree Control ............................................................................................ 237
List Control ............................................................................................. 245
12. MFC - MESSAGES AND EVENTS ................................................................. 254
   Overview ...................................................................................................... 254
   Map of Messages ......................................................................................... 254
   Windows Messages ...................................................................................... 258
   Command Messages ................................................................................... 264
   Keyboard Messages .................................................................................... 264
   Mouse Messages ......................................................................................... 267

13. MFC - ACTIVEX CONTROL ..................................................................... 270

14. MFC - FILE SYSTEM .............................................................................. 276
   Drives .......................................................................................................... 276
   Directories .................................................................................................. 280
   File Processing ............................................................................................ 284

15. MFC - STANDARD I/O ........................................................................... 288

16. MFC - DOCUMENT VIEW ....................................................................... 294
   View ........................................................................................................... 294
   Document .................................................................................................. 294
   Frame ......................................................................................................... 294
   Single Document Interface (SDI) ................................................................. 294
   Multiple Document Interface (MDI) ............................................................. 296

17. MFC - STRINGS ...................................................................................... 300
   Create String .............................................................................................. 302
   Empty String .............................................................................................. 303
   String Concatenation .................................................................................. 305
   String Length ............................................................................................. 306
   String Comparison ....................................................................................... 308
18. MFC - CARRAY

Create CArray Object ................................................................. 310
Add items .................................................................................. 311
Retrieve Items .......................................................................... 311
Add Items in the Middle ............................................................. 313
Update Item Value..................................................................... 315
Copy Array ................................................................................ 317
Remove Items ........................................................................... 319

19. MFC - LINKED LISTS .............................................................. 322

Singly Linked List ....................................................................... 322
Doubly Linked List ..................................................................... 322
CList Class ................................................................................. 323
Create CList Object .................................................................. 324
Add items .................................................................................. 324
Retrieve Items .......................................................................... 324
Add Items in the Middle ............................................................. 326
Update Item Value..................................................................... 328
Remove Items ........................................................................... 330

20. MFC - DATABASE CLASSES .................................................. 333

CDatabase ................................................................................ 333
Insert Query .............................................................................. 335
Retrieve Record ........................................................................ 337
Update Record ......................................................................... 342
Delete Record .......................................................................... 346

21. MFC - SERIALIZATION .......................................................... 351
22. MFC - MULTITHREADING ................................................................. 358

23. MFC - INTERNET PROGRAMMING ............................................. 367

24. MFC - GDI ................................................................. 381
   Drawing ................................................................. 381
   Lines ................................................................. 387
   Polylines ............................................................. 390
   Rectangles ............................................................ 391
   Squares ............................................................... 393
   Pies ................................................................. 394
   Arcs ................................................................. 396
   Chords ............................................................... 398
   Colors ............................................................... 399
   Fonts ................................................................. 401
   Pens ................................................................. 403
   Brushes ............................................................. 404

25. MFC - LIBRARIES ............................................................... 407
   Static Library .......................................................... 407
   Dynamic Library ..................................................... 421
1. MFC - Overview

The Microsoft Foundation Class (MFC) library provides a set of functions, constants, data types, and classes to simplify creating applications for the Microsoft Windows operating systems. In this tutorial, you will learn all about how to start and create windows based applications using MFC.

Prerequisites

We have assumed that you know the following:

- A little about programming for Windows.
- The basics of programming in C++.
- Understand the fundamentals of object-oriented programming.

What is MFC?

The Microsoft Foundation Class Library (MFC) is an "application framework" for programming in Microsoft Windows. MFC provides much of the code, which are required for the following:

- Managing Windows.
- Menus and dialog boxes.
- Performing basic input/output.
- Storing collections of data objects, etc.

You can easily extend or override the basic functionality the MFC framework in your C++ applications by adding your application-specific code into MFC framework.

MFC Framework

- The MFC framework provides a set of reusable classes designed to simplify Windows programming.
- MFC provides classes for many basic objects, such as strings, files, and collections that are used in everyday programming.
- It also provides classes for common Windows APIs and data structures, such as windows, controls, and device contexts.
- The framework also provides a solid foundation for more advanced features, such as ActiveX and document view processing.
- In addition, MFC provides an application framework, including the classes that make up the application architecture hierarchy.
Why MFC?

The MFC framework is a powerful approach that lets you build upon the work of expert programmers for Windows. MFC framework has the following advantages.

- It shortens development time.
- It makes code more portable.
- It also provides tremendous support without reducing programming freedom and flexibility.
- It gives easy access to "hard to program" user-interface elements and technologies.
- MFC simplifies database programming through Data Access Objects (DAO) and Open Database Connectivity (ODBC), and network programming through Windows Sockets.
Microsoft Visual C++ is a programming environment used to create applications for the Microsoft Windows operating systems. To use MFC framework in your C++ application, you must have installed either Microsoft Visual C++ or Microsoft Visual Studio. Microsoft Visual Studio also contains the Microsoft Visual C++ environment.

Microsoft provides a free version of visual studio which also contains SQL Server and it can be downloaded from https://www.visualstudio.com/en-us/downloads/download-visual-studio-vs.aspx.

Following are the installation steps.

**Step 1:** Once Visual Studio is downloaded, run the installer. The following dialog box will be displayed.

![Visual Studio Installer](image.png)

**Step 2:** Click Install to start the installation process.
Community 2015

Acquiring:
Microsoft Build Tools Language Resources 14.0 (x86)

Applying:
Microsoft .NET Framework 4.6
Step 3: Once Visual Studio is installed successfully, you will see the following dialog box.

![Visual Studio Setup Completed Dialog Box]

Step 4: Close this dialog box and restart your computer if required.
**Step 5:** Open Visual studio from the Start menu, which will open the following dialog box. It will take some time for preparation, while starting for the first time.

![Visual Studio](image)

**Visual Studio**

We're preparing for first use

This may take a few minutes.
Step 6: Next, you will see the main window of Visual Studio.

Step 7: You are now ready to start your application.
In this chapter, we will be covering the different types of VC++ projects. Visual Studio includes several kinds of Visual C++ project templates. These templates help to create the basic program structure, menus, toolbars, icons, references, and include statements that are appropriate for the kind of project you want to create. Following are some of the salient features of the templates.

- It provides wizards for many of these project templates and helps you customize your projects as you create them.
- Once the project is created, you can build and run the application.
- You don't have to use a template to create a project, but in most cases it's more efficient to use project templates.
- It's easier to modify the provided project files and structure than it is to create them from scratch.

In MFC, you can use the following project templates.

<table>
<thead>
<tr>
<th>Project Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MFC Application</td>
<td>An MFC application is an executable application for Windows that is based on the Microsoft Foundation Class (MFC) Library. The easiest way to create an MFC application is to use the MFC Application Wizard.</td>
</tr>
<tr>
<td>MFC ActiveX Control</td>
<td>ActiveX control programs are modular programs designed to give a specific type of functionality to a parent application. For example, you can create a control such as a button for use in a dialog, or toolbar or on a Web page.</td>
</tr>
<tr>
<td>MFC DLL</td>
<td>An MFC DLL is a binary file that acts as a shared library of functions that can be used simultaneously by multiple applications. The easiest way to create an MFC DLL project is to use the MFC DLL Wizard.</td>
</tr>
</tbody>
</table>

Following are some General templates which can also be used to create MFC application:

<table>
<thead>
<tr>
<th>Project Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empty Project</td>
<td>Projects are the logical containers for everything that's needed to build your application. You can then add more new or existing projects to the solution if necessary.</td>
</tr>
<tr>
<td>Custom Wizard</td>
<td>The Visual C++ Custom Wizard is the tool to use when you need to create a new custom wizard. The easiest way to create a custom wizard is to use the Custom Wizard.</td>
</tr>
</tbody>
</table>
In this chapter, we will look at a working MFC example. To create an MFC application, you can use wizards to customize your projects. You can also create an application from scratch.

**Create Project Using Project Templates**

Following are the steps to create a project using project templates available in Visual Studio.

**Step 1:** Open the Visual studio and click on the File -> New -> Project menu option.

**Step 2:** You can now see that the New Project dialog box is open.

**Step 3:** From the left pane, select Templates -> Visual C++ -> MFC

**Step 4:** In the middle pane, select MFC Application.

**Step 5:** Enter the project name ‘MFCDemo’ in the Name field and click OK to continue. You will see the following dialog.
Step 6: Click Next.
**Step 7:** Select the options which are shown in the dialog box given above and click Next.
**Step 8:** Uncheck all options and click Finish button.
You can now see that the MFC wizard creates this Dialog Box and the project files by default.

**Step 9:** Run this application, you will see the following output.
Create Project from Scratch

You can also create an MFC application from scratch. To create an MFC application, you need to follow the following Steps.

**Step 1:** Open the Visual studio and click on the File - > New - > Project menu option.

**Step 2:** You can now see the New Project dialog box.
Step 3: From the left pane, select Templates -> Visual C++ -> General.

Step 4: In the middle pane, select Empty.

Step 5: Enter project name ‘MFCDemoFromScratch’ in the Name field and click OK to continue. You will see that an empty project is created.
**Step 6:** To make it an MFC project, right-click on the project and select Properties.
Step 7: In the left section, click Configuration Properties -> General.

Step 8: Select the Use MFC in Shared DLL option in Project Defaults section and click OK.

Step 9: As it is an empty project now; we need to add a C++ file. So, right-click on the project and select Add -> New Item...

Step 10: Select C++ File (.cpp) in the middle pane and enter file name in the Name field and click Add button.
Step 11: You can now see the main.cpp file added under the Source Files folder.

Step 12: Let us add the following code in this file.

```cpp
#include <iostream>
using namespace std;

void main()
{
    cout << "******************************************************************************\n";
    cout << "MFC Application Tutorial";
    cout << "\n******************************************************************************";
    getchar();
}
```

Step 13: When you run this application, you will see the following output on console.

```
******************************************************************************
MFC Application Tutorial
******************************************************************************
```
In this chapter, we will be covering the fundamentals of Windows. To create a program, also called an application, you derive a class from the MFC's CWinApp. **CWinApp** stands for *Class for a Windows Application*.

Let us look into a simple example by creating a new Win32 project

**Step 1:** Open the Visual studio and click on the File -> New -> Project menu option.

**Step 2:** You can now see the New Project dialog box.

![New Project Dialog Box](image)

**Step 3:** From the left pane, select Templates -> Visual C++ -> Win32.

**Step 4:** In the middle pane, select Win32 Project.

**Step 5:** Enter the project name ‘MFCWindowDemo’ in the Name field and click OK to continue. You will see the following dialog box.
Step 6: Click Next.
Step 7: Select the options as shown in the dialog box given above and click Finish.
Step 8: An empty project is created.

Step 9: To make it an MFC project, right-click on the project and select Properties.
**Step 10:** In the left section, click Configuration Properties -> General.

**Step 11:** Select the Use MFC in Shared DLL option in Project Defaults section and click OK.

**Step 12:** Add a new source file.

**Step 13:** Right-click on your Project and select Add -> New Item...

**Step 14:** In the Templates section, click C++ File (.cpp)
Step 15: Set the Name as Example and click Add.

Window Creation

Any application has two main sections:
- Class
- Frame or Window

Let us create a window using the following steps:

Step 1: To create an application, we need to derive a class from the MFC’s CWinApp.

```cpp
class CExample : public CWinApp
{
    BOOL InitInstance()
    {
        return TRUE;
    }
};
```
**Step 2:** We also need a frame/window to show the content of our application.

**Step 3:** For this, we need to add another class and derive it from the MFC's **CFrameWnd** class and implement its constructor and a call the Create() method, which will create a frame/window as shown in the following code.

```cpp
class CMyFrame : public CFrameWnd
{
public:
    CMyFrame()
    {
        Create(NULL, _T("MFC Application Tutorial"));
    }
};
```

**Step 4:** As you can see that Create() method needs two parameters, the name of the class, which should be passed as NULL, and the name of the window, which is the string that will be shown on the title bar.

---

**Main Window**

After creating a window, to let the application use it, you can use a pointer to show the class used to create the window. In this case, the pointer would be CFrameWnd. To use the frame window, assign its pointer to the CWinThread::m_pMainWnd member variable. This is done in the InitInstance() implementation of your application.

**Step 1:** Here is the implementation of InitInstance() in CExample class.

```cpp
class CExample : public CWinApp
{
    BOOL InitInstance()
    {
        CMyFrame *Frame = new CMyFrame();
        m_pMainWnd = Frame;

        Frame->ShowWindow(SW_NORMAL);
        Frame->UpdateWindow();

        return TRUE;
    }
};
```
Step 2: Following is the complete implementation of Example.cpp file.

```cpp
#include <afxwin.h>

class CMyFrame : public CFrameWnd
{
public:
    CMyFrame()
    {
        Create(NULL, _T("MFC Application Tutorial"));
    }
};

class CExample : public CWinApp
{
    BOOL InitInstance()
    {
        CMyFrame *Frame = new CMyFrame();
        m_pMainWnd = Frame;

        Frame->ShowWindow(SW_NORMAL);
        Frame->UpdateWindow();

        return TRUE;
    }
};
CExample theApp;
```
Step 3: When we run the above application, the following window is created.

Windows Styles

Windows styles are characteristics that control features such as window appearance, borders, minimized or maximized state, or other resizing states, etc. Following is a list of styles which you can use while creating a Window.

<table>
<thead>
<tr>
<th>Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WS_BORDER</td>
<td>Creates a window that has a border.</td>
</tr>
<tr>
<td>WS_CAPTION</td>
<td>Creates a window that has a title bar (implies the WS_BORDER style).</td>
</tr>
<tr>
<td>WS_CHILD</td>
<td>Creates a child window. Cannot be used with the WS_POPUP style.</td>
</tr>
<tr>
<td>WS_CHILDWINDOW</td>
<td>Same as the WS_CHILD style.</td>
</tr>
<tr>
<td>WS_CLIPCHILDREN</td>
<td>Excludes the area occupied by child windows when you draw within the parent window. Used when you create the parent window.</td>
</tr>
<tr>
<td>WS_CLIPSIBLINGS</td>
<td>Clips child windows relative to each other; that is, when a particular child window receives a paint message, the WS_CLIPSIBLINGS style clips all other overlapped child windows out of the region of the child window to be updated. (If WS_CLIPSIBLINGS is not given and child windows overlap, when you draw within the client area of a child window, it is possible to draw within the client area of a neighboring child window.) For use with the WS_CHILD style only.</td>
</tr>
<tr>
<td>WS_DISABLED</td>
<td>Creates a window that is initially disabled.</td>
</tr>
<tr>
<td>WS_DLGFRA ME</td>
<td>Creates a window with a double border but no title.</td>
</tr>
<tr>
<td>WS_GROUP</td>
<td>Specifies the first control of a group of controls in which the user can move from one control to the next with the arrow keys. All controls defined with the WS_GROUP style FALSE after</td>
</tr>
</tbody>
</table>
the first control belong to the same group. The next control with the WS_GROUP style starts the next group (that is, one group ends where the next begins).

<table>
<thead>
<tr>
<th>Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WS_HSCROLL</td>
<td>Creates a window that has a horizontal scroll bar.</td>
</tr>
<tr>
<td>WS_ICONIC</td>
<td>Creates a window that is initially minimized. Same as the WS_MINIMIZE style.</td>
</tr>
<tr>
<td>WS_MAXIMIZE</td>
<td>Creates a window of maximum size.</td>
</tr>
<tr>
<td>WS_MAXIMIZEBOX</td>
<td>Creates a window that has a Maximize button.</td>
</tr>
<tr>
<td>WS_MINIMIZE</td>
<td>Creates a window that is initially minimized. For use with the WS_OVERLAPPED style only.</td>
</tr>
<tr>
<td>WS_MINIMIZEBOX</td>
<td>Creates a window that has a Minimize button.</td>
</tr>
<tr>
<td>WS_OVERLAPPED</td>
<td>Creates an overlapped window. An overlapped window usually has a caption and a border.</td>
</tr>
<tr>
<td>WS_OVERLAPPEDWINDOW</td>
<td>Creates an overlapped window with the WS_OVERLAPPED, WS_CAPTION, WS_SYSMENU, WS_THICKFRAME, WS_MINIMIZEBOX, and WS_MAXIMIZEBOX styles.</td>
</tr>
<tr>
<td>WS_POPUP</td>
<td>Creates a pop-up window. Cannot be used with the WS_CHILD style.</td>
</tr>
<tr>
<td>WS_POPUPWINDOW</td>
<td>Creates a pop-up window with the WS_BORDER, WS_POPUP, and WS_SYSMENU styles. The WS_CAPTION style must be combined with the WS_POPUPWINDOW style to make the Control menu visible.</td>
</tr>
<tr>
<td>WS_SIZEBOX</td>
<td>Creates a window that has a sizing border. Same as the WS_THICKFRAME style.</td>
</tr>
<tr>
<td>WS_SYSMENU</td>
<td>Creates a window that has a Control-menu box in its title bar. Used only for windows with title bars.</td>
</tr>
<tr>
<td>WS_TABSTOP</td>
<td>Specifies one of any number of controls through which the user can move by using the TAB key. The TAB key moves the user to the next control specified by the WS_TABSTOP style.</td>
</tr>
<tr>
<td>WS_THICKFRAME</td>
<td>Creates a window with a thick frame that can be used to size the window.</td>
</tr>
<tr>
<td>WS_TILED</td>
<td>Creates an overlapped window. An overlapped window has a title bar and a border. Same as the WS_OVERLAPPED style.</td>
</tr>
<tr>
<td>WS_TILEDWINDOW</td>
<td>Creates an overlapped window with the WS_OVERLAPPED, WS_CAPTION, WS_SYSMENU, WS_THICKFRAME, WS_MINIMIZEBOX, and WS_MAXIMIZEBOX styles. Same as the WS_OVERLAPPEDWINDOW style.</td>
</tr>
<tr>
<td>WS_VISIBLE</td>
<td>Creates a window that is initially visible.</td>
</tr>
<tr>
<td>WS_VSCROLL</td>
<td>Creates a window that has a vertical scroll bar.</td>
</tr>
</tbody>
</table>

Step 1: Let us look into a simple example in which we will add some styling. After creating a window, to display it to the user, we can apply the WS_VISIBLE style to it and additionally, we will also add WS_OVERLAPPED style. Here is an implementation:

```c++
class CMyFrame : public CFrameWnd
{
public:
    CMyFrame()
    {
```
Create(NULL, _T("MFC Application Tutorial"), WS_VISIBLE |
WS_OVERLAPPED);
};

Step 2: When you run this application, the following window is created.

You can now see that the minimize, maximize, and close options do not appear anymore.

Windows Location

To locate things displayed on the monitor, the computer uses a coordinate system similar to the Cartesian's, but the origin is located on the top left corner of the screen. Using this coordinate system, any point can be located by its distance from the top left corner of the screen of the horizontal and the vertical axes.

The Win32 library provides a structure called POINT defined as follows:

typedef struct tagPOINT {
    LONG x;
    LONG y;
} POINT;

- The 'x' member variable is the distance from the left border of the screen to the point.
The 'y' variable represents the distance from the top border of the screen to the point.

Besides the Win32's POINT structure, the Microsoft Foundation Class (MFC) library provides the CPoint class.

This provides the same functionality as the POINT structure. As a C++ class, it adds more functionality needed to locate a point. It provides two constructors.

```
CPoint();
CPoint(int X, int Y);
```

Windows Size

While a point is used to locate an object on the screen, each window has a size. The size provides two measures related to an object.

- The width of an object.
- The height of an object.

The Win32 library uses the SIZE structure defined as follows:

```
typedef struct tagSIZE {
    int cx;
    int cy;
} SIZE;
```

Besides the Win32's SIZE structure, the MFC provides the CSize class. This class has the same functionality as SIZE but adds features of a C++ class. It provides five constructors that allow you to create a size variable in any way of your choice.

```
CSize();
CSize(int initCX, int initCY);
CSize(SIZE initSize);
CSize(POINT initPt);
CSize(DWORD dwSize);
```
**Windows Dimensions**

When a Window displays, it can be identified on the screen by its location with regards to the borders of the monitor. A Window can also be identified by its width and height. These characteristics are specified or controlled by the *rect* argument of the `Create()` method. This argument is a rectangle that can be created through the Win32 RECT structure.

```c
typedef struct _RECT {
    LONG left;
    LONG top;
    LONG right;
    LONG bottom;
} RECT, *PRECT;
```

Besides the Win32's `RECT` structure, the MFC provides the `CRect` class which has the following constructors:

```c
CRect();
CRect(int l, int t, int r, int b);
CRect(const RECT& srcRect);
CRect(LPCRECT lpSrcRect);
CRect(POINT point, SIZE size);
CRect(POINT topLeft, POINT bottomRight);
```

Let us look into a simple example in which we will specify the location and the size of the window.

```c
class CMyFrame : public CFrameWnd
{
public:
    CMyFrame()
    {
        Create(NULL, _T("MFC Application Tutorial"), WS_SYSMENU, CRect(90, 120, 550, 480));
    }
};
```

When you run this application, the following window is created on the top left corner of your screen as specified in CRect constructor in the first two parameters. The last two parameters are the size of the Window.
**Windows Parents**

In the real world, many applications are made of different Windows. When an application uses various Windows, most of the objects depend on a particular one. It could be the first Window that was created or another window that you designated. Such a Window is referred to as the **Parent Window**. All the other windows depend on it directly or indirectly.

- If the Window you are creating is dependent of another, you can specify that it has a parent.
- This is done with the pParentWnd argument of the CFrameWnd::Create() method.
- If the Window does not have a parent, pass the argument with a NULL value.

Let us look into an example which has only one Window, and there is no parent Window available, so we will pass the argument with NULL value as shown in the following code:

```cpp
class CMyFrame : public CFrameWnd
{
public:
    CMyFrame()
    {
        Create(NULL, _T("MFC Application Tutorial"), WS_SYSMENU, CRect(90, 120, 550, 480), NULL);
    }
};
```
When you run the above application, you see the same output.
In this chapter, we will be covering the Dialog boxes. Applications for Windows frequently communicate with the user through dialog boxes. **CDialog class** provides an interface for managing dialog boxes. The Visual C++ dialog editor makes it easy to design dialog boxes and create their dialog-template resources.

- Creating a dialog object is a two-phase operation:
  - Construct the dialog object.
  - Create the dialog window.

Let us look into a simple example by creating a new Win32 project

**Step 1:** Open the Visual studio and click on the File -> New -> Project menu option.

**Step 2:** You can now see the New Project dialog box.

**Step 3:** From the left pane, select Templates -> Visual C++ -> Win32.

**Step 4:** In the middle pane, select Win32 Project.

**Step 5:** Enter project name ‘MFCDialogDemo’ in the Name field and click OK to continue. You will see the following dialog.
Step 6: Click Next.
**Step 7:** Select the options shown in the dialog box given above and click Finish.
**Step 8:** An empty project is created.

**Step 9:** To make it a MFC project, right-click on the project and select Properties.
Step 10: In the left section, click Configuration Properties -> General.

Step 11: Select the Use MFC in Shared DLL option in Project Defaults section and click OK.

Step 12: Add a new source file.

Step 13: Right-click on your Project and select Add -> New Item.

Step 14: In the Templates section, click C++ File (.cpp)
Step 15: Set the Name as Example and click Add.

Step 16: To create an application, we need to add a class and derive it from the MFC's CWinApp.

```cpp
#include <afxwin.h>

class CExample : public CWinApp
{
public:
    BOOL InitInstance();
};
```
Dialog Box Creation

**Step 1:** To create a dialog box, right-click on the Resource Files folder in solution explorer and select Add -> Resource.

![Add Resource Dialog](image)

**Step 2:** In the Add Resource dialog box, select Dialog and click New.

**Step 3:** A dialog box requires some preparation before actually programmatically creating it.

**Step 4:** A dialog box can first be manually created as a text file (in a resource file).

**Step 5:** You can now see the MFCDialogDemo.rc file created under Resource Files.
**Step 6:** The resource file is open in designer. The same can be opened as a text file. Right-click on the resource file and select Open With.
**Step 7:** Select the Source Code (Text) editor and click Add button.

**Step 8:** Go back to the designer and right-click on the dialog and select Properties.
Step 9: You need to choose out of the many options.

Step 10: Like most other controls, a dialog box must be identified. The identifier (ID) of a dialog box usually starts with IDD_, Let us change the ID to IDD_EXAMPLE_DLG.

Dialog Location

A dialog box must be “physically” located on an application. Because a dialog box is usually created as a parent to other controls, its location depends on its relationship to its parent window or to the desktop.

If you look and the Properties window, you see two fields, X Pos and Y Pos.
- X is the distance from the left border of the monitor to the left border of the dialog box.

- Y is the distance from the top border of the monitor to the top border of the dialog box.

By default, these fields are set to zero. You can also change as shown above.

If you specify these two dimensions as 0, the left and top borders of the dialog box would be set so the object appears in the center-middle of the screen.
**Dialog Box Dimensions**

The dimensions of a dialog box refer to its width and its height. You can resize the width and height with the help of mouse in designer window.

![Dialog Box Dimensions](image)

You can see the changes in width and height on the Status Bar.

**Dialog Box Methods**

The base class used for displaying dialog boxes on the screen is CDialog class. To create a dialog box, we need to derive a class from CDialog. The CDialog class itself provides three constructors which are as follows:

```cpp
CDialog();
CDialog(UINT nIDTemplate, CWnd* pParentWnd = NULL);
CDialog(LPCTSTR lpszTemplateName, CWnd* pParentWnd = NULL);
```
Let us create another class CExampleDlg and derive it from CDialog. We will implement its default constructor destructor as shown in the following code.

class CExampleDlg : public CDialog
{
    public:
        enum { IDD = IDD_EXAMPLE_DLG };

        CExampleDlg();
        ~CExampleDlg();
};

CExampleDlg::CExampleDlg(): CDialog(CExampleDlg::IDD)
{
}

CExampleDlg::~CExampleDlg()
{
}

We need to instantiate this dialog on CExample::InitInstance() method as shown in the following code.

BOOL CExample::InitInstance()
{
    CExampleDlg myDlg;
    m_pMainWnd = &myDlg;

    return TRUE;
}

Modal Dialog Boxes

There are two types of dialog boxes — modeless and modal. Modal and modeless dialog boxes differ by the process used to create and display them.
Modeless Dialog Box

- For a modeless dialog box, you must provide your own public constructor in your dialog class.

- To create a modeless dialog box, call your public constructor and then call the dialog object's Create member function to load the dialog resource.

- You can call Create either during or after the constructor call. If the dialog resource has the property WS_VISIBLE, the dialog box appears immediately.

- If not, you must call its ShowWindow member function.

Modal Dialog

- To create a modal dialog box, call either of the two public constructors declared in CDialog.

- Next, call the dialog object's `DoModal` member function to display the dialog box and manage interaction with it until the user chooses OK or Cancel.

- This management by `DoModal` is what makes the dialog box modal. For modal dialog boxes, `DoModal` loads the dialog resource.

**Step 1:** To display the dialog box as modal, in the `CExample::InitInstance()` event call the `DoModal()` method using your dialog variable:

```cpp
BOOL CExample::InitInstance()
{
    CExampleDlg myDlg;
    m_pMainWnd = &myDlg;
    myDlg.DoModal();
    return TRUE;
}
```

**Step 2:** Here is the complete implementation of Example.cpp file.

```cpp
#include <afxwin.h>
#include "resource.h"

class CExample : public CWinApp
{
    public:
        BOOL InitInstance();
};
```
class CExampleDlg : public CDialog
{
    public:
        enum { IDD = IDD_EXAMPLE_DLG };

        CExampleDlg();
        ~CExampleDlg();
};

CExampleDlg::CExampleDlg(): CDialog(CExampleDlg::IDD) {
}

CExampleDlg::~CExampleDlg() {
}

BOOL CExample::InitInstance()
{
    CExampleDlg myDlg;
    m_pMainWnd = &myDlg;
    myDlg.DoModal();
    return TRUE;
}

CExample MyApp;
**Step 3:** When the above code is compiled and executed, you will see the following dialog box.

![Dialog Box](image)

**Dialog-Based Applications**

Microsoft Visual Studio provides an easier way to create an application that is mainly based on a dialog box. Here are the steps to create a dialog base project using project templates available in Visual Studio:

**Step 1:** Open the Visual studio and click on the File -> New -> Project menu option. You can see the New Project dialog box.
Step 2: From the left pane, select Templates -> Visual C++ -> MFC.

Step 3: In the middle pane, select MFC Application.

Step 4: Enter project name 'MFCModalDemo' in the Name field and click OK to continue. You will see the following dialog box.
Step 6: Click Next.
Step 7: Select the options shown in the above dialog box and click Next.
Step 8: Check all the options that you choose to have on your dialog box like Maximize and Minimize Boxes and click Next.
Step 9: Click Next.
**Step 10:** It will generate these two classes. You can change the name of the classes and click Finish.

**Step 11:** You can now see that the MFC wizard creates this Dialog Box and the project files by default.
Step 12: When you run this application, you will see the following output.
TODO: Place dialog controls here.
A **resource** is a text file that allows the compiler to manage objects such as pictures, sounds, mouse cursors, dialog boxes, etc. Microsoft Visual Studio makes creating a resource file particularly easy by providing the necessary tools in the same environment used to program. This means, you usually do not have to use an external application to create or configure a resource file. Following are some important features related to resources.

- Resources are interface elements that provide information to the user.
- Bitmaps, icons, toolbars, and cursors are all resources.
- Some resources can be manipulated to perform an action such as selecting from a menu or entering data in dialog box.
- An application can use various resources that behave independently of each other, these resources are grouped into a text file that has the *.rc* extension.
- Most resources are created by selecting the desired one from the Add Resource dialog box.

![Add Resource dialog box](image-url)
The Add Resource dialog box provides an extensive list of resources which can be used as per requirements, but if you need something which is not available then you can add it manually to the *.rc file before executing the program.

Identifiers

An **identifier** is a symbol which is a constant integer whose name usually starts with ID. It consists of two parts — a text string (symbol name) mapped to an integer value (symbol value).

- Symbols provide a descriptive way of referring to resources and user-interface objects, both in your source code and while you're working with them in the resource editors.

- When you create a new resource or resource object, the **resource editors** provide a default name for the resource, for example, IDC_DIALOG1, and assign a value to it.

- The name-plus-value definition is stored in the Resource.h file.

**Step 1:** Let us look into our **CMFCDialogDemo** example from the last chapter in which we have created a dialog box and its ID is **IDD_EXAMPLE_DLG**.

**Step 2:** Go to the Solution Explorer, you will see the resource.h file under Header Files. Continue by opening this file in editor and you will see the dialog box identifier and its integer value as well.
Icons

An icon is a small picture used on a window which represents an application. It is used in two main scenarios.

- On a Window's frame, it is displayed on the left side of the Window name on the title bar.

- In Windows Explorer, on the Desktop, in My Computer, or in the Control Panel window.

If you look at our MFCModalDemo example, you will see that Visual studio was using a default icon for the title bar as shown in the following snapshot.
You can create your own icon by following the steps given below:

**Step 1:** Right-click on your project and select Add -> Resources, you will see the Add Resources dialog box.

**Step 2:** Select Icon and click New button and you will see the following icon.
**Step 3:** In Solution Explorer, go to Resource View and expand MFCModalDemo > Icon. You will see two icons. The IDR_MAINFRAME is the default one and IDI_ICON1 is the newly created icon.

**Step 4:** Right-click on the newly Created icon and select Properties.

**Step 5:** IDI_ICON1 is the ID of this icon, now let us change this ID to IDR_MYICON.

**Step 6:** You can now change this icon in the designer as per your requirements. We will use the same icon.

**Step 7:** Save this icon.

**Step 8:** Go to the CMFCModalDemoDlg constructor in CMFCModalDemoDlg.cpp file which will look like the following code.

```cpp
CMFCModalDemoDlg::CMFCModalDemoDlg(CWnd* pParent /*=NULL*/) : CDialogEx(IDD_MFCMODALDEMO_DIALOG, pParent)
{
    m_hIcon = AfxGetApp()->LoadIcon(IDR_MAINFRAME);
}
```
**Step 9:** You can now see that the default icon is loaded in the constructor. Let us change it to IDR_MYICON as shown in the following code.

```cpp
CMFCModalDemoDlg::CMFCModalDemoDlg(CWnd* pParent /*=NULL*/)
    : CDialogEx(IDD_MFCMODALDEMO_DIALOG, pParent)
{
    m_hIcon = AfxGetApp()->LoadIcon(IDR_MYICON);
}
```

**Step 10:** When the above code is compiled and executed, you will see the new icon is displayed on the dialog box.

![Dialog Box with new icon](image)

**Menus**

**Menus** allow you to arrange commands in a logical and easy-to-find fashion. With the Menu editor, you can create and edit menus by working directly with a menu bar that closely resembles the one in your finished application. To create a menu, follow the steps given below:

**Step 1:** Right-click on your project and select Add -> Resources. You will see the Add Resources dialog box.
Step 2: Select Menu and click New. You will see the rectangle that contains "Type Here" on the menu bar.
Step 3: Write some menu options like File, Edit, etc. as shown in the following snapshot.
Step 4: If you expand the Menu folder in Resource View, you will see the Menu identifier IDR_MENU1. Right-click on this identifier and change it to IDM_MAINMENU.
**Step 5:** Save all the changes.

**Step 6:** We need to attach this menu to our dialog box. Expand your Dialog folder in Solution Explorer and double click on the dialog box identifier.

**Step 7:** You will see the menu field in the Properties. Select the Menu identifier from the dropdown as shown above.

**Step 8:** Run this application and you will see the following dialog box which also contains menu options.
A toolbar is a Windows control that allows the user to perform some actions on a form by clicking a button instead of using a menu.

- A toolbar provides a convenient group of buttons that simplifies the user’s job by bringing the most accessible actions as buttons.
- A toolbar can bring such common actions closer to the user.
- Toolbars usually display under the main menu.
- They can be equipped with buttons but sometimes their buttons or some of their buttons have a caption.
- Toolbars can also be equipped with other types of controls.

To create a toolbar, following are the steps.

**Step 1:** Right-click on your project and select Add -> Resources. You will see the Add Resources dialog box.
Step 2: Select Toolbar and click New. You will see the following screen.
Step 3: Design your toolbar in the designer as shown in the following screenshot and specify the IDs as well.

Step 4: Add these two variables in CMFCModalDemoDlg class.

```cpp
CToolBar m_wndToolBar;
BOOL butD;
```

Step 5: Following is the complete implementation of CMFCModalDemoDlg in CMFCModalDemoDlg.h file:

```cpp
class CMFCModalDemoDlg : public CDialogEx
{
    // Construction
    public:
        CMFCModalDemoDlg(CWnd* pParent = NULL); // standard constructor

    // Dialog Data
```
Step 6: Update CMFCModalDemoDlg::OnInitDialog() as shown in the following code.

```cpp
BOOL CMFCModalDemoDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);       // Set big icon
    SetIcon(m_hIcon, FALSE);      // Set small icon

    if (!m_wndToolBar.Create(this)
        || !m_wndToolBar.LoadToolBar(IDR_TOOLBAR1))
        //if (!m_wndToolBar.CreateEx(this, TBSTYLE_FLAT, WS_CHILD |
```

---
// WS_VISIBLE | CBRS_TOP | CBRS_GRIPPER | CBRS_TOOLTIPS |
// CBRS_FLYBY | CBRS_SIZE_DYNAMIC) ||
// !m_wndToolBar.LoadToolBar(IDR_TOOLBAR1))
{
TRACE0("Failed to Create Dialog Toolbar\n");
EndDialog(IDCANCEL);
}

butD = TRUE;
CRect rcClientOld; // Old Client Rect
CRect rcClientNew; // New Client Rect with Toolbar Added

// Retrive the Old Client WindowSize
// Called to reposition and resize control bars in the client area of a window
// The reposQuery FLAG does not really traw the Toolbar. It only does the calculations.
// And puts the new ClientRect values in rcClientNew so we can do the rest of the Math.

GetClientRect(rcClientOld);
RepositionBars(AFX_IDW_CONTROLBAR_FIRST, AFX_IDW_CONTROLBAR_LAST, 0,
               reposQuery, rcClientNew);

// All of the Child Windows (Controls) now need to be moved so the Tollbar does not cover them up.
// Offest to move all child controls after adding Tollbar
CPoint ptOffset(rcClientNew.left - rcClientOld.left,
                 rcClientNew.top - rcClientOld.top);

CRect rcChild;
CWnd* pwndChild = GetWindow(GW_CHILD); //Handle to the Dialog Controls
while (pwndChild) // Cycle through all child controls
{
    pwndChild->GetWindowRect(rcChild); // Get the child control RECT
    ScreenToClient(rcChild);
    // Changes the Child Rect by the values of the claculated offset
Step 7: Run this application. You will see the following dialog box which also contains the toolbar.
Accelerators

An access key is a letter that allows the user to perform a menu action faster by using the keyboard instead of the mouse. This is usually faster because the user would not need to position the mouse anywhere, which reduces the time it takes to perform the action.

**Step 1:** To create an access key, type an ampersand "&" on the left of the menu item.
Step 2: Repeat this step for all menu options. Run this application and press Alt. You will see that the first letter of all menu options are underlined.
Shortcut Key

A shortcut key is a key or a combination of keys used by advanced users to perform an action that would otherwise be done on a menu item. Most shortcuts are a combination of the Ctrl key simultaneously pressed with a letter key. For example, Ctrl + N, Ctrl + O, or Ctrl + D.

To create a shortcut, on the right side of the string that makes up a menu caption, right-click on the menu item and select properties.

In the Caption field type \t followed by the desired combination as shown below for the New menu option. Repeat the step for all menu options.
Accelerator Table

An Accelerator Table is a list of items where each item of the table combines an identifier, a shortcut key, and a constant number that specifies the kind of accelerator key. Just like the other resources, an accelerator table can be created manually in a .rc file. Following are the steps to create an accelerator table.

**Step 1:** To create an accelerator table, right-click on *.rc file in the solution explorer.
Step 2: Select Accelerator and click New.
Step 3: Click the arrow of the ID combo box and select menu Items.
**Step 4:** Select Ctrl from the Modifier dropdown.

**Step 5:** Click the Key box and type the respective Keys for both menu options.

We will also add New menu item event handler to testing. Right-click on the New menu option.
**Step 6:** You can specify a class, message type and handler name. For now, let us leave it as it is and click Add and Edit button.
Step 7: Select Add Event Handler

Step 8: You will now see the event added at the end of the CMFCModalDemoDlg.cpp file.

```cpp
void CMFCModalDemoDlg::OnFileNew()
{
    // TODO: Add your command handler code here
    MessageBox(L"File > New menu option");
}
```

Step 9: Now Let us add a message box that will display the simple menu option message.

To start accelerator table in working add the HACCEL variable and ProcessMessageFilter as shown in the following CMFCModalDemoApp.

```cpp
class CMFCModalDemoApp : public CWinApp
{
public:
    CMFCModalDemoApp();
};
```
// Overrides
public:
    virtual BOOL InitInstance();
    HACCEL m_hAccelTable;

// Implementation

DECLARE_MESSAGE_MAP()
    virtual BOOL ProcessMessageFilter(int code, LPMGS lpMsg);
};

Step 10: Load Accelerator and the following call in the CMFCModalDemoApp::InitInstance().

m_hAccelTable = LoadAccelerators(AfxGetInstanceHandle(), MAKEINTRESOURCE(IDR_ACCELERATOR1));

Step 11: Here is the implementation of ProcessMessageFilter.

BOOL CMFCModalDemoApp::ProcessMessageFilter(int code, LPMGS lpMsg)
{
    if (code >= 0 && m_pMainWnd && m_hAccelTable)
    {
        if (::TranslateAccelerator(m_pMainWnd->m_hWnd, m_hAccelTable, lpMsg))
            return TRUE;
    }
    return CWinApp::ProcessMessageFilter(code, lpMsg);
}

Step 12: When the above code is compiled and executed, you will see the following output.
Step 13: Press Alt button followed by F key and then N key or Ctrl + N. You will see the following message.
A **property sheet**, also known as a tab dialog box, is a dialog box that contains property pages. Each property page is based on a dialog template resource and contains controls. It is enclosed on a page with a tab on top. The tab names the page and indicates its purpose. Users click a tab in the property sheet to select a set of controls.

To create property pages, let us look into a simple example by creating a dialog based MFC project.

Once the project is created, we need to add some property pages. Visual Studio makes it easy to create resources for property pages by displaying the Add Resource dialog box, expanding the Dialog node and selecting one of the IDD_PROPPAGE_X items.

**Step 1:** Right-click on your project in solution explorer and select Add -> Resources.
**Step 2:** Select the IDD_PROPPAGE_LARGE and click NEW.
Step 3: Let us change ID and Caption of this property page to **IDD_PROPPAGE_1** and **Property Page 1** respectively as shown above.

Step 4: Right-click on the property page in designer window.
**Step 5:** Select the Add Class option.
Step 6: Enter the class name and select CPropertyPage from base class dropdown list.

Step 7: Click Finish to continue.

Step 8: Add one more property page with ID IDD_PROPPAGE_2 and Caption Property Page 2 by following the above mentioned steps.

Step 9: You can now see two property pages created. To implement its functionality, we need a property sheet.

The Property Sheet groups the property pages together and keeps it as entity.

To create a property sheet, follow the steps given below:

Step 1: Right-click on your project and select Add > Class menu options
Step 2: Select Visual C++ -> MFC from the left pane and MFC Class in the template pane and click Add.
Step 3: Enter the class name and select CPropertySheet from base class dropdown list.

Step 4: Click finish to continue.

Step 5: To launch this property sheet, we need the following changes in our main project class.

Step 6: Add the following references in CMFCPropSheetDemo.cpp file.

```cpp
#include "MySheet.h"
#include "PropPage1.h"
#include "PropPage2.h"
```

Step 7: Modify the CMFCPropSheetDemoApp::OnInitInstance() method as shown in the following code.

```cpp
CMySheet mySheet(L"Property Sheet Demo");
CPropPage1 page1;
CPropPage2 page2;

mySheet.AddPage(&page1);
```
mySheet.AddPage(&page2);

m_pMainWnd = &mySheet;
INT_PTR nResponse = mySheet.DoModal();

Step 8: Here is the complete implementation of CMFCPropSheetDemo.cpp file.

// MFCPropSheetDemo.cpp : Defines the class behaviors for the application.

#include "stdafx.h"
#include "MFCPropSheetDemo.h"
#include "MFCPropSheetDemoDlg.h"
#include "MySheet.h"
#include "PropPage1.h"
#include "PropPage2.h"

#if defined _DEBUG
#define new DEBUG_NEW
#endif

// CMFCPropSheetDemoApp construction

CMFCPropSheetDemoApp::CMFCPropSheetDemoApp()
{
    // support Restart Manager
    m_dwRestartManagerSupportFlags = AFX_RESTART_MANAGER_SUPPORT_RESTART;
// TODO: add construction code here,
// Place all significant initialization in InitInstance
}

// The one and only CMFCPropSheetDemoApp object
CMFCPropSheetDemoApp theApp;

// CMFCPropSheetDemoApp initialization
BOOL CMFCPropSheetDemoApp::InitInstance()
{
    // InitCommonControlsEx() is required on Windows XP if an application
    // manifest specifies use of ComCtl32.dll version 6 or later to enable
    // visual styles. Otherwise, any window creation will fail.
    INITCOMMONCONTROLSEX InitCtrls;
    InitCtrls.dwSize = sizeof(InitCtrls);
    // Set this to include all the common control classes you want to use
    // in your application.
    InitCtrls.dwICC = ICC_WIN95_CLASSES;
    InitCommonControlsEx(&InitCtrls);
    CWinApp::InitInstance();

    AfxEnableControlContainer();

    // Create the shell manager, in case the dialog contains
    // any shell tree view or shell list view controls.
    CShellManager *pShellManager = new CShellManager;

    // Activate "Windows Native" visual manager for enabling themes in MFC
    controls
    CMFCVisualManager::SetDefaultManager(RUNTIME_CLASS(CMFCVisualManagerWindow));
}
// Standard initialization
// If you are not using these features and wish to reduce the size
// of your final executable, you should remove from the following
// the specific initialization routines you do not need
// Change the registry key under which our settings are stored
// TODO: You should modify this string to be something appropriate
// such as the name of your company or organization
SetRegistryKey(_T("Local AppWizard-Generated Applications"));

CMySheet mySheet(L"Property Sheet Demo");
CPropPage1 page1;
CPropPage2 page2;

mySheet.AddPage(&page1);
mySheet.AddPage(&page2);

m_pMainWnd = &mySheet;
INT_PTR nResponse = mySheet.DoModal();
if (nResponse == IDOK)
{
    // TODO: Place code here to handle when the dialog is
    // dismissed with OK
}
else if (nResponse == IDCANCEL)
{
    // TODO: Place code here to handle when the dialog is
    // dismissed with Cancel
}
else if (nResponse == -1)
{
    TRACE(traceAppMsg, 0, "Warning: dialog creation failed, so application is terminating unexpectedly.\n");
    TRACE(traceAppMsg, 0, "Warning: if you are using MFC controls on the dialog, you cannot #define _AFX_NO_MFC_CONTROLS_IN_DIALOGS.\n");
}

// Delete the shell manager created above.
if (pShellManager != NULL)
{

delete pShellManager;
}
// Since the dialog has been closed, return FALSE so that we exit the
// application, rather than start the application's message pump.
return FALSE;}

**Step 9:** When the above code is compiled and executed, you will see the following dialog box. This dialog box contains two property pages.
Layout of controls is very important and critical for application usability. It is used to arrange a group of GUI elements in your application. There are certain important things to consider while selecting layout:

- Positions of the child elements.
- Sizes of the child elements.

Adding controls

Let us create new Dialog based MFC Project MFCLayoutDemo.

Step 1: Once the project is created, you will see the following screen.

Step 2: Delete the TODO from the dialog box.

Step 3: Drag some controls from the Toolbox which you can see on the left side.

(We will drag one Static Text and one Edit Control as shown in the following snapshot).
Step 4: Change the Caption of the Static Text to Name.
Control Grid

Control grid is the guiding grid dots, which can help in positioning of the controls you are adding at the time of designing.

To enable the control grid, you need to click the Toggle Grid button in the toolbar as shown in the following snapshot.
Controls Resizing

After you have added a control to a dialog box, it assumes either its default size or the size you drew it with. To help with the sizes of controls on the form or dialog box, Visual Studio provides a visual grid made of black points.

To resize a control, that is, to give it a particular width or height, position the mouse on one of the handles and drag it in the desired direction.
You can now resize the controls with the help of this dotted grid.

Controls Positions

The controls you position on a dialog box or a form assume their given place. Most of the time, these positions are not practical. You can move them around to any position of your choice.

Let us add some more controls:
Step 1: To move a control, click and drag it in the desired direction until it reaches the intended position.

Step 2: To move a group of controls, first select them. Then drag the selection to the desired location. Let us select the Static Texts and Edit Controls.
Step 3: Move these selected controls to the left side.
Microsoft Foundation Classes
To help with positioning the controls, Visual Studio provides the Dialog toolbar with the following buttons.

**Step 1:** Let us align the Check box and Static Text controls to the left by selecting all these controls.
Step 2: Select the Format -> Align -> Lefts.
Step 3: You can now see all these controls are aligned to the left.

Tab Ordering

The controls you add to a form or a dialog box are positioned in a sequence that follows the order they were added. When you add control(s) regardless of the section or area you place the new control, it is sequentially positioned at the end of the existing controls. If you do not fix it, the user would have a hard time navigating the controls. The sequence of controls navigation is also known as the tab order.

To change the tab, you can either use the Format -> Tab Order menu option or you can also use the Ctrl + D shortcut. Let us press Ctrl + D.
You can now see the order in which all these controls are added to this dialog box. To change the order or sequence of controls, click on all the controls in sequence in which you want to navigate.

In this example, we will first click on the checkbox followed by Name and Address Edit controls. Then click OK and Cancel as shown in the following snapshot.
Let us run this application and you will see the following output.
In MFC applications, after visually adding a control to your application, if you want to refer to it in your code, you can declare a variable based on, or associated with that control. The MFC library allows you to declare two types of variables for some of the controls used in an application: a value or a control variable.

- One variable is used for the information stored in the control, which is also known as **Control Variable/Instance**.

- The other variable is known as **Control Value Variable**. A user can perform some sort of actions on that control with this variable.

### Control Variable/Instance

A control variable is a variable based on the class that manages the control. For example, a button control is based on the CButton class.

To see these concepts in real programming, let us create an MFC dialog based project **MFCCControlManagement**.

Once the project is created, you will see the following dialog box in designer window.
Step 1: Delete the TODO line and drag one checkbox and one Edit control as shown in the following snapshot. Change the caption of checkbox to Enable Control.
Step 2: Right-click on the checkbox.
Step 3: Select Add Variable.

Step 4: You can now see the Add Member Variable Wizard.
You can select different options on this dialog box. For checkbox, the variable type is CButton. It is selected by default in this dialog box.

Similarly, the control ID is also selected by default now we need to select Control in the Category combo box, and type m_enableDisableCheck in the Variable Name edit box and click finish.

**Step 5:** Similarly, add Control Variable of Edit control with the settings as shown in the following snapshot.
Observe the header file of the dialog class. You can see that the new variables have been added now.

```cpp
CButton m_enableDisableCheck;
CEdit m_myEditControl;
```

**Control Value Variable**

Another type of variable you can declare for a control is the value variable. Not all controls provide a value variable.

- The value variable must be able to handle the type of value stored in the control it is intended to refer to.

- For example, because a text based control is used to handle text, you can declare a text-based data type for it. This would usually be a CString variable.
Let us look into this type of variable for checkbox and edit control.

**Step 1:** Right-click on the checkbox and select Add Variable.

**Step 2:** The Variable type is BOOL. Select Value from the Category dropdown list.

**Step 3:** Click Finish to continue.

**Step 4:** Similarly, add value Variable for Edit control with the settings as shown in the following snapshot.
Step 5: Type CString in variable type and m_editControlVal in the variable name field.

Step 6: You can now see these variables added in the Header file.

```c++
bool m_enableDisableVal;
CString m_editControlVal;
```

Controls Event Handlers

After adding a control to your application, whether you visually added it or created it dynamically, you will also decide how to handle the possible actions that the user can perform on the control.

- For project dialog boxes that are already associated with a class, you can take advantage of some shortcuts when you create event handlers.

- You can quickly create a handler either for the default control notification event or for any applicable Windows message.
Let us look into the same example in which we added event handler for checkbox.

**Step 1:** Right-click the control for which you want to handle the notification event.

Step 2: On the shortcut menu, click Add Event Handler to display the Event Handler Wizard.
Step 3: Select the event in the Message type box to add to the class selected in the Class list box.

Step 4: Accept the default name in the Function handler name box, or provide the name of your choice.

Step 5: Click Add and edit to add the event handler.

Step 6: You can now see the following event added at the end of CMFCControlManagementDlg.cpp file.

```cpp
void CMFCControlManagementDlg::OnBnClickedCheck1()
{
    // TODO: Add your control notification handler code here
}
```
Controls Management

So far, we have seen how to add controls to an application. We will now see how to manage these controls as per user requirement. We can use the control variable/instance in a particular event handler.

**Step 1**: Let us look into the following example. Here, we will enable/disable the edit control when the checkbox is checked/unchecked.

**Step 2**: We have now added the checkbox click event handler. Here is the implementation:

```cpp
void CMFCControlManagementDlg::OnBnClickedCheck1()
{
    // TODO: Add your control notification handler code here
    UpdateData(TRUE);
    if (m_enableDisableVal)
        m_myEditControl.EnableWindow(TRUE);
    else
        m_myEditControl.EnableWindow(FALSE);
}
```

**Step 3**: When the dialog is created, we need to add the following code to CMFCControlManagementDlg::OnInitDialog(). This will manage these controls.

```cpp
UpdateData(TRUE);
if (m_enableDisableVal)
    m_myEditControl.EnableWindow(TRUE);
else
    m_myEditControl.EnableWindow(FALSE);
```

**Step 4**: Here is the complete implementation of CMFCControlManagementDlg.cpp file.

```cpp
// MFCControlManagementDlg.cpp : implementation file

#include "stdafx.h"
#include "MFCControlManagement.h"
#include "MFCControlManagementDlg.h"
#include "afxdialogex.h"

#ifdef _DEBUG
```
```cpp
#define new DEBUG_NEW
#endif

// CAboutDlg dialog used for App About
class CAboutDlg : public CDialogEx
{
public:
    CAboutDlg();

    // Dialog Data
    #ifdef AFX_DESIGN_TIME
    enum { IDD = IDD_ABOUTBOX };
    #endif

    protected:
        virtual void DoDataExchange(CDataExchange* pDX); // DDX/DDV support

    // Implementation
    protected:
        DECLARE_MESSAGE_MAP()

    CAboutDlg::CAboutDlg() : CDialogEx(IDD_ABOUTBOX)
    {
    }

    void CAboutDlg::DoDataExchange(CDataExchange* pDX)
    {
        CDialogEx::DoDataExchange(pDX);
    }

BEGIN_MESSAGE_MAP(CAboutDlg, CDialogEx)
    END_MESSAGE_MAP()
};
```
// CMFCControlManagementDlg dialog

CMFCControlManagementDlg::CMFCControlManagementDlg(CWnd* pParent /*=NULL*/) :
    CDialogEx(IDD_MFCCONTROLMANAGEMENT_DIALOG, pParent),
    m_enableDisableVal(FALSE),
    m_editControlVal(_T(""))
{
    m_hIcon = AfxGetApp()->LoadIcon(IDR_MAINFRAME);
}

void CMFCControlManagementDlg::DoDataExchange(CDataExchange* pDX)
{
    CDialogEx::DoDataExchange(pDX);
    DDX_Control(pDX, IDC_CHECK1, m_enableDisableCheck);
    DDX_Control(pDX, IDC_EDIT1, m_myEditControl);
    DDX_Check(pDX, IDC_CHECK1, m_enableDisableVal);
    DDX_Text(pDX, IDC_EDIT1, m_editControlVal);
}

BEGIN_MESSAGE_MAP(CMFCControlManagementDlg, CDialogEx)
    ON_WM_SYSCOMMAND()
    ON_WM_PAINT()
    ON_WM_QUERYDRAGICON()
    ON_BN_CLICKED(IDC_CHECK1, &CMFCControlManagementDlg::OnBnClickedCheck1)
END_MESSAGE_MAP()

// CMFCControlManagementDlg message handlers

BOOL CMFCControlManagementDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Add "About..." menu item to system menu.
// IDM_ABOUTBOX must be in the system command range.
ASSERT((IDM_ABOUTBOX & 0xFFF0) == IDM_ABOUTBOX);
ASSERT(IDM_ABOUTBOX < 0xF000);

CMenu* pSysMenu = GetSystemMenu(FALSE);
if (pSysMenu != NULL)
{
    BOOL bNameValid;
    CString strAboutMenu;
    bNameValid = strAboutMenu.LoadString(IDS_ABOUTBOX);
    ASSERT(bNameValid);
    if (!strAboutMenu.IsEmpty())
    {
        pSysMenu->AppendMenu(MF_SEPARATOR);
        pSysMenu->AppendMenu(MF_STRING, IDM_ABOUTBOX, strAboutMenu);
    }
}

// Set the icon for this dialog. The framework does this automatically
// when the application's main window is not a dialog
SetIcon(m_hIcon, TRUE);        // Set big icon
SetIcon(m_hIcon, FALSE);       // Set small icon

// TODO: Add extra initialization here
UpdateData(TRUE);
if (m_enableDisableVal)
    m_myEditControl.EnableWindow(TRUE);
else
    m_myEditControl.EnableWindow(FALSE);

return TRUE;  // return TRUE unless you set the focus to a control

void CMFCControlManagementDlg::OnSysCommand(UINT nID, LPARAM lParam)
{
    if ((nID & 0xFFF0) == IDM_ABOUTBOX)
    {

CAboutDlg dlgAbout;
dlgAbout.DoModal();
}
else
{
    CDialogEx::OnSysCommand(nID, lParam);
}

// If you add a minimize button to your dialog, you will need the code below
// to draw the icon. For MFC applications using the document/view model,
// this is automatically done for you by the framework.

void CMFCControlManagementDlg::OnPaint()
{
    if (IsIconic())
    {
        CPaintDC dc(this); // device context for painting

        SendMessage(WM_ICONERASEBKGND,
                    reinterpret_cast<WPARAM>(dc.GetSafeHdc()), 0);

        // Center icon in client rectangle
        int cxIcon = GetSystemMetrics(SM_CXICON);
        int cyIcon = GetSystemMetrics(SM_CYICON);
        CRect rect;
        GetClientRect(&rect);
        int x = (rect.Width() - cxIcon + 1) / 2;
        int y = (rect.Height() - cyIcon + 1) / 2;

        // Draw the icon
        dc.DrawIcon(x, y, m_hIcon);
    }
    else
    {
        CDialogEx::OnPaint();
    }
}
// The system calls this function to obtain the cursor to display while the
// user drags
// the minimized window.
HCURSOR CMFCControlManagementDlg::OnQueryDragIcon()
{
    return static_cast<HCURSOR>(m_hIcon);
}

void CMFCControlManagementDlg::OnBnClickedCheck1()
{
    // TODO: Add your control notification handler code here
    UpdateData(TRUE);
    if (m_enableDisableVal)
        m_myEditControl.EnableWindow(TRUE);
    else
        m_myEditControl.EnableWindow(FALSE);
}

**Step 5:** When the above code is compiled and executed, you will see the following output. The checkbox is unchecked by default. This disables the edit control too.
**Step 6:** Check the Enable Control checkbox. This will automatically enable the edit control.
**Windows controls** are objects that users can interact with to enter or manipulate data. They commonly appear in dialog boxes or on toolbars. There are various types of controls:

- A **text based control** which is used to display text to the user or request text from the user.
- A **list based control** displays a list of items.
- A **progress based control** is used to show the progress of an action.
- A **static control** can be used to show colors, a picture or something that does not regularly fit in the above categories.

### Static Control

A static control is an object that displays information to the user without his or her direct intervention. It can be used to show colors, a geometric shape, or a picture such as an icon, a bitmap, or an animation. Following are the static controls:

- Static Text
- Picture Control
- Group Box

### Animation Control

An animation control is a window that displays an Audio clip in AVI format. An AVI clip is a series of bitmap frames, like a movie. Animation controls can only play simple AVI clips, and they do not support sound. It is represented by the `CAnimateCtrl` class.

Following is the list of methods in `CAnimateCtrl` class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>Closes the AVI clip.</td>
</tr>
<tr>
<td>Create</td>
<td>Creates an animation control and attaches it to a <code>CAnimateCtrl</code> object.</td>
</tr>
<tr>
<td>CreateEx</td>
<td>Creates an animation control with the specified Windows extended styles and attaches it to a <code>CAnimateCtrl</code> object.</td>
</tr>
<tr>
<td>IsPlaying</td>
<td>Indicates whether an Audio-Video Interleaved (AVI) clip is playing.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens an AVI clip from a file or resource and displays the first frame.</td>
</tr>
<tr>
<td>Play</td>
<td>Plays the AVI clip without sound.</td>
</tr>
<tr>
<td>Seek</td>
<td>Displays a selected single frame of the AVI clip.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops playing the AVI clip.</td>
</tr>
</tbody>
</table>
Here is the list of messages mapping for animation control:

<table>
<thead>
<tr>
<th>Message</th>
<th>Map entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACN_START</td>
<td>ON_ACN_START (&lt;id&gt;,</td>
<td>The framework calls this member function when an animation is being started</td>
</tr>
<tr>
<td></td>
<td>&lt;memberFxn&gt; )</td>
<td></td>
</tr>
<tr>
<td>ACN_STOP</td>
<td>ON_ACN_STOP (&lt;id&gt;,</td>
<td>The framework calls this member function when an animation stop</td>
</tr>
<tr>
<td></td>
<td>&lt;memberFxn&gt; )</td>
<td></td>
</tr>
</tbody>
</table>

Let us look into a simple example of animation control.

**Step 1:** Create a new MFC dialog based project.
**Step 2:** Once the project is created, remove the TODO line and click on Animation Control in Toolbox and draw a rectangle as shown in the following snapshot.
Step 3: To add a control variable for animation control, right-click and select Add Variable.

![Add Member Variable Wizard](image)

Step 4: Enter the variable name and variable type, which is CAnimateCtrl for animation.
Step 5: Using the Properties window, set the Border value to False, Set the Auto Play, the Center, and the transparent values to True.

Step 6: Here we have *.avi file in res folder, which is the default folder for any resources used in the project.

Step 7: To start the animation, we need to call the Open method CAnimateCtrl class. Add the following line of code in CMFCAnimationDemoDlg::OnInitDialog()

```cpp
m_animationCtrl.Open(L"res\copyfile.avi");
```

Step 8: Here is the complete implementation of CMFCAnimationDemoDlg::OnInitDialog()

```cpp
BOOL CMFCAnimationDemoDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Add "About..." menu item to system menu.

    // IDM_ABOUTBOX must be in the system command range.
    ASSERT((IDM_ABOUTBOX & 0xFFF0) == IDM_ABOUTBOX);
```
ASSERT(IDM_ABOUTBOX < 0xF000);

CMenu* pSysMenu = GetSystemMenu(FALSE);
if (pSysMenu != NULL)
{
    BOOL bNameValid;
    CString strAboutMenu;
    bNameValid = strAboutMenu.LoadString(IDS_ABOUTBOX);
    ASSERT(bNameValid);
    if (!strAboutMenu.IsEmpty())
    {
        pSysMenu->AppendMenu(MF_SEPARATOR);
        pSysMenu->AppendMenu(MF_STRING, IDM_ABOUTBOX, strAboutMenu);
    }
}

// Set the icon for this dialog. The framework does this automatically
// when the application's main window is not a dialog
setIcon(m_hIcon, TRUE);   // Set big icon
setIcon(m_hIcon, FALSE);  // Set small icon

// TODO: Add extra initialization here
m_animationCtrl.Open(L"res\copyfile.avi");

return TRUE;  // return TRUE unless you set the focus to a control

**Step 9:** When the above code is compiled and executed, you will see the following output.
Button

A button is an object that the user clicks to initiate an action. Button control is represented by CButton class.

Here is the list of methods in CButton class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Creates the Windows button control and attaches it to the CButton object.</td>
</tr>
<tr>
<td>DrawItem</td>
<td>Override to draw an owner-drawn CButton object.</td>
</tr>
<tr>
<td>GetBitmap</td>
<td>Retrieves the handle of the bitmap previously set with SetBitmap.</td>
</tr>
<tr>
<td>GetButtonStyle</td>
<td>Retrieves information about the button control style.</td>
</tr>
<tr>
<td>GetCheck</td>
<td>Retrieves the check state of a button control.</td>
</tr>
<tr>
<td>GetCursor</td>
<td>Retrieves the handle of the cursor image previously set with SetCursor.</td>
</tr>
<tr>
<td>GetIcon</td>
<td>Retrieves the handle of the icon previously set with SetIcon.</td>
</tr>
<tr>
<td>GetIdealSize</td>
<td>Retrieves the ideal size of the button control.</td>
</tr>
<tr>
<td>GetImageList</td>
<td>Retrieves the image list of the button control.</td>
</tr>
<tr>
<td>GetNote</td>
<td>Retrieves the note component of the current command link control.</td>
</tr>
<tr>
<td>GetNoteLength</td>
<td>Retrieves the length of the note text for the current command link control.</td>
</tr>
<tr>
<td>GetSplitGlyph</td>
<td>Retrieves the glyph associated with the current split button control.</td>
</tr>
<tr>
<td>GetSplitImageList</td>
<td>Retrieves the image list for the current split button control.</td>
</tr>
<tr>
<td>GetSplitInfo</td>
<td>Retrieves information that defines the current split button control.</td>
</tr>
<tr>
<td>GetSplitSize</td>
<td>Retrieves the bounding rectangle of the drop-down component of the current split button control.</td>
</tr>
<tr>
<td>GetSplitStyle</td>
<td>Retrieves the split button styles that define the current split button control.</td>
</tr>
<tr>
<td>GetState</td>
<td>Retrieves the check state, highlight state, and focus state of a button control.</td>
</tr>
<tr>
<td>GetTextMargin</td>
<td>Retrieves the text margin of the button control.</td>
</tr>
<tr>
<td>SetBitmap</td>
<td>Specifies a bitmap to be displayed on the button.</td>
</tr>
</tbody>
</table>
**SetButtonStyle** Changes the style of a button.

**SetCheck** Sets the check state of a button control.

**SetCursor** Specifies a cursor image to be displayed on the button.

**SetDropDownState** Sets the drop-down state of the current split button control.

**setIcon** Specifies an icon to be displayed on the button.

**SetImageList** Sets the image list of the button control.

**SetNote** Sets the note on the current command link control.

**SetSplitGlyph** Associates a specified glyph with the current split button control.

**SetSplitImageList** Associates an image list with the current split button control.

**SetSplitInfo** Specifies information that defines the current split button control.

**SetSplitSize** Sets the bounding rectangle of the drop-down component of the current split button control.

**SetState** Sets the highlighting state of a button control.

**SetTextMargin** Sets the text margin of the button control.

<table>
<thead>
<tr>
<th>Message</th>
<th>Map entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BN_CLICKED</td>
<td>ON_BN_CLICKED( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is clicked.</td>
</tr>
<tr>
<td>BN_DISABLE</td>
<td>ON_BN_DISABLE( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is disabled.</td>
</tr>
<tr>
<td>BN_DOUBLECLICKED</td>
<td>ON_BN_DOUBLECLICKED( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is double clicked.</td>
</tr>
<tr>
<td>BN_PAINT</td>
<td>ON_BN_PAINT( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when an application makes a request to repaint a button.</td>
</tr>
</tbody>
</table>

Let us look into a simple example by dragging two buttons from the Toolbox.

**Step 1:** Change the Caption from Start, Stop and ID to IDC_BUTTON_START, IDC_BUTTON_STOP for both buttons.
Step 2: Let us add event handler for both buttons.

Step 3: Here is an implementation of both events in which we will start and stop animation.

```cpp
void CMFCAnimationDemoDlg::OnBnClickedButtonStart()
{
    // TODO: Add your control notification handler code here
    m_animationCtrl.Open(L"res\copyfile.avi");
}
```

```cpp
void CMFCAnimationDemoDlg::OnBnClickedButtonStop()
{
    // TODO: Add your control notification handler code here
    m_animationCtrl.Stop();
}
```

Step 4: When the above code is compiled and executed, you will see the following output.
Step 5: When you click the Stop button, the animation stops and when you press the Start button, it starts again.

Bitmap Button

A bitmap button displays a picture or a picture and text on its face. This is usually intended to make the button a little explicit. A bitmap button is created using the CBitmapButton class, which is derived from CButton.

Here is the list of methods in CBitmapButton class.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoLoad</td>
<td>Associates a button in a dialog box with an object of the CBitmapButton class, loads the bitmap(s) by name, and sizes the button to fit the bitmap.</td>
</tr>
<tr>
<td>LoadBitmaps</td>
<td>Initializes the object by loading one or more named bitmap resources from the application's resource file and attaching the bitmaps to the object.</td>
</tr>
<tr>
<td>SizeToContent</td>
<td>It resizes the button to the size of the bitmaps.</td>
</tr>
</tbody>
</table>

Here is the list of messages mapping for Bitmap Button control:

<table>
<thead>
<tr>
<th>Message</th>
<th>Map entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BN_CLICKED</td>
<td>ON_BN_CLICKED( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is clicked.</td>
</tr>
<tr>
<td>BN_DISABLE</td>
<td>ON_BN_DISABLE( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is disabled.</td>
</tr>
<tr>
<td>BN_DOUBLECLICKED</td>
<td>ON_BN_DOUBLECLICKED( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is double clicked.</td>
</tr>
<tr>
<td>BN_PAINT</td>
<td>ON_BN_PAINT( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when an application makes a request to repaint a button.</td>
</tr>
</tbody>
</table>
Let us look into a simple example by creating a new project.

**Step 1:** Add a Bitmap from Add Resource dialog box.

**Step 2:** Select Bitmap and click New.

**Step 3:** Design your bitmap and change its ID to IDB_BITMAP_START as shown above.
**Step 4:** Add a button to your dialog box and also add a control Variable m_buttonStart for that button.

**Step 5:** Add a bitmap variable in your header file. You can now see the following two variables.

```
CBitmap m_bitmapStart;
CButton m_buttonStart;
```

**Step 6:** Modify your OnInitDialog() method as shown in the following code.

```
m_bitmapStart.LoadBitmap(IDB_BITMAP_START);
HBITMAP hBitmap = (HBITMAP)m_bitmapStart.GetSafeHandle();
m_buttonStart.SetBitmap(hBitmap);
```

**Step 7:** When the above code is compiled and executed, you will see the following output.

![Command Button](image)

**Command Button**

A command button is an enhanced version of the regular button. It displays a green arrow icon on the left, followed by a caption in regular size. Under the main caption, it can display another smaller caption that serves as a hint to provide more information.
Here is the list of methods in CommandButton class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Creates the Windows button control and attaches it to the CButton object.</td>
</tr>
<tr>
<td>DrawItem</td>
<td>Override to draw an owner-drawn CButton object.</td>
</tr>
<tr>
<td>GetBitmap</td>
<td>Retrieves the handle of the bitmap previously set with SetBitmap.</td>
</tr>
<tr>
<td>GetButtonType</td>
<td>Retrieves information about the button control style.</td>
</tr>
<tr>
<td>GetCheck</td>
<td>Retrieves the check state of a button control.</td>
</tr>
<tr>
<td>GetCursor</td>
<td>Retrieves the handle of the cursor image previously set with SetCursor.</td>
</tr>
<tr>
<td>GetIcon</td>
<td>Retrieves the handle of the icon previously set with SetIcon.</td>
</tr>
<tr>
<td>GetIdealSize</td>
<td>Retrieves the ideal size of the button control.</td>
</tr>
<tr>
<td>GetImageList</td>
<td>Retrieves the image list of the button control.</td>
</tr>
<tr>
<td>GetNote</td>
<td>Retrieves the note component of the current command link control.</td>
</tr>
<tr>
<td>GetNoteLength</td>
<td>Retrieves the length of the note text for the current command link control.</td>
</tr>
<tr>
<td>GetSplitGlyph</td>
<td>Retrieves the glyph associated with the current split button control.</td>
</tr>
<tr>
<td>GetSplitImageList</td>
<td>Retrieves the image list for the current split button control.</td>
</tr>
<tr>
<td>GetSplitInfo</td>
<td>Retrieves information that defines the current split button control.</td>
</tr>
<tr>
<td>GetSplitSize</td>
<td>Retrieves the bounding rectangle of the drop-down component of the current split button control.</td>
</tr>
<tr>
<td>GetSplitStyle</td>
<td>Retrieves the split button styles that define the current split button control.</td>
</tr>
<tr>
<td>GetState</td>
<td>Retrieves the check state, highlight state, and focus state of a button control.</td>
</tr>
<tr>
<td>GetTextMargin</td>
<td>Retrieves the text margin of the button control.</td>
</tr>
<tr>
<td>SetBitmap</td>
<td>Specifies a bitmap to be displayed on the button.</td>
</tr>
<tr>
<td>SetButtonStyle</td>
<td>Changes the style of a button.</td>
</tr>
<tr>
<td>SetCheck</td>
<td>Sets the check state of a button control.</td>
</tr>
<tr>
<td>SetCursor</td>
<td>Specifies a cursor image to be displayed on the button.</td>
</tr>
<tr>
<td>SetDropDownState</td>
<td>Sets the drop-down state of the current split button control.</td>
</tr>
<tr>
<td>SetIcon</td>
<td>Specifies an icon to be displayed on the button.</td>
</tr>
<tr>
<td>SetImageList</td>
<td>Sets the image list of the button control.</td>
</tr>
<tr>
<td>SetNote</td>
<td>Sets the note on the current command link control.</td>
</tr>
<tr>
<td>SetSplitGlyph</td>
<td>Associates a specified glyph with the current split button control.</td>
</tr>
<tr>
<td>SetSplitImageList</td>
<td>Associates an image list with the current split button control.</td>
</tr>
<tr>
<td>SetSplitInfo</td>
<td>Specifies information that defines the current split button control.</td>
</tr>
<tr>
<td>SetSplitSize</td>
<td>Sets the bounding rectangle of the drop-down component of the current split button control.</td>
</tr>
<tr>
<td>SetSplitStyle</td>
<td>Sets the style of the current split button control.</td>
</tr>
<tr>
<td>SetState</td>
<td>Sets the highlighting state of a button control.</td>
</tr>
<tr>
<td>SetTextMargin</td>
<td>Sets the text margin of the button control.</td>
</tr>
</tbody>
</table>
Here is the list of messages mapping for Command Button control:

<table>
<thead>
<tr>
<th>Message</th>
<th>Map entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BN_CLICKED</td>
<td>ON_BN_CLICKED( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is clicked.</td>
</tr>
<tr>
<td>BN_DISABLE</td>
<td>ON_BN_DISABLE( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is disabled.</td>
</tr>
<tr>
<td>BN_DOUBLECLICKED</td>
<td>ON_BN_DOUBLECLICKED( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is double clicked.</td>
</tr>
<tr>
<td>BN_PAINT</td>
<td>ON_BN_PAINT( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when an application makes a request to repaint a button.</td>
</tr>
</tbody>
</table>

Let us look into a simple example of command button by creating a new MFC dialog based project MFCCommandButton

**Step 1:** From the Toolbox, add Command Button Control.

![Command Button Control](image)

**Step 2:** Change the Caption to My Command button.
**Step 3:** Add the event handler for this button and add the following message in the event handler.

```cpp
void CMFCCommandButtonDlg::OnBnClickedCommand1()
{
    // TODO: Add your control notification handler code here
    MessageBox(L"My Command Button Clicked");
}
```

**Step 4:** When the above code is compiled and executed, you will see the following output.

![Static Text](image)

**Step 5:** When the My Command Button is clicked; the following message will be displayed.

![Static Text](image)

**Static Text**

A static control displays a text string, box, rectangle, icon, cursor, bitmap, or enhanced metafile. It is represented by CStatic class. It can be used to label, box, or separate other controls. A static control normally takes no input and provides no output.
Here is the list of methods in CStatic class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Creates the Windows static control and attaches it to the CStatic object.</td>
</tr>
<tr>
<td>DrawItem</td>
<td>Override to draw an owner-drawn static control.</td>
</tr>
<tr>
<td>GetBitmap</td>
<td>Retrieves the handle of the bitmap previously set with SetBitmap.</td>
</tr>
<tr>
<td>GetCursor</td>
<td>Retrieves the handle of the cursor image previously set with SetCursor.</td>
</tr>
<tr>
<td>GetEnhMetaFile</td>
<td>Retrieves the handle of the enhanced metafile previously set with SetEnhMetaFile.</td>
</tr>
<tr>
<td>GetIcon</td>
<td>Retrieves the handle of the icon previously set with SetIcon.</td>
</tr>
<tr>
<td>SetBitmap</td>
<td>Specifies a bitmap to be displayed in the static control.</td>
</tr>
<tr>
<td>SetCursor</td>
<td>Specifies a cursor image to be displayed in the static control.</td>
</tr>
<tr>
<td>SetEnhMetaFile</td>
<td>Specifies an enhanced metafile to be displayed in the static control.</td>
</tr>
<tr>
<td>SetIcon</td>
<td>Specifies an icon to be displayed in the static control.</td>
</tr>
</tbody>
</table>

Let us look into a simple example of Static Text.

**Step 1:** Drag a Static Text control from Toolbox.
**Step 2:** Change the Caption to **It is Static Text Control** and run your application you will see the following dialog box, which now contains the Static Text control as well.

![Dialog Box with Static Text Control](image)

**List Box**

A **list box** displays a list of items, such as filenames, that the user can view and select. A List box is represented by **CListBox class**. In a single-selection list box, the user can select only one item. In a multiple-selection list box, a range of items can be selected. When the user selects an item, it is highlighted and the list box sends a notification message to the parent window.

Here is the list of methods in CListBox class.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AddString</strong></td>
<td>Adds a string to a list box.</td>
</tr>
<tr>
<td><strong>CharToItem</strong></td>
<td>Override to provide custom <strong>WM_CHAR</strong> handling for owner-draw list boxes which don't have strings.</td>
</tr>
<tr>
<td><strong>CompareItem</strong></td>
<td>Called by the framework to determine the position of a new item in a sorted owner-draw list box.</td>
</tr>
<tr>
<td><strong>Create</strong></td>
<td>Creates the Windows list box and attaches it to the CListBox object.</td>
</tr>
<tr>
<td><strong>DeleteItem</strong></td>
<td>Called by the framework when the user deletes an item from an owner-draw list box.</td>
</tr>
<tr>
<td><strong>DeleteString</strong></td>
<td>Deletes a string from a list box.</td>
</tr>
<tr>
<td><strong>Dir</strong></td>
<td>Adds filenames, drives, or both from the current directory to a list box.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>DrawItem</strong></td>
<td>Called by the framework when a visual aspect of an owner-draw list box changes.</td>
</tr>
<tr>
<td><strong>FindString</strong></td>
<td>Searches for a string in a list box.</td>
</tr>
<tr>
<td><strong>FindStringExact</strong></td>
<td>Finds the first list-box string that matches a specified string.</td>
</tr>
<tr>
<td><strong>GetAnchorIndex</strong></td>
<td>Retrieves the zero-based index of the current anchor item in a list box.</td>
</tr>
<tr>
<td><strong>GetCaretIndex</strong></td>
<td>Determines the index of the item that has the focus rectangle in a multiple-selection list box.</td>
</tr>
<tr>
<td><strong>GetCount</strong></td>
<td>Returns the number of strings in a list box.</td>
</tr>
<tr>
<td><strong>GetCurSel</strong></td>
<td>Returns the zero-based index of the currently selected string in a list box.</td>
</tr>
<tr>
<td><strong>GetHorizontalExtent</strong></td>
<td>Returns the width in pixels that a list box can be scrolled horizontally.</td>
</tr>
<tr>
<td><strong>GetItemData</strong></td>
<td>Returns the 32-bit value associated with the list-box item.</td>
</tr>
<tr>
<td><strong>GetItemDataPtr</strong></td>
<td>Returns a pointer to a list-box item.</td>
</tr>
<tr>
<td><strong>GetItemHeight</strong></td>
<td>Determines the height of items in a list box.</td>
</tr>
<tr>
<td><strong>GetItemRect</strong></td>
<td>Returns the bounding rectangle of the list-box item as it is currently displayed.</td>
</tr>
<tr>
<td><strong>GetListBoxInfo</strong></td>
<td>Retrieves the number of items per column.</td>
</tr>
<tr>
<td><strong>GetLocale</strong></td>
<td>Retrieves the locale identifier for a list box.</td>
</tr>
<tr>
<td><strong>GetSel</strong></td>
<td>Returns the selection state of a list-box item.</td>
</tr>
<tr>
<td><strong>GetSelCount</strong></td>
<td>Returns the number of strings currently selected in a multiple-selection list box.</td>
</tr>
<tr>
<td><strong>GetSelItems</strong></td>
<td>Returns the indices of the strings currently selected in a list box.</td>
</tr>
<tr>
<td><strong>GetText</strong></td>
<td>Copies a list-box item into a buffer.</td>
</tr>
<tr>
<td><strong>GetTextLen</strong></td>
<td>Returns the length in bytes of a list-box item.</td>
</tr>
<tr>
<td><strong>GetTopIndex</strong></td>
<td>Returns the index of the first visible string in a list box.</td>
</tr>
<tr>
<td><strong>InitStorage</strong></td>
<td>Preallocates blocks of memory for list box items and strings.</td>
</tr>
<tr>
<td><strong>InsertString</strong></td>
<td>Inserts a string at a specific location in a list box.</td>
</tr>
<tr>
<td><strong>ItemFromPoint</strong></td>
<td>Returns the index of the list-box item nearest a point.</td>
</tr>
<tr>
<td><strong>MeasureItem</strong></td>
<td>Called by the framework when an owner-draw list box is created to determine list-box dimensions.</td>
</tr>
<tr>
<td><strong>ResetContent</strong></td>
<td>Clears all the entries from a list box.</td>
</tr>
<tr>
<td><strong>SelectString</strong></td>
<td>Searches for and selects a string in a single-selection list box.</td>
</tr>
<tr>
<td><strong>SelItemRange</strong></td>
<td>Selects or deselects a range of strings in a multiple-selection list box.</td>
</tr>
</tbody>
</table>
### SetAnchorIndex
Sets the anchor in a multiple-selection list box to begin an extended selection.

### SetCaretIndex
Sets the focus rectangle to the item at the specified index in a multiple-selection list box.

### SetColumnWidth
Sets the column width of a multicolumn list box.

### SetCurSel
Selects a list-box string.

### SetHorizontalExtent
Sets the width in pixels that a list box can be scrolled horizontally.

### SetItemData
Sets the 32-bit value associated with the list-box item.

### SetItemDataPtr
Sets a pointer to the list-box item.

### SetItemHeight
Sets the height of items in a list box.

### SetLocale
Sets the locale identifier for a list box.

### SetSel
Selects or deselects a list-box item in a multiple-selection list box.

### SetTabStops
Sets the tab-stop positions in a list box.

### SetTopIndex
Sets the zero-based index of the first visible string in a list box.

### VKeyToItem
Override to provide custom WM_KEYDOWN handling for list boxes with the LBS_WANTKEYBOARDINPUT style set.

Here are some mapping entries for Listbox:

<table>
<thead>
<tr>
<th>Message</th>
<th>Map entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LBN_DBLCLK</td>
<td>ON_LBN_DBLCLK( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when list item is double clicked.</td>
</tr>
<tr>
<td>LBN_KILLFOCUS</td>
<td>ON_LBN_KILLFOCUS( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function immediately before losing the input focus.</td>
</tr>
<tr>
<td>LBN_SELCHANGE</td>
<td>ON_LBN_SELCHANGE( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when selection is changed.</td>
</tr>
<tr>
<td>LBN_SETFOCUS</td>
<td>ON_LBN_SETFOCUS( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function after gaining the input focus.</td>
</tr>
</tbody>
</table>

Let us look into a simple example of List box by creating a new MFC dialog based application.

**Step 1:** Once the project is created, you will see the TODO line which is the Caption of Text Control. Remove the Caption and set its ID to IDC_STATIC_TXT.

**Step 2:** Drag List Box from the Toolbox.
Step 3: Add the control variable for the Text control.

Step 4: Add the Value variable for the Text control.
**Step 5:** Add the control variable for the List Box control.
**Step 6:** Add the event handler for the List Box control.

![Event Handler Wizard - MFCLListBox](image)

**Step 7:** Select the LBN_SELCHANGE from the message type and enter name for the event handler.

**Step 8:** Add one function, which will load the list box.

```cpp
void CMFCListBoxDlg::LoadListBox()
{
    CString str = _T("");  
    for (int i = 0; i<10; i++)
    {
        str.Format(_T("Item %d"), i);
        m_listBox.AddString(str);
    }
}
```
Step 9: Call the function from CMFCLListBoxDlg::OnInitDialog() as shown in the following code.

```cpp
BOOL CMFCLListBoxDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);    // Set big icon
    SetIcon(m_hIcon, FALSE);   // Set small icon

    // TODO: Add extra initialization here
    LoadListBox();
    return TRUE;   // return TRUE unless you set the focus to a control
}
```

Step 10: Here is the event handler implementation. This will display the current selected item from the List Box.

```cpp
void CMFCLListBoxDlg::OnLbnSelchangeList1()
{
    // TODO: Add your control notification handler code here
    m_listBox.GetText(m_listBox.GetCurSel(),m_strItemSelected);
    UpdateData(FALSE);
}
```

Step 11: When the above code is compiled and executed, you will see the following output.
Step 12: When you select any item, it will be displayed on the Text Control.

**Combo Boxes**

A **combo box** consists of a list box combined with either a static control or edit control. It is represented by `CComboBox` class. The list-box portion of the control may be displayed at all times or may only drop down when the user selects the drop-down arrow next to the control.

Here is the list of methods of `CComboBox` class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AddString</strong></td>
<td>Adds a string to the end of the list in the list box of a combo box, or at the sorted position for list boxes with the CBS_SORT style.</td>
</tr>
<tr>
<td><strong>Clear</strong></td>
<td>Deletes (clears) the current selection, if any, in the edit control.</td>
</tr>
<tr>
<td><strong>CompareItem</strong></td>
<td>Called by the framework to determine the relative position of a new list item in a sorted owner-drawn combo box.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Copies the current selection, if any, onto the Clipboard in CF_TEXT format.</td>
</tr>
<tr>
<td><strong>Create</strong></td>
<td>Creates the combo box and attaches it to the CComboBox object.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cut</td>
<td>Deletes (cuts) the current selection, if any, in the edit control and copies the deleted text onto the Clipboard in CF_TEXT format.</td>
</tr>
<tr>
<td>DeleteItem</td>
<td>Called by the framework when a list item is deleted from an owner-drawn combo box.</td>
</tr>
<tr>
<td>DeleteString</td>
<td>Deletes a string from the list box of a combo box.</td>
</tr>
<tr>
<td>Dir</td>
<td>Adds a list of file names to the list box of a combo box.</td>
</tr>
<tr>
<td>DrawItem</td>
<td>Called by the framework when a visual aspect of an owner-drawn combo box changes.</td>
</tr>
<tr>
<td>FindString</td>
<td>Finds the first string that contains the specified prefix in the list box of a combo box.</td>
</tr>
<tr>
<td>FindStringExact</td>
<td>Finds the first list-box string (in a combo box) that matches the specified string.</td>
</tr>
<tr>
<td>GetComboBoxInfo</td>
<td>Retrieves information about the CComboBox object.</td>
</tr>
<tr>
<td>GetCount</td>
<td>Retrieves the number of items in the list box of a combo box.</td>
</tr>
<tr>
<td>GetCueBanner</td>
<td>Gets the cue text that is displayed for a combo box control.</td>
</tr>
<tr>
<td>GetCurSel</td>
<td>Retrieves the index of the currently selected item, if any, in the list box of a combo box.</td>
</tr>
<tr>
<td>GetDroppedControlRect</td>
<td>Retrieves the screen coordinates of the visible (dropped down) list box of a drop-down combo box.</td>
</tr>
<tr>
<td>GetDroppedState</td>
<td>Determines whether the list box of a drop-down combo box is visible (dropped down).</td>
</tr>
<tr>
<td>GetDroppedWidth</td>
<td>Retrieves the minimum allowed width for the drop-down list-box portion of a combo box.</td>
</tr>
<tr>
<td>GetEditSel</td>
<td>Gets the starting and ending character positions of the current selection in the edit control of a combo box.</td>
</tr>
<tr>
<td>GetExtendedUI</td>
<td>Determines whether a combo box has the default user interface or the extended user interface.</td>
</tr>
<tr>
<td>GetHorizontalExtent</td>
<td>Returns the width in pixels that the list-box portion of the combo box can be scrolled horizontally.</td>
</tr>
<tr>
<td>GetItemData</td>
<td>Retrieves the application-supplied 32-bit value associated...</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GetItemDataPtr</td>
<td>Retrieves the application-supplied 32-bit pointer that is associated with the specified combo-box item.</td>
</tr>
<tr>
<td>GetItemHeight</td>
<td>Retrieves the height of list items in a combo box.</td>
</tr>
<tr>
<td>GetLBText</td>
<td>Gets a string from the list box of a combo box.</td>
</tr>
<tr>
<td>GetLBTextLen</td>
<td>Gets the length of a string in the list box of a combo box.</td>
</tr>
<tr>
<td>GetLocale</td>
<td>Retrieves the locale identifier for a combo box.</td>
</tr>
<tr>
<td>GetMinVisible</td>
<td>Gets the minimum number of visible items in the drop-down list of the current combo box.</td>
</tr>
<tr>
<td>GetTopIndex</td>
<td>Returns the index of the first visible item in the list-box portion of the combo box.</td>
</tr>
<tr>
<td>InitStorage</td>
<td>Preallocates blocks of memory for items and strings in the list-box portion of the combo box.</td>
</tr>
<tr>
<td>InsertString</td>
<td>Inserts a string into the list box of a combo box.</td>
</tr>
<tr>
<td>LimitText</td>
<td>Limits the length of the text that the user can enter into the edit control of a combo box.</td>
</tr>
<tr>
<td>MeasureItem</td>
<td>Called by the framework to determine combo box dimensions when an owner-drawn combo box is created.</td>
</tr>
<tr>
<td>Paste</td>
<td>Inserts the data from the Clipboard into the edit control at the current cursor position. Data is inserted only if the Clipboard contains data in CF_TEXT format.</td>
</tr>
<tr>
<td>ResetContent</td>
<td>Removes all items from the list box and edit control of a combo box.</td>
</tr>
<tr>
<td>SelectString</td>
<td>Searches for a string in the list box of a combo box and, if the string is found, selects the string in the list box and copies the string to the edit control.</td>
</tr>
<tr>
<td>SetCueBanner</td>
<td>Sets the cue text that is displayed for a combo box control.</td>
</tr>
<tr>
<td>SetCurSel</td>
<td>Selects a string in the list box of a combo box.</td>
</tr>
<tr>
<td>SetDroppedWidth</td>
<td>Sets the minimum allowed width for the drop-down list-box portion of a combo box.</td>
</tr>
</tbody>
</table>
### SetEditSel
Selects characters in the edit control of a combo box.

### SetExtendedUI
Selects either the default user interface or the extended user interface for a combo box that has the `CBS_DROPDOWN` or `CBS_DROPDOWNLIST` style.

### SetHorizontalExtent
Sets the width in pixels that the list-box portion of the combo box can be scrolled horizontally.

### SetItemData
Sets the 32-bit value associated with the specified item in a combo box.

### SetItemDataPtr
Sets the 32-bit pointer associated with the specified item in a combo box.

### SetItemHeight
Sets the height of list items in a combo box or the height of the edit-control (or static-text) portion of a combo box.

### SetLocale
Sets the locale identifier for a combo box.

### SetMinVisibleItems
Sets the minimum number of visible items in the drop-down list of the current combo box.

### SetTopIndex
Tells the list-box portion of the combo box to display the item with the specified index at the top.

### ShowDropDown
Shows or hides the list box of a combo box that has the `CBS_DROPDOWN` or `CBS_DROPDOWNLIST` style.

---

Here is the list of messages mapping for Combobox control:

<table>
<thead>
<tr>
<th>Message</th>
<th>Map entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CBN_DBLCLK</td>
<td>ON_CBN_DBLCLK( &lt;id&gt;, memberFxn&gt; )</td>
<td>The user double-clicks a string in the list box of a combo box</td>
</tr>
<tr>
<td>CBN_DROPDOWN</td>
<td>ON_CBN_DROPDOWN( &lt;id&gt;, memberFxn&gt; )</td>
<td>The list box of a combo box is about to drop down (be made visible).</td>
</tr>
<tr>
<td>CBN_EDITCHANGE</td>
<td>ON_CBN_EDITCHANGE( &lt;id&gt;, memberFxn&gt; )</td>
<td>The user has taken an action that may have altered the text in the edit-control portion of a combo box.</td>
</tr>
<tr>
<td>CBN_EDITUPDATE</td>
<td>ON_CBN_EDITUPDATE( &lt;id&gt;, memberFxn&gt; )</td>
<td>The edit-control portion of a combo box is about to display altered text.</td>
</tr>
<tr>
<td>CBN_KILLFOCUS</td>
<td>ON_CBN_KILLFOCUS( &lt;id&gt;, memberFxn&gt; )</td>
<td>The combo box is losing the input focus.</td>
</tr>
</tbody>
</table>
CBN_SELCHANGE | ON_CBN_SELCHANGE( <id>, <memberFxn> ) | The selection in the list box of a combo box is about to be changed as a result of the user either clicking in the list box or changing the selection by using the arrow keys.

CBN_SETFOCUS | ON_CBN_SETFOCUS( <id>, <memberFxn> ) | The combo box receives the input focus.

Let us look into an example of Radio button by creating a new MFC dialog based application.

**Step 1:** Drag a Combo box and remove the Caption of Static Text control.

Step 2: Add a control variable m_comboBoxCtrl for combobox and value variable m_strTextCtrl for Static Text control.
Step 3: Add event handler for selection change of combo box.

Step 4: Add the following code in OnInitDialog() to load the combo box.

```cpp
for (int i=0; i<10; i++)
{
    str.Format(_T("Item %d"), i);
    m_comboBoxCtrl.AddString(str);
}
```
**Step 5:** Here is the implementation of event handler.

```cpp
void CMFCComboBoxDlg::OnCbSelchangeCombo1()
{
    // TODO: Add your control notification handler code here
    m_comboBoxCtrl.GetLBText(m_comboBoxCtrl.GetCurSel(), m_strTextCtrl);
    UpdateData(FALSE);
}
```

**Step 6:** When the above code is compiled and executed, you will see the following output.

![ComboBox Example](image)

**Step 7:** When you select any item then it will be displayed on the Text Control.

---

**Radio Buttons**

A **radio button** is a control that appears as a dot surrounded by a round box. In reality, a radio button is accompanied by one or more other radio buttons that appear and behave as a group.

Here is the list of methods in **Radio Button class**.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Creates the Windows button control and attaches it to the CButton object.</td>
</tr>
<tr>
<td>DrawItem</td>
<td>Override to draw an owner-drawn CButton object.</td>
</tr>
</tbody>
</table>

---

159
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetBitmap</td>
<td>Retrieves the handle of the bitmap previously set with SetBitmap.</td>
</tr>
<tr>
<td>GetButtonStyle</td>
<td>Retrieves information about the button control style.</td>
</tr>
<tr>
<td>GetCheck</td>
<td>Retrieves the check state of a button control.</td>
</tr>
<tr>
<td>GetCursor</td>
<td>Retrieves the handle of the cursor image previously set with SetCursor.</td>
</tr>
<tr>
<td>GetIcon</td>
<td>Retrieves the handle of the icon previously set with SetIcon.</td>
</tr>
<tr>
<td>GetIdealSize</td>
<td>Retrieves the ideal size of the button control.</td>
</tr>
<tr>
<td>GetImageList</td>
<td>Retrieves the image list of the button control.</td>
</tr>
<tr>
<td>GetNote</td>
<td>Retrieves the note component of the current command link control.</td>
</tr>
<tr>
<td>GetNoteLength</td>
<td>Retrieves the length of the note text for the current command link control.</td>
</tr>
<tr>
<td>GetSplitGlyph</td>
<td>Retrieves the glyph associated with the current split button control.</td>
</tr>
<tr>
<td>GetSplitImageList</td>
<td>Retrieves the image list for the current split button control.</td>
</tr>
<tr>
<td>GetSplitInfo</td>
<td>Retrieves information that defines the current split button control.</td>
</tr>
<tr>
<td>GetSplitSize</td>
<td>Retrieves the bounding rectangle of the drop-down component of the current split button control.</td>
</tr>
<tr>
<td>GetSplitStyle</td>
<td>Retrieves the split button styles that define the current split button control.</td>
</tr>
<tr>
<td>GetState</td>
<td>Retrieves the check state, highlight state, and focus state of a button control.</td>
</tr>
<tr>
<td>GetTextMargin</td>
<td>Retrieves the text margin of the button control.</td>
</tr>
<tr>
<td>SetBitmap</td>
<td>Specifies a bitmap to be displayed on the button.</td>
</tr>
<tr>
<td>SetButtonStyle</td>
<td>Changes the style of a button.</td>
</tr>
<tr>
<td>SetCheck</td>
<td>Sets the check state of a button control.</td>
</tr>
<tr>
<td>SetCursor</td>
<td>Specifies a cursor image to be displayed on the button.</td>
</tr>
<tr>
<td>SetDropDownState</td>
<td>Sets the drop-down state of the current split button control.</td>
</tr>
<tr>
<td>SetIcon</td>
<td>Specifies an icon to be displayed on the button.</td>
</tr>
<tr>
<td>SetImageList</td>
<td>Sets the image list of the button control.</td>
</tr>
<tr>
<td>SetNote</td>
<td>Sets the note on the current command link control.</td>
</tr>
<tr>
<td>SetSplitGlyph</td>
<td>Associates a specified glyph with the current split button control.</td>
</tr>
<tr>
<td>SetSplitImageList</td>
<td>Associates an image list with the current split button control.</td>
</tr>
<tr>
<td>SetSplitInfo</td>
<td>Specifies information that defines the current split button control.</td>
</tr>
<tr>
<td>SetSplitSize</td>
<td>Sets the bounding rectangle of the drop-down component of the current split button control.</td>
</tr>
<tr>
<td>SetSplitStyle</td>
<td>Sets the style of the current split button control.</td>
</tr>
<tr>
<td>SetState</td>
<td>Sets the highlighting state of a button control.</td>
</tr>
<tr>
<td>SetTextMargin</td>
<td>Sets the text margin of the button control.</td>
</tr>
</tbody>
</table>

Here is the list of messages mapping for Radio Button control:

<table>
<thead>
<tr>
<th>Message</th>
<th>Map entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
BN_CLICKED | ON_BN_CLICKED( <id>, <memberFxn> ) | The framework calls this member function when is button clicked
BN_DISABLE | ON_BN_DISABLE( <id>, <memberFxn> ) | The framework calls this member function when button is disabled
BN_DOUBLECLICKED | ON_BN_DOUBLECLICKED( <id>, <memberFxn> ) | The framework calls this member function when button is double clicked
BN_PAINT | ON_BN_PAINT( <id>, <memberFxn> ) | The framework calls this member function when an application makes a request to repaint a button

Let us look into an example of Radio button by creating a new MFC dialog based application

Step 1: Drag a group box and three radio buttons and remove the Caption of Static Text control.

Step 2: Add event handler for all the three radio buttons.
Step 3: Add the Value variable for the Static Text control.
Step 4: Here is the implementation of three event handlers.

```cpp
void CMFCRadioButtonDlg::OnBnClickedRadio1()
{
    // TODO: Add your control notification handler code here
    m_strTextControl = _T("Radio Button 1 Clicked");
    UpdateData(FALSE);
}

void CMFCRadioButtonDlg::OnBnClickedRadio2()
{
    // TODO: Add your control notification handler code here
    m_strTextControl = _T("Radio Button 2 Clicked");
    UpdateData(FALSE);
}

void CMFCRadioButtonDlg::OnBnClickedRadio3()
{
```
// TODO: Add your control notification handler code here
m_strTextControl = _T("Radio Button 3 Clicked");
UpdateData(FALSE);
}

**Step 5:** When the above code is compiled and executed, you will see the following output. When you select any radio button, the message is displayed on Static Text control.

---

**Checkboxes**

A checkbox is a Windows control that allows the user to set or change the value of an item as true or false.

Here is the list of methods in **Checkbox class:**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create</strong></td>
<td>Creates the Windows button control and attaches it to the <strong>CButton</strong> object.</td>
</tr>
<tr>
<td><strong>DrawItem</strong></td>
<td>Override to draw an owner-drawn <strong>CButton</strong> object.</td>
</tr>
<tr>
<td><strong>GetBitmap</strong></td>
<td>Retrieves the handle of the bitmap previously set with <strong>SetBitmap</strong>.</td>
</tr>
<tr>
<td><strong>GetButtonStyle</strong></td>
<td>Retrieves information about the button control style.</td>
</tr>
<tr>
<td><strong>GetCheck</strong></td>
<td>Retrieves the check state of a button control.</td>
</tr>
<tr>
<td><strong>GetCursor</strong></td>
<td>Retrieves the handle of the cursor image previously set with <strong>SetCursor</strong>.</td>
</tr>
<tr>
<td><strong>GetIcon</strong></td>
<td>Retrieves the handle of the icon previously set with <strong>SetIcon</strong>.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GetIdealSize</td>
<td>Retrieves the ideal size of the button control.</td>
</tr>
<tr>
<td>GetImageList</td>
<td>Retrieves the image list of the button control.</td>
</tr>
<tr>
<td>GetNote</td>
<td>Retrieves the note component of the current command link control.</td>
</tr>
<tr>
<td>GetNoteLength</td>
<td>Retrieves the length of the note text for the current command link control.</td>
</tr>
<tr>
<td>GetSplitGlyph</td>
<td>Retrieves the glyph associated with the current split button control.</td>
</tr>
<tr>
<td>GetSplitImageList</td>
<td>Retrieves the image list for the current split button control.</td>
</tr>
<tr>
<td>GetSplitInfo</td>
<td>Retrieves information that defines the current split button control.</td>
</tr>
<tr>
<td>GetSplitSize</td>
<td>Retrieves the bounding rectangle of the drop-down component of the current split button control.</td>
</tr>
<tr>
<td>GetSplitStyle</td>
<td>Retrieves the split button styles that define the current split button control.</td>
</tr>
<tr>
<td>GetState</td>
<td>Retrieves the check state, highlight state, and focus state of a button control.</td>
</tr>
<tr>
<td>GetTextMargin</td>
<td>Retrieves the text margin of the button control.</td>
</tr>
<tr>
<td>SetBitmap</td>
<td>Specifies a bitmap to be displayed on the button.</td>
</tr>
<tr>
<td>SetButtonStyle</td>
<td>Changes the style of a button.</td>
</tr>
<tr>
<td>SetCheck</td>
<td>Specifies a cursor image to be displayed on the button.</td>
</tr>
<tr>
<td>SetDropDownState</td>
<td>Sets the drop-down state of the current split button control.</td>
</tr>
<tr>
<td>SetIcon</td>
<td>Specifies an icon to be displayed on the button.</td>
</tr>
<tr>
<td>SetImageList</td>
<td>Sets the image list of the button control.</td>
</tr>
<tr>
<td>SetNote</td>
<td>Sets the note on the current command link control.</td>
</tr>
<tr>
<td>SetSplitGlyph</td>
<td>Associates a specified glyph with the current split button control.</td>
</tr>
<tr>
<td>SetSplitImageList</td>
<td>Associates an image list with the current split button control.</td>
</tr>
<tr>
<td>SetSplitInfo</td>
<td>Specifies information that defines the current split button control.</td>
</tr>
<tr>
<td>SetSplitSize</td>
<td>Sets the bounding rectangle of the drop-down component of the current split button control.</td>
</tr>
<tr>
<td>SetSplitStyle</td>
<td>Sets the style of the current split button control.</td>
</tr>
<tr>
<td>SetState</td>
<td>Sets the highlighting state of a button control.</td>
</tr>
<tr>
<td>SetTextMargin</td>
<td>Sets the text margin of the button control.</td>
</tr>
</tbody>
</table>
Here is the list of messages mapping for checkbox control:

<table>
<thead>
<tr>
<th>Message</th>
<th>Map entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BN_CLICKED</td>
<td>ON_BN_CLICKED(&lt;id&gt;,&lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is clicked.</td>
</tr>
<tr>
<td>BN_DISABLE</td>
<td>ON_BN_DISABLE(&lt;id&gt;,&lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is disabled.</td>
</tr>
<tr>
<td>BN_DOUBLECLICKED</td>
<td>ON_BN_DOUBLECLICKED(&lt;id&gt;,&lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is double clicked.</td>
</tr>
<tr>
<td>BN_PAINT</td>
<td>ON_BN_PAINT(&lt;id&gt;,&lt;memberFxn&gt; )</td>
<td>The framework calls this member function when an application makes a request to repaint a button.</td>
</tr>
</tbody>
</table>

Let us create a new MFC dialog based project.

Once the project is created, you will see the following dialog box in designer window.

**Step 1:** Delete the TODO line and drag one checkbox and one Edit control as shown in the following snapshot. Also change the caption of checkbox to Enable Control.
Step 2: Right-click on the checkbox and select Add Variable.

Step 3: You can select different options on this dialog box. For checkbox, the CButton variable type is selected by default.

Step 4: Similarly, the control ID is also selected by default. We now need to select Control in the Category combo box, and type m_enableDisableCheck in the Variable Name edit box and click Finish.

Step 5: Add Control Variable of Edit control with the settings as shown in the following snapshot.
Step 6: Observe the header file of the dialog class. You can see that these two variables have been added now.

```cpp
CBUTTON m_enableDisbleCheck;
CEDIT m_myEditControl;
```

Step 7: Right-click on the checkbox and select Add Variable.
Step 8: Click Finish to continue.
**Step 9:** Add value Variable for Edit control with the settings as shown in the following snapshot.

![Add Member Variable Wizard](image)

**Step 10:** Observe the header file. You can see that the new variables have been added now.

```cpp
bool m_enableDisableVal;
CString m_editControlVal;
```

**Step 11:** Now we will add event handler for checkbox.

**Step 12:** Right-click the control for which you want to handle the notification event.
Step 13: Select the event in the Message type box to add to the class selected in the Class list box.

Step 14: Accept the default name in the Function handler name box, or provide a name of your choice.

Step 15: Click Add and Edit to add the event handler.

Step 16: You can now see the following event added at the end of CMFCControlManagementDlg.cpp file.

```c
void CMFCControlManagementDlg::OnBnClickedCheck1()
{
    // TODO: Add your control notification handler code here
}
```

Step 17: This enables/disables the edit control when the checkbox is checked/unchecked.
Step 18: We have now added the checkbox click event handler. Here is the implementation of event handler for checkbox.

```cpp
void CMFCControlManagementDlg::OnBnClickedCheck1()
{
    // TODO: Add your control notification handler code here
    UpdateData(TRUE);
    if (m_enableDisableVal)
        m_myEditControl.EnableWindow(TRUE);
    else
        m_myEditControl.EnableWindow(FALSE);
}
```

Step 19: We need to add the following code to CMFCControlManagementDlg::OnInitDialog(). When the dialog is created, it will manage these controls.

```cpp
UpdateData(TRUE);
if (m_enableDisableVal)
    m_myEditControl.EnableWindow(TRUE);
else
    m_myEditControl.EnableWindow(FALSE);
```

Step 20: Here is the complete implementation of CMFCControlManagementDlg.cpp file.

```cpp
// MFCControlManagementDlg.cpp : implementation file

#include "stdafx.h"
#include "MFCControlManagement.h"
#include "MFCControlManagementDlg.h"
#include "afxdialogex.h"

#ifdef _DEBUG
#define new DEBUG_NEW
#endif

#ifdef new
#define new DEBUG_NEW
#endif
```
class CAboutDlg : public CDialogEx
{
    public:
        CAboutDlg();

    // Dialog Data
    #ifdef AFX_DESIGN_TIME
        enum { IDD = IDD_ABOUTBOX };  
    #endif

    protected:
        virtual void DoDataExchange(CDataExchange* pDX);   // DDX/DDV support

    // Implementation
    protected:
        DECLARE_MESSAGE_MAP()
    };

CAboutDlg::CAboutDlg() : CDialogEx(IDC_ABOUTBOX) {
}

void CAboutDlg::DoDataExchange(CDataExchange* pDX) {
    CDialogEx::DoDataExchange(pDX);
}

BEGIN_MESSAGE_MAP(CAboutDlg, CDialogEx)

END_MESSAGE_MAP()

CMFCControlManagementDlg::CMFCControlManagementDlg(CWnd* pParent /*=NULL*/)
    : CDialogEx(IDD_MFCCONTROLMANAGEMENT_DIALOG, pParent)
    , m_enableDisableVal(FALSE)
    , m_editControlVal(_T("")
{
}
m_hIcon = AfxGetApp()->LoadIcon(IDR_MAINFRAME);
}

void CMFCControlManagementDlg::DoDataExchange(CDataExchange* pDX)
{
    CDialogEx::DoDataExchange(pDX);
    DDX_Control(pDX, IDC_CHECK1, m_enableDisableCheck);
    DDX_Control(pDX, IDC_EDIT1, m_myEditControl);
    DDX_Check(pDX, IDC_CHECK1, m_enableDisableVal);
    DDX_Text(pDX, IDC_EDIT1, m_editControlVal);
}

BEGIN_MESSAGE_MAP(CMFCControlManagementDlg, CDialogEx)
    ON_WM_SYSCOMMAND()
    ON_WM_PAINT()
    ON_WM_QUERYDRAGICON()
    ON_BN_CLICKED(IDC_CHECK1, &CMFCControlManagementDlg::OnBnClickedCheck1)
END_MESSAGE_MAP()

// CMFCControlManagementDlg message handlers

BOOL CMFCControlManagementDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Add "About..." menu item to system menu.

    // IDM_ABOUTBOX must be in the system command range.
    ASSERT((IDM_ABOUTBOX & 0xFFF0) == IDM_ABOUTBOX);
    ASSERT(IDM_ABOUTBOX < 0xF000);

    CMenu* pSysMenu = GetSystemMenu(FALSE);
    if (pSysMenu != NULL)
    {
        BOOL bNameValid;
        CString strAboutMenu;
        pSysMenu = GetSystemMenu(FALSE);
        if (pSysMenu != NULL)
        {
            bNameValid = TRUE;
            strAboutMenu = lstrcmpiA("CMFCControlManagementDlg", pSysMenu->GetMenuName(0)) == 0;
            if (bNameValid)
            {
                pSysMenu->AppendMenu(MF_SEPARATOR);
                pSysMenu->AppendMenu(MF_STRING, IDM_ABOUTBOX, "About..." NWSTR);
            }
        }
    }

    return TRUE;
}
bNameValid = strAboutMenu.LoadString(IDS_ABOUTBOX);
ASSERT(bNameValid);
if (!strAboutMenu.IsEmpty())
{
    pSysMenu->AppendMenu(MF_SEPARATOR);
    pSysMenu->AppendMenu(MF_STRING, IDM_ABOUTBOX, strAboutMenu);
}

// Set the icon for this dialog. The framework does this automatically
// when the application's main window is not a dialog
SetIcon(m_hIcon, TRUE); // Set big icon
SetIcon(m_hIcon, FALSE); // Set small icon

// TODO: Add extra initialization here
UpdateData(TRUE);
if (m_enableDisableVal)
    m_myEditControl.EnableWindow(TRUE);
else
    m_myEditControl.EnableWindow(FALSE);

return TRUE; // return TRUE unless you set the focus to a control

void CMFCControlManagementDlg::OnSysCommand(UINT nID, LPARAM lParam)
{
    if ((nID & 0xFFF0) == IDM_ABOUTBOX)
    {
        CAboutDlg dlgAbout;
        dlgAbout.DoModal();
    }
    else
    {
        CDialogEx::OnSysCommand(nID, lParam);
    }
}
// If you add a minimize button to your dialog, you will need the code below
// to draw the icon. For MFC applications using the document/view model,
// this is automatically done for you by the framework.

void CMFCControlManagementDlg::OnPaint()
{
    if (IsIconic())
    {
        CPaintDC dc(this); // device context for painting

        SendMessage(WM_ICONERASEBKGND,
                    reinterpret_cast<WPARAM>(dc.GetSafeHdc()), 0);

        // Center icon in client rectangle
        int cxIcon = GetSystemMetrics(SM_CXICON);
        int cyIcon = GetSystemMetrics(SM_CYICON);
        CRect rect;
        GetClientRect(&rect);
        int x = (rect.Width() - cxIcon + 1) / 2;
        int y = (rect.Height() - cyIcon + 1) / 2;

        // Draw the icon
        dc.DrawIcon(x, y, m_hIcon);
    }
    else
    {
        CDialogEx::OnPaint();
    }
}

// The system calls this function to obtain the cursor to display while the
// user drags the minimized window.
HCURSOR CMFCControlManagementDlg::OnQueryDragIcon()
{
    return static_cast<HCURSOR>(m_hIcon);
}
void CMFCControlManagementDlg::OnBnClickedCheck1()
{
    // TODO: Add your control notification handler code here
    UpdateData(TRUE);
    if (m_enableDisableVal)
    {
        m_myEditControl.EnableWindow(TRUE);
    }
    else
    {
        m_myEditControl.EnableWindow(FALSE);
    }
}

**Step 21:** When the above code is compiled and executed, you will see the following output. You can now see the checkbox is unchecked by default. This disables the edit control.

![Checkbox Example](image)

**Step 22:** Now when you check the checkbox, the edit control is enabled.
Image Lists

An Image List is a collection of same-sized images, each of which can be referred to by its zero-based index. Image lists are used to efficiently manage large sets of icons or bitmaps. Image lists are represented by CImageList class.

Here is the list of methods in CImageList class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Adds an image or images to an image list.</td>
</tr>
<tr>
<td>Attach</td>
<td>Attaches an image list to a CImageList object.</td>
</tr>
<tr>
<td>BeginDrag</td>
<td>Begins dragging an image.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies an image within a CImageList object.</td>
</tr>
<tr>
<td>Create</td>
<td>Initializes an image list and attaches it to a CImageList object.</td>
</tr>
<tr>
<td>DeleteImageList</td>
<td>Deletes an image list.</td>
</tr>
<tr>
<td>DeleteTempMap</td>
<td>Called by the CWinApp idle-time handler to delete any temporary CImageList object created by FromHandle.</td>
</tr>
<tr>
<td>Detach</td>
<td>Detaches an image list object from a CImageList object and returns a handle to an image list.</td>
</tr>
<tr>
<td>DragEnter</td>
<td>Locks updates during a drag operation and displays the drag image at a specified position.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DragLeave</td>
<td>Unlocks the window and hides the drag image so that the window can be updated.</td>
</tr>
<tr>
<td>DragMove</td>
<td>Moves the image that is being dragged during a drag-and-drop operation.</td>
</tr>
<tr>
<td>DragShowNolock</td>
<td>Shows or hides the drag image during a drag operation, without locking the window.</td>
</tr>
<tr>
<td>Draw</td>
<td>Draws the image that is being dragged during a drag-and-drop operation.</td>
</tr>
<tr>
<td>DrawEx</td>
<td>Draws an image list item in the specified device context. The function uses the specified drawing style and blends the image with the specified color.</td>
</tr>
<tr>
<td>DrawIndirect</td>
<td>Draws an image from an image list.</td>
</tr>
<tr>
<td>EndDrag</td>
<td>Ends a drag operation.</td>
</tr>
<tr>
<td>ExtractIcon</td>
<td>Creates an icon based on an image and mask in an image list.</td>
</tr>
<tr>
<td>FromHandle</td>
<td>Returns a pointer to a CImageList object when given a handle to an image list. If a CImageList object is not attached to the handle, a temporary CImageList object is created and attached.</td>
</tr>
<tr>
<td>FromHandlePermanent</td>
<td>Returns a pointer to a CImageList object when given a handle to an image list. If a CImageList object is not attached to the handle, NULL is returned.</td>
</tr>
<tr>
<td>GetBkColor</td>
<td>Retrieves the current background color for an image list.</td>
</tr>
<tr>
<td>GetDragImage</td>
<td>Gets the temporary image list that is used for dragging.</td>
</tr>
<tr>
<td>GetImageCount</td>
<td>Retrieves the number of images in an image list.</td>
</tr>
<tr>
<td>GetImageInfo</td>
<td>Retrieves information about an image.</td>
</tr>
<tr>
<td>GetSafeHandle</td>
<td>Retrieves m_hImageList.</td>
</tr>
<tr>
<td>Read</td>
<td>Reads an image list from an archive.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes an image from an image list.</td>
</tr>
<tr>
<td>Replace</td>
<td>Replaces an image in an image list with a new image.</td>
</tr>
<tr>
<td>SetBkColor</td>
<td>Sets the background color for an image list.</td>
</tr>
<tr>
<td>SetDragCursorImage</td>
<td>Creates a new drag image.</td>
</tr>
<tr>
<td>SetImageCount</td>
<td>Resets the count of images in an image list.</td>
</tr>
</tbody>
</table>
SetOverlayImage
Adds the zero-based index of an image to the list of images to be used as overlay masks.

Write
Writes an image list to an archive.

Let us create a new MFC Application **MFCImageListDemo** with the following settings.

**Step 1:** Add bmp file as a resource in your application.

**Step 2:** In header file of CMFCImageListDemoView class, add the following two variables.

```cpp
CImageList ImageList;
int nImage;
```

**Step 3:** Add the following code in constructor of CMFCImageListDemoView.

```cpp
CMFCImageListDemoView::CMFCImageListDemoView()
{
    // TODO: add construction code here
    ImageList.Create(800, 800, ILC_COLOR, 4, 1);

    CBitmap bmp;
}
Microsoft Foundation Classes

```cpp
bmp.LoadBitmap(IDB_BITMAP1);
ImageList.Add(&bmp, RGB(0, 0, 0));
```

Step 4: Call the CImageList::Draw() method as follows.

```cpp
void CMFCImageListDemoView::OnDraw(CDC* pDC)
{
    CMFCImageListDemoDoc* pDoc = GetDocument();
    ASSERT_VALID(pDoc);

    nImage = 0;
    ImageList.Draw(pDC, nImage, CPoint(0,0), ILD_NORMAL);
    Invalidate();

    if (!pDoc)
    {
        return;
    }

    // TODO: add draw code for native data here
}
```

Step 5: When you run this application, you will see the following output.
Edit Box

An Edit Box is a rectangular child window in which the user can enter text. It is represented by CEdit class.

Here is the list of methods in CEdit class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CanUndo</td>
<td>Determines whether an edit-control operation can be undone.</td>
</tr>
<tr>
<td>CharFromPos</td>
<td>Retrieves the line and character indexes for the character closest to a specified position.</td>
</tr>
<tr>
<td>Clear</td>
<td>Deletes (clears) the current selection (if any) in the edit control.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the current selection (if any) in the edit control to the Clipboard in CF_TEXT format.</td>
</tr>
<tr>
<td>Create</td>
<td>Creates the Windows edit control and attaches it to the CEdit object.</td>
</tr>
<tr>
<td>Cut</td>
<td>Deletes (cuts) the current selection (if any) in the edit control and copies the deleted text to the Clipboard in CF_TEXT format.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EmptyUndoBuffer</td>
<td>Resets (clears) the undo flag of an edit control.</td>
</tr>
<tr>
<td>FmtLines</td>
<td>Sets the inclusion of soft line-break characters on or off within a multiple-line edit control.</td>
</tr>
<tr>
<td>GetCueBanner</td>
<td>Retrieves the text that is displayed as the text cue, or tip, in an edit control when the control is empty and does not have focus.</td>
</tr>
<tr>
<td>GetFirstVisibleLine</td>
<td>Determines the topmost visible line in an edit control.</td>
</tr>
<tr>
<td>GetHandle</td>
<td>Retrieves a handle to the memory that is currently allocated for a multiple-line edit control.</td>
</tr>
<tr>
<td>GetHighlight</td>
<td>Gets the indexes of the starting and ending characters in a range of text that is highlighted in the current edit control.</td>
</tr>
<tr>
<td>GetLimitText</td>
<td>Gets the maximum amount of text this CEdit can contain.</td>
</tr>
<tr>
<td>GetLine</td>
<td>Retrieves a line of text from an edit control.</td>
</tr>
<tr>
<td>GetLineCount</td>
<td>Retrieves the number of lines in a multiple-line edit control.</td>
</tr>
<tr>
<td>GetMargins</td>
<td>Gets the left and right margins for this CEdit.</td>
</tr>
<tr>
<td>GetModify</td>
<td>Determines whether the contents of an edit control have been modified.</td>
</tr>
<tr>
<td>GetPasswordChar</td>
<td>Retrieves the password character displayed in an edit control when the user enters text.</td>
</tr>
<tr>
<td>GetRect</td>
<td>Gets the formatting rectangle of an edit control.</td>
</tr>
<tr>
<td>GetSel</td>
<td>Gets the first and last character positions of the current selection in an edit control.</td>
</tr>
<tr>
<td>HideBalloonTip</td>
<td>Hides any balloon tip associated with the current edit control.</td>
</tr>
<tr>
<td>LimitText</td>
<td>Limits the length of the text that the user can enter into an edit control.</td>
</tr>
<tr>
<td>LineFromChar</td>
<td>Retrieves the line number of the line that contains the specified character index.</td>
</tr>
<tr>
<td>LineIndex</td>
<td>Retrieves the character index of a line within a multiple-line edit control.</td>
</tr>
<tr>
<td>LineLength</td>
<td>Retrieves the length of a line in an edit control.</td>
</tr>
<tr>
<td>LineScroll</td>
<td>Scrolls the text of a multiple-line edit control.</td>
</tr>
<tr>
<td>Paste</td>
<td>Inserts the data from the Clipboard into the edit control at the current cursor position. Data is inserted only if the Clipboard contains data in CF_TEXT format.</td>
</tr>
<tr>
<td>PosFromChar</td>
<td>Retrieves the coordinates of the upper-left corner of a specified character index.</td>
</tr>
<tr>
<td>ReplaceSel</td>
<td>Replaces the current selection in an edit control with the specified text.</td>
</tr>
<tr>
<td>SetCueBanner</td>
<td>Sets the text that is displayed as the text cue, or tip, in an edit control when the control is empty and does not have focus.</td>
</tr>
</tbody>
</table>
### Microsoft Foundation Classes

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SetHandle</td>
<td>Sets the handle to the local memory that will be used by a multiple-line edit control.</td>
</tr>
<tr>
<td>SetHighlight</td>
<td>Highlights a range of text that is displayed in the current edit control.</td>
</tr>
<tr>
<td>SetLimitText</td>
<td>Sets the maximum amount of text this CEdit can contain.</td>
</tr>
<tr>
<td>SetMargins</td>
<td>Sets the left and right margins for this CEdit.</td>
</tr>
<tr>
<td>SetModify</td>
<td>Sets or clears the modification flag for an edit control.</td>
</tr>
<tr>
<td>SetPasswordChar</td>
<td>Sets or removes a password character displayed in an edit control when the user enters text.</td>
</tr>
<tr>
<td>SetReadOnly</td>
<td>Sets the read-only state of an edit control.</td>
</tr>
<tr>
<td>SetRect</td>
<td>Sets the formatting rectangle of a multiple-line edit control and updates the control.</td>
</tr>
<tr>
<td>SetRectNP</td>
<td>Sets the formatting rectangle of a multiple-line edit control without redrawing the control window.</td>
</tr>
<tr>
<td>SetSel</td>
<td>Selects a range of characters in an edit control.</td>
</tr>
<tr>
<td>SetTabStops</td>
<td>Sets the tab stops in a multiple-line edit control.</td>
</tr>
<tr>
<td>ShowBalloonTip</td>
<td>Displays a balloon tip that is associated with the current edit control.</td>
</tr>
<tr>
<td>Undo</td>
<td>Reverses the last edit-control operation.</td>
</tr>
</tbody>
</table>

Here is the list of messages mapping for Edit Control.

<table>
<thead>
<tr>
<th>Message</th>
<th>Map entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN_CHANGE</td>
<td>ON_EN_CHANGE(id), memberFxn()</td>
<td>The user has taken an action that may have altered text in an edit control</td>
</tr>
<tr>
<td>EN_ERRSPACE</td>
<td>ON_EN_ERRSPACE(id), memberFxn()</td>
<td>The edit control cannot allocate enough memory to meet a specific request.</td>
</tr>
<tr>
<td>EN_HSCROLL</td>
<td>ON_EN_HSCROLL(id), memberFxn()</td>
<td>The user clicks an edit control's horizontal scroll bar. The parent window is notified before the screen is updated.</td>
</tr>
<tr>
<td>EN_KILLFOCUS</td>
<td>ON_EN_KILLFOCUS(id), memberFxn()</td>
<td>The edit control loses the input focus.</td>
</tr>
<tr>
<td>MAXTEXT</td>
<td>ON_EN_MAXTEXT(id), memberFxn()</td>
<td>The current insertion has exceeded the specified number of characters for the edit control.</td>
</tr>
</tbody>
</table>
EN_SETFOCUS

ON_EN_SETFOCUS( <id>, <memberFxn> )

Sent when an edit control receives the input focus.

EN_UPDATE

ON_EN_UPDATE( <id>, <memberFxn> )

The edit control is about to display altered text. Sent after the control has formatted the text but before it screens the text so that the window size can be altered, if necessary.

EN_VSCROLL

ON_EN_VSCROLL( <id>, <memberFxn> )

The user clicks an edit control's vertical scroll bar. The parent window is notified before the screen is updated.

Let us into a simple example by creating a new MFC dialog based project.

**Step 1:** Remove the caption of Static Text control and drag one button and one Edit control.

**Step 2:** Add a control variable `m_editCtrl` for edit control and value variable `m_strTextCtrl` for Static text control.
**Step 3:** Add the event handler for button click event.

![Image of Event Handler Wizard]

**Step 4:** Here is the implementation of event handler for button click event.

```cpp
void CMFCEditDlg::OnBnClickedButton1()
{
    // TODO: Add your control notification handler code here
    CString str = _T("");
    m_editCtrl.GetWindowTextW(str);

    if (!str.IsEmpty())
        m_strTextCtrl = str;
    else
        m_strTextCtrl = _T("Write Something");
    UpdateData(FALSE);
}
```
Step 5: When the above code is compiled and executed, you will see the following.

![Image of MFCEdit control]

Step 6: When you write text in the edit control and click Display, it will update that text on Static Text Control.

Rich Edit

A Rich Edit Control is a window in which the user can enter and edit text. The text can be assigned character and paragraph formatting, and can include embedded OLE objects. It is represented by CRichEditCtrl class.

Here is the list of methods in CRichEditCtrl class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CanPaste</td>
<td>Determines if the contents of the Clipboard can be pasted into this rich edit control.</td>
</tr>
<tr>
<td>CanRedo</td>
<td>Determines whether there are any actions in the controls redo queue.</td>
</tr>
<tr>
<td>CanUndo</td>
<td>Determines if an editing operation can be undone.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CharFromPos</td>
<td>Retrieves information about the character closest to a specified point in the client area of an edit control.</td>
</tr>
<tr>
<td>Clear</td>
<td>Clears the current selection.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the current selection to the Clipboard.</td>
</tr>
<tr>
<td>Create</td>
<td>Creates the Windows rich edit control and associates it with this CRichEditCtrl object.</td>
</tr>
<tr>
<td>CreateEx</td>
<td>Creates the Windows rich edit control with the specified extended Windows styles and associates it with this CRichEditCtrl object.</td>
</tr>
<tr>
<td>Cut</td>
<td>Cuts the current selection to the Clipboard.</td>
</tr>
<tr>
<td>DisplayBand</td>
<td>Displays a portion of the contents of this CRichEditCtrl object.</td>
</tr>
<tr>
<td>EmptyUndoBuffer</td>
<td>Resets (clears) the undo flag of this CRichEditCtrl object.</td>
</tr>
<tr>
<td>FindText</td>
<td>Locates text within this CRichEditCtrl object.</td>
</tr>
<tr>
<td>FindWordBreak</td>
<td>Finds the next word break before or after the specified character position, or retrieves information about the character at that position.</td>
</tr>
<tr>
<td>FormatRange</td>
<td>Formats a range of text for the target output device.</td>
</tr>
<tr>
<td>GetCharPos</td>
<td>Determines the location of a given character within this CRichEditCtrl object.</td>
</tr>
<tr>
<td>GetDefaultCharFormat</td>
<td>Retrieves the current default character formatting attributes in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>GetEventMask</td>
<td>Retrieves the event mask for this CRichEditCtrl object.</td>
</tr>
<tr>
<td>GetFirstVisibleLine</td>
<td>Determines the topmost visible line in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>GetIRichEditOle</td>
<td>Retrieves a pointer to the IRichEditOle interface for this rich edit control.</td>
</tr>
<tr>
<td>GetLimitText</td>
<td>Gets the limit on the amount of text a user can enter into this CRichEditCtrl object.</td>
</tr>
<tr>
<td>GetLine</td>
<td>Retrieves a line of text from this CRichEditCtrl object.</td>
</tr>
<tr>
<td>GetLineCount</td>
<td>Retrieves the number of lines in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>GetModify</td>
<td>Determines if the contents of this CRichEditCtrl object have changed since the last save.</td>
</tr>
<tr>
<td>Method Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GetOptions</td>
<td>Retrieves the rich edit control options.</td>
</tr>
<tr>
<td>GetParaFormat</td>
<td>Retrieves the paragraph formatting attributes in the current selection in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>GetPunctuation</td>
<td>Retrieves the current punctuation characters for the rich edit control. This message is available only in Asian-language versions of the operating system.</td>
</tr>
<tr>
<td>GetRect</td>
<td>Retrieves the formatting rectangle for this CRichEditCtrl object.</td>
</tr>
<tr>
<td>GetRedoName</td>
<td>Retrieves the type of the next action, if any, in the control's redo queue.</td>
</tr>
<tr>
<td>GetSel</td>
<td>Gets the starting and ending positions of the current selection in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>GetSelectionCharFormat</td>
<td>Retrieves the character formatting attributes in the current selection in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>GetSelectionType</td>
<td>Retrieves the type of contents in the current selection in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>GetSelText</td>
<td>Gets the text of the current selection in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>GetTextLength</td>
<td>Retrieves the length of the text, in characters, in this CRichEditCtrl object. Does not include the terminating null character.</td>
</tr>
<tr>
<td>GetTextLengthEx</td>
<td>Retrieves the number of characters or bytes in the rich edit view. Accepts a list of flags to indicate the method of determining length of the text in a rich edit control</td>
</tr>
<tr>
<td>GetTextMode</td>
<td>Retrieves the current text mode and undo level of a rich edit control.</td>
</tr>
<tr>
<td>GetTextRange</td>
<td>Retrieves the specified range of text.</td>
</tr>
<tr>
<td>GetUndoName</td>
<td>Retrieves the type of the next undo action, if any.</td>
</tr>
<tr>
<td>GetWordWrapMode</td>
<td>Retrieves the current word wrapping and word breaking options for the rich edit control. This message is available only</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HideSelection</td>
<td>Shows or hides the current selection.</td>
</tr>
<tr>
<td>LimitText</td>
<td>Limits the amount of text a user can enter into the CRichEditCtrl object.</td>
</tr>
<tr>
<td>LineFromChar</td>
<td>Determines which line contains the given character.</td>
</tr>
<tr>
<td>LineIndex</td>
<td>Retrieves the character index of a given line in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>LineLength</td>
<td>Retrieves the length of a given line in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>LineScroll</td>
<td>Scrolls the text in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>Paste</td>
<td>Inserts the contents of the Clipboard into this rich edit control.</td>
</tr>
<tr>
<td>PasteSpecial</td>
<td>Inserts the contents of the Clipboard into this rich edit control in the specified data format.</td>
</tr>
<tr>
<td>PosFromChar</td>
<td>Retrieves the client area coordinates of a specified character in an edit control.</td>
</tr>
<tr>
<td>Redo</td>
<td>Redoes the next action in the control's redo queue.</td>
</tr>
<tr>
<td>ReplaceSel</td>
<td>Replaces the current selection in this CRichEditCtrl object with specified text.</td>
</tr>
<tr>
<td>RequestResize</td>
<td>Forces this CRichEditCtrl object to send request resize notifications.</td>
</tr>
<tr>
<td>SetAutoURLDetect</td>
<td>Indicates if the auto URL detection is active in a rich edit control.</td>
</tr>
<tr>
<td>SetBackgroundColor</td>
<td>Sets the background color in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>SetDefaultCharFormat</td>
<td>Sets the current default character formatting attributes in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>SetEventMask</td>
<td>Sets the event mask for this CRichEditCtrl object.</td>
</tr>
<tr>
<td>SetModify</td>
<td>Sets or clears the modification flag for this CRichEditCtrl object.</td>
</tr>
<tr>
<td>SetOLECallback</td>
<td>Sets the IRichEditOleCallback COM object for this rich edit control.</td>
</tr>
<tr>
<td>SetOptions</td>
<td>Sets the options for this CRichEditCtrl object.</td>
</tr>
<tr>
<td>SetParaFormat</td>
<td>Sets the paragraph formatting attributes in the current CRichEditCtrl object.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SetPunctuation</td>
<td>Sets the punctuation characters for a rich edit control. This message is available only in Asian-language versions of the operating system.</td>
</tr>
<tr>
<td>SetReadOnly</td>
<td>Sets the read-only option for this CRichEditCtrl object.</td>
</tr>
<tr>
<td>SetRect</td>
<td>Sets the formatting rectangle for this CRichEditCtrl object.</td>
</tr>
<tr>
<td>SetSel</td>
<td>Sets the selection in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>SetSelectionCharFormat</td>
<td>Sets the character formatting attributes in the current selection in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>SetTargetDevice</td>
<td>Sets the target output device for this CRichEditCtrl object.</td>
</tr>
<tr>
<td>SetTextStyle</td>
<td>Sets the text mode or undo level of a rich edit control. The message fails if the control contains text.</td>
</tr>
<tr>
<td>SetUndoLimit</td>
<td>Sets the maximum number of actions that can be stored in the undo queue.</td>
</tr>
<tr>
<td>SetWordCharFormat</td>
<td>Sets the character formatting attributes in the current word in this CRichEditCtrl object.</td>
</tr>
<tr>
<td>SetWordWrapMode</td>
<td>Sets the word-wrapping and word-breaking options for the rich edit control. This message is available only in Asian-language versions of the operating system.</td>
</tr>
<tr>
<td>StopGroupTyping</td>
<td>Stops the control from collecting additional typing actions into the current undo action. The control stores the next typing action, if any, into a new action in the undo queue.</td>
</tr>
<tr>
<td>StreamIn</td>
<td>Inserts text from an input stream into this CRichEditCtrl object.</td>
</tr>
<tr>
<td>StreamOut</td>
<td>Stores text from this CRichEditCtrl object into an output stream.</td>
</tr>
<tr>
<td>Undo</td>
<td>Reverses the last editing operation.</td>
</tr>
</tbody>
</table>

Here is the list of messages mapping for Rich Edit Control:
<table>
<thead>
<tr>
<th>Message</th>
<th>Map entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN_CHANGE</td>
<td>ON_EN_CHANGE( &lt;id&gt;, &lt;memberFxN&gt; )</td>
<td>The user has taken an action that may have altered text in an edit control.</td>
</tr>
<tr>
<td>EN_ERRSPACE</td>
<td>ON_EN_ERRSPACE( &lt;id&gt;, &lt;memberFxN&gt; )</td>
<td>The edit control cannot allocate enough memory to meet a specific request.</td>
</tr>
<tr>
<td>EN_HSCROLL</td>
<td>ON_EN_HSCROLL( &lt;id&gt;, &lt;memberFxN&gt; )</td>
<td>The user clicks an edit control's horizontal scroll bar. The parent window is notified before the screen is updated.</td>
</tr>
<tr>
<td>EN_KILLFOCUS</td>
<td>ON_EN_KILLFOCUS( &lt;id&gt;, &lt;memberFxN&gt; )</td>
<td>The edit control loses the input focus.</td>
</tr>
<tr>
<td>MAXTEXT</td>
<td>ON_EN_MAXTEXT( &lt;id&gt;, &lt;memberFxN&gt; )</td>
<td>The current insertion has exceeded the specified number of characters for the edit control and has been truncated.</td>
</tr>
<tr>
<td>EN_SETFOCUS</td>
<td>ON_EN_SETFOCUS( &lt;id&gt;, &lt;memberFxN&gt; )</td>
<td>Sent when an edit control receives the input focus.</td>
</tr>
<tr>
<td>EN_UPDATE</td>
<td>ON_EN_UPDATE( &lt;id&gt;, &lt;memberFxN&gt; )</td>
<td>The edit control is about to display altered text. Sent after the control has formatted the text but before it screens the text so that the window size can be altered, if necessary.</td>
</tr>
<tr>
<td>EN_VSCROLL</td>
<td>ON_EN_VSCROLL( &lt;id&gt;, &lt;memberFxN&gt; )</td>
<td>The user clicks an edit control's vertical scroll bar. The parent window is notified before the screen is updated.</td>
</tr>
</tbody>
</table>

Let us into a simple example by creating a new MFC dialog based application.

**Step 1:** Delete the TODO line and drag one Rich Edit Control and three buttons from the Toolbox.
Step 2: Change the Caption of these three buttons from Bold, Italic and Under Line to IDC_BUTTON_BOLD, IDC_BUTTON_ITALIC and IDC_BUTTON_UNDERLINE respectively.

Step 3: Set the following properties to True: Multiline, Want Return, Vertical Scroll.

Step 4: Add the control variable m_richEdit for Rich Edit Control.
Step 5: Go to the CMFCRichEditApp and call the `::AfxInitRichEdit2()` in CMFCRichEditApp::InitInstance() function as shown in the following code.

```cpp
BOOL CMFCRichEditApp::InitInstance()
{
    //TODO: call AfxInitRichEdit2() to initialize richedit2 library.
    // InitCommonControlsEx() is required on Windows XP if an application
    // manifest specifies use of ComCtl32.dll version 6 or later to enable
    // visual styles. Otherwise, any window creation will fail.
    INITCOMMONCONTROLSEX InitCtrls;
    InitCtrls.dwSize = sizeof(InitCtrls);
    // Set this to include all the common control classes you want to use
    // in your application.
    InitCtrls.dwICC = ICC_WIN95_CLASSES;
    InitCommonControlsEx(&InitCtrls);

    ::AfxInitRichEdit2();
}
```
CWinApp::InitInstance();

AfxEnableControlContainer();

// Create the shell manager, in case the dialog contains
// any shell tree view or shell list view controls.
CShellManager *pShellManager = new CShellManager;

// Activate "Windows Native" visual manager for enabling themes in MFC
// controls
CMFCVisualManager::SetDefaultManager(RUNTIME_CLASS(CMFCVisualManagerWindow));

// Standard initialization
// If you are not using these features and wish to reduce the size
// of your final executable, you should remove from the following
// the specific initialization routines you do not need
// Change the registry key under which our settings are stored
// TODO: You should modify this string to be something appropriate
// such as the name of your company or organization
SetRegistryKey(_T("Local AppWizard-Generated Applications"));

CMFCRichEditDlg dlg;
m_pMainWnd = &dlg;
INT_PTR nResponse = dlg.DoModal();
if (nResponse == IDOK)
{
    // TODO: Place code here to handle when the dialog is
    // dismissed with OK
}
else if (nResponse == IDCANCEL)
{
    // TODO: Place code here to handle when the dialog is
    // dismissed with Cancel
}
else if (nResponse == -1)
{
TRACE(traceAppMsg, 0, "Warning: dialog creation failed, so application is terminating unexpectedly.\n");

TRACE(traceAppMsg, 0, "Warning: if you are using MFC controls on the dialog, you cannot #define _AFX_NO_MFC_CONTROLS_IN_DIALOGS.\n");
}

// Delete the shell manager created above.
if (pShellManager != NULL)
{
    delete pShellManager;
}

// Since the dialog has been closed, return FALSE so that we exit the // application, rather than start the application's message pump.
return FALSE;

Step 6: Add the Click event handler for all the three buttons. Here is the implementation for these events.

void CMFCRichEditDlg::OnBnClickedButtonBold()
{
    // TODO: Add your control notification handler code here

    CHARFORMAT Cfm;

    m_richEdit.GetSelectionCharFormat(Cfm);

    Cfm.cbSize = sizeof(CHARFORMAT);
    Cfm.dwMask = CFM_BOLD;
    Cfm.dwEffects ^= CFE_BOLD;

    m_richEdit.SetSelectionCharFormat(Cfm);
    m_richEdit.SetFocus();
}

void CMFCRichEditDlg::OnBnClickedButtonItalic()
{
    // TODO: Add your control notification handler code here
Step 7: When the above code is compiled and executed, you will see the following output. Now enter text and change its formatting by selecting the text and then click on any of the three buttons.
Group Box

A group box is a static control used to set a visible or programmatic group of controls. The control is a rectangle that groups other controls together. The controls are grouped by drawing a border around them and displaying the given text in the upper-left corner.
In the following dialog box, the Group box contains three radio buttons inside.

![MFCadioButton](image)

## Spin Button

A **Spin Button** Control (also known as an up-down control) is a pair of arrow buttons that the user can click to increment or decrement a value, such as a scroll position or a number displayed in a companion control. It is represented by **CSpinButtonCtrl** class.

Here is the list of methods in **CSpinButtonCtrl** class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Creates a spin button control and attaches it to a CSpinButtonCtrl object.</td>
</tr>
<tr>
<td>CreateEx</td>
<td>Creates a spin button control with the specified Windows extended styles and attaches it to a CSpinButtonCtrl object.</td>
</tr>
<tr>
<td>GetAccel</td>
<td>Retrieves acceleration information for a spin button control.</td>
</tr>
<tr>
<td>GetBase</td>
<td>Retrieves the current base for a spin button control.</td>
</tr>
<tr>
<td>GetBuddy</td>
<td>Retrieves a pointer to the current buddy window.</td>
</tr>
<tr>
<td>GetPos</td>
<td>Retrieves the current position of a spin button control.</td>
</tr>
<tr>
<td>GetRange</td>
<td>Retrieves the upper and lower limits (range) for a spin button control.</td>
</tr>
<tr>
<td>SetAccel</td>
<td>Sets the acceleration for a spin button control.</td>
</tr>
<tr>
<td>SetBase</td>
<td>Sets the base for a spin button control.</td>
</tr>
<tr>
<td>SetBuddy</td>
<td>Sets the buddy window for a spin button control.</td>
</tr>
<tr>
<td>SetPos</td>
<td>Sets the current position for the control.</td>
</tr>
</tbody>
</table>
**SetRange**  
Sets the upper and lower limits (range) for a spin button control.

Here is the list of messages mapping for Spin Button control.

<table>
<thead>
<tr>
<th>Message</th>
<th>Map entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BN_CLICKED</td>
<td>ON_BN_CLICKED( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is clicked.</td>
</tr>
<tr>
<td>BN_DISABLE</td>
<td>ON_BN_DISABLE( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is disabled.</td>
</tr>
<tr>
<td>BN_DOUBLECLICKED</td>
<td>ON_BN_DOUBLECLICKED( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when the button is double clicked.</td>
</tr>
<tr>
<td>BN_PAINT</td>
<td>ON_BN_PAINT( &lt;id&gt;, &lt;memberFxn&gt; )</td>
<td>The framework calls this member function when an application makes a request to repaint a button.</td>
</tr>
</tbody>
</table>
Let us look into a simple example of Spin button by creating a new MFC dialog based application.

**Step 1:** Add one Spin Control and one Edit control from the Toolbox.

![Spin Control](image)

**Step 2:** Go to the Properties of Spin Control and set the values of **Auto Buddy** and **Set Buddy Integer** to True.

### Managing the Updown Control

**Step 1:** Add a control variable `m_spinControl` for spin control with the settings as shown in the following snapshot.
**Step 2:** Add the control variable `m_editControl` for Edit control.
**Step 3:** Add the event handler for UDN_DELTAPOS event for the spin button.
Step 4: Update the OnInitDialog() as shown in the following code.

```cpp
BOOL CMFCSpinButtonDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);    // Set big icon
    SetIcon(m_hIcon, FALSE);    // Set small icon

    // TODO: Add extra initialization here
    m_spinControl.SetRange(0, 100);
    m_spinControl.SetPos(50);
    m_editControl.SetWindowText(L"50");
    return TRUE;  // return TRUE unless you set the focus to a control
}
```
**Step 5:** Here is the implementation of spin control event.

```cpp
void CMFCSpinButtonDlg::OnDeltaposSpin1(NMHDR *pNMHDR, LRESULT *pResult)
{
    LPNMUPDOWN pNMUpDown = reinterpret_cast<LPNMUPDOWN>(pNMHDR);
    // TODO: Add your control notification handler code here
    // Declare a pointer to a CSpinButtonCtrl;
    CSpinButtonCtrl *Spinner;
    // Get a pointer to our spin button
    Spinner = reinterpret_cast<CSpinButtonCtrl *>(GetDlgItem(IDC_SPIN1));
    // Found out if it is our spin button that sent the message
    // This conditional statement appears useless but so what?
    if (pNMHDR->hwndFrom == Spinner->m_hWnd)
    {
        // Get the current value of the spin button
        int CurPos = pNMUpDown->iPos;
        // Convert the value to a string
        CString str;
        str.Format(L"%d", CurPos);
        // Display the value into the accompanying edit box
        m_editControl.SetWindowText(str);
    }
    *pResult = 0;
}
```

**Step 6:** When the above code is compiled and executed, you will see the following output.
A **progress bar control** is a window that an application can use to indicate the progress of a lengthy operation. It consists of a rectangle that is gradually filled, from left to right, with the system highlight color as an operation progresses. It is represented by `CProgressCtrl` class.

Here is the list of methods in `CProgressCtrl` class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Creates a progress bar control and attaches it to a <code>CProgressCtrl</code> object.</td>
</tr>
<tr>
<td>CreateEx</td>
<td>Creates a progress control with the specified Windows extended styles and attaches it to a <code>CProgressCtrl</code> object.</td>
</tr>
<tr>
<td>GetBarColor</td>
<td>Gets the color of the progress indicator bar for the current progress bar control.</td>
</tr>
<tr>
<td>GetBkColor</td>
<td>Gets the background color of the current progress bar.</td>
</tr>
<tr>
<td>GetPos</td>
<td>Gets the current position of the progress bar.</td>
</tr>
<tr>
<td>GetRange</td>
<td>Gets the lower and upper limits of the range of the progress bar control.</td>
</tr>
<tr>
<td>GetState</td>
<td>Gets the state of the current progress bar control.</td>
</tr>
<tr>
<td>GetStep</td>
<td>Retrieves the step increment for the progress bar of the current progress bar control.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>OffsetPos</td>
<td>Advances the current position of a progress bar control by a specified increment and redraws the bar to reflect the new position.</td>
</tr>
<tr>
<td>SetBarColor</td>
<td>Sets the color of the progress indicator bar in the current progress bar control.</td>
</tr>
<tr>
<td>SetBkColor</td>
<td>Sets the background color for the progress bar.</td>
</tr>
<tr>
<td>SetMarquee</td>
<td>Turns marquee mode on or off for the current progress bar control.</td>
</tr>
<tr>
<td>SetPos</td>
<td>Sets the current position for a progress bar control and redraws the bar to reflect the new position.</td>
</tr>
<tr>
<td>SetRange</td>
<td>Sets the minimum and maximum ranges for a progress bar control and redraws the bar to reflect the new ranges.</td>
</tr>
<tr>
<td>SetState</td>
<td>Sets the state of the current progress bar control.</td>
</tr>
<tr>
<td>SetStep</td>
<td>Specifies the step increment for a progress bar control.</td>
</tr>
<tr>
<td>StepIt</td>
<td>Advances the current position for a progress bar control by the step increment (see SetStep) and redraws the bar to reflect the new position.</td>
</tr>
</tbody>
</table>

Let us create a new MFC application.

**Step 1:** Change the ID of the Text control to and remove the caption.

**Step 2:** Drag Progress Control from the Toolbox.

**Step 3:** Add value variable for Static Text control.
**Step 4:** Add control variable for the Progress control.

**Step 5:** Here is the implementation in OnInitDialog()

```cpp
BOOL CMFCProgressControlDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Add "About..." menu item to system menu.

    // IDM_ABOUTBOX must be in the system command range.
    ASSERT((IDM_ABOUTBOX & 0xFFF0) == IDM_ABOUTBOX);
    ASSERT(IDM_ABOUTBOX < 0xF000);

    CMenu* pSysMenu = GetSystemMenu(FALSE);
    if (pSysMenu != NULL)
    {
        BOOL bNameValid;
        CString strAboutMenu;
        // ...
bNameValid = strAboutMenu.LoadString(IDS_ABOUTBOX);
ASSERT(bNameValid);
if (!strAboutMenu.IsEmpty())
{
    pSysMenu->AppendMenu(MF_SEPARATOR);
    pSysMenu->AppendMenu(MF_STRING, IDM_ABOUTBOX, strAboutMenu);
}

// Set the icon for this dialog. The framework does this automatically
// when the application's main window is not a dialog
SetIcon(m_hIcon, TRUE);  // Set big icon
SetIcon(m_hIcon, FALSE);  // Set small icon

// TODO: Add extra initialization here
m_progCtrl.SetRange(0, 100);

for (int i = 0; i <= 100; i++)
{
    m_progCtrl.SetPos(i);
}

return TRUE;  // return TRUE unless you set the focus to a control
Step 6: When the above code is compiled and executed, you will see the following output.

![Visual C++ progress control example](image)

**Progress Bars**

Besides the Progress control, Visual C++ provides two other progress-oriented controls:

- The Microsoft Progress Control Version 5.0
- The Microsoft Progress Control Version 6.0

The main difference is in their ability to assume one or two orientations.

Let us look into a simple example.
**Step 1:** Right-click on the dialog in the designer window.

**Step 2:** Select Insert ActiveX Control.
**Step 3:** Select the Microsoft ProgressBar Control 6.0 and click OK.

**Step 4:** Select the progress bar and set its Orientation in the Properties Window to 1 – `ccOrientationVertical`.

**Step 5:** Add control variable for Progress bar.

![Add Member Variable Wizard](image)

**Step 6:** Add the following code in the OnInitDialog()

```cpp
m_progBarCtrl1.SetScrollRange(0, 100, TRUE);
m_progBarCtrl1.put_Value(53);
```
Step 7: Run this application again and you will see the progress bar in Vertical direction as well.

Timer

A timer is a non-spatial object that uses recurring lapses of time from a computer or from your application. To work, every lapse of period, the control sends a message to the operating system. Unlike most other controls, the MFC timer has neither a button to represent it nor a class. To create a timer, you simply call the CWnd::SetTimer() method. This function call creates a timer for your application. Like the other controls, a timer uses an identifier.

Let us create a new MFC dialog based application.

Step 1: Remove the Caption and set its ID to IDC_STATIC_TXT.

Step 2: Add the value variable for text control.
**Step 3:** Go to the class view in solution.

**Step 4:** Click the CMFCTimeDlg class.

**Step 5:** In the Properties window, click the Messages button.
Step 6: Click the WM_TIMER field and click the arrow of its combo box. Select <Add> OnTimer and implement the event.

```cpp
void CMFTimerDlg::OnTimer(UINT_PTR nIDEvent)
{
    // TODO: Add your message handler code here and/or call default
    CTime CurrentTime = CTime::GetCurrentTime();

    int iHours = CurrentTime.GetHour();
    int iMinutes = CurrentTime.GetMinute();
    int iSeconds = CurrentTime.GetSecond();
    CString strHours, strMinutes, strSeconds;

    if (iHours < 10)
        strHours.Format(_T("0%d"), iHours);
    else
        strHours.Format(_T("%d"), iHours);

    if (iMinutes < 10)
        strMinutes.Format(_T("0%d"), iMinutes);
    else
        strMinutes.Format(_T("%d"), iMinutes);

    // More code here...
}
```
strMinutes.Format(_T("0%d"), iMinutes);
else
    strMinutes.Format(_T("%d"), iMinutes);

if (iSeconds < 10)
    strSeconds.Format(_T("0%d"), iSeconds);
else
    strSeconds.Format(_T("%d"), iSeconds);

m_strTimer.Format(_T("%s:%s:%s"), strHours, strMinutes, strSeconds);

UpdateData(FALSE);
CDialogEx::OnTimer(nIDEvent);
}

**Step 7:** When the above code is compiled and executed, you will see the following output.
Date & Time Picker

The date and time picker control (CDateTimeCtrl) implements an intuitive and recognizable method of entering or selecting a specific date. The main interface of the control is similar in functionality to a combo box. However, if the user expands the control, a month calendar control appears (by default), allowing the user to specify a particular date. When a date is chosen, the month calendar control automatically disappears.

Here is the list of methods in CDateTimeCtrl class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CloseMonthCal</td>
<td>Closes the current date and time picker control.</td>
</tr>
<tr>
<td>Create</td>
<td>Creates the date and time picker control and attaches it to the CDateTimeCtrl object.</td>
</tr>
<tr>
<td>GetDateTimePickerInfo</td>
<td>Retrieves information about the current date and time picker control.</td>
</tr>
<tr>
<td>GetIdealSize</td>
<td>Returns the ideal size of the date and time picker control that is required to display the current date or time.</td>
</tr>
<tr>
<td>GetMonthCalColor</td>
<td>Retrieves the color for a given portion of the month calendar within the date and time picker control.</td>
</tr>
<tr>
<td>GetMonthCalCtrl</td>
<td>Retrieves the CMonthCalCtrl object associated with the date and time picker control.</td>
</tr>
<tr>
<td>GetMonthCalFont</td>
<td>Retrieves the font currently used by the date and time picker control's child month calendar control.</td>
</tr>
<tr>
<td>GetMonthCalStyle</td>
<td>Gets the style of the current date and time picker control.</td>
</tr>
<tr>
<td>GetRange</td>
<td>Retrieves the current minimum and maximum allowed system times for a date and time picker control.</td>
</tr>
<tr>
<td>GetTime</td>
<td>Retrieves the currently selected time from a date and time picker control and puts it in a specified SYSTEMTIME structure.</td>
</tr>
<tr>
<td>SetFormat</td>
<td>Sets the display of a date and time picker control in accordance with a given format string.</td>
</tr>
<tr>
<td>SetMonthCalColor</td>
<td>Sets the color for a given portion of the month calendar within a date and time picker control.</td>
</tr>
<tr>
<td>SetMonthCalFont</td>
<td>Sets the font that the date and time picker control's child month calendar control will use.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SetMonthCalStyle</td>
<td>Sets the style of the current date and time picker control.</td>
</tr>
<tr>
<td>SetRange</td>
<td>Sets the minimum and maximum allowed system times for a date and time picker control.</td>
</tr>
<tr>
<td>SetTime</td>
<td>Sets the time in a date and time picker control.</td>
</tr>
</tbody>
</table>

Let us look into a simple example by creating a new MFC application.

**Step 1:** Remove the Caption and set its ID to IDC_STATIC_TXT.

**Step 2:** Add the value variable for text control.
Step 3: Drag the Date Time Picker control.
**Step 4:** Add a control variable for Date Time Picker.
**Step 5:** Add the Event handler for Date Time Picker.

![Event Handler Wizard - MFCDatetimePicker](image)

**Step 6:** Here is the implementation of event handler.

```c++
void CMFCDateAndTimePickerDlg::OnDtnDatetimechangeDatetimepicker1(NMHDR *pNMHDR, LRESULT *pResult)
{
    LPNMDATETIMECHANGE pDTChange = reinterpret_cast<LPNMDATETIMECHANGE>(pNMHDR);
    // TODO: Add your control notification handler code here

    GetDlgItemText(IDC_DATETIMEPICKER1, m_strValue);
    UpdateData(FALSE);
    *pResult = 0;
}
```
**Step 7:** When you run the above application, you see the following output. Select any date, it will display on the Static Text Control.

![Screenshot of MFCDateAndTimePicker dialog](image)

**Picture**

If you need to display a picture for your application, Visual C++ provides a special control for that purpose.

Let us look into a simple example by creating a new MFC dialog based application.
**Step 1:** Right-click on the dialog in the designer window and select Insert ActiveX Control.

![Insert ActiveX Control dialog]

**Step 2:** Select the Microsoft Picture Click Control and click OK.
Step 3: Resize the Picture control and in the Properties window, click the Picture field.

Step 4: Browse the folder that contains Pictures. Select any picture.

Step 5: Run this application and you will see the following output.
Image Editor

The Image editor has an extensive set of tools for creating and editing images, as well as features to help you create toolbar bitmaps. In addition to bitmaps, icons, and cursors, you can edit images in GIF or JPEG format using commands on the Image menu and tools on the Image Editor Toolbar.

Let us look into a simple example by creating a new project.

**Step 1:** Add a Bitmap from Add Resource dialog box.
Step 2: Select Bitmap and click New. It will open the Image editor.
Step 3: Design your bitmap image in Image editor and change its ID to IDB_BITMAP_START as shown above.

Step 4: Add a button to your dialog box and also add a control Variable m_buttonStart for that button.

Step 5: Add a bitmap variable to your header file. You will now see the following two variables.

```cpp
CBitmap m_bitmapStart;
CButton m_buttonStart;
```

Step 6: Modify your OnInitDialog() method as shown in the following code.

```cpp
m_bitmapStart.LoadBitmap(IDB_BITMAP_START);
HBITMAP hBitmap = (HBITMAP)m_bitmapStart.GetSafeHandle();
m_buttonStart.SetBitmap(hBitmap);
```

Step 7: When the above code is compiled and executed, you will see the following output.
Slider Controls

A Slider Control (also known as a trackbar) is a window containing a slider and optional tick marks. When the user moves the slider, using either the mouse or the direction keys, the control sends notification messages to indicate the change. There are two types of sliders — horizontal and vertical. It is represented by CSliderCtrl class.

Here is the list of methods in CSliderCtrl class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClearSel</td>
<td>Clears the current selection in a slider control.</td>
</tr>
<tr>
<td>ClearTics</td>
<td>Removes the current tick marks from a slider control.</td>
</tr>
<tr>
<td>Create</td>
<td>Creates a slider control and attaches it to a CSliderCtrl object.</td>
</tr>
<tr>
<td>CreateEx</td>
<td>Creates a slider control with the specified Windows extended styles and attaches it to a CSliderCtrl object.</td>
</tr>
<tr>
<td>GetBuddy</td>
<td>Retrieves the handle to a slider control buddy window at a given location.</td>
</tr>
<tr>
<td>GetChannelRect</td>
<td>Retrieves the size of the slider control's channel.</td>
</tr>
<tr>
<td>GetLineSize</td>
<td>Retrieves the line size of a slider control.</td>
</tr>
<tr>
<td>GetNumTics</td>
<td>Retrieves the number of tick marks in a slider control.</td>
</tr>
</tbody>
</table>
Microsoft Foundation Classes

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetPageSize</td>
<td>Retrieves the page size of a slider control.</td>
</tr>
<tr>
<td>GetPos</td>
<td>Retrieves the current position of the slider.</td>
</tr>
<tr>
<td>GetRange</td>
<td>Retrieves the minimum and maximum positions for a slider.</td>
</tr>
<tr>
<td>GetRangeMax</td>
<td>Retrieves the maximum position for a slider.</td>
</tr>
<tr>
<td>GetRangeMin</td>
<td>Retrieves the minimum position for a slider.</td>
</tr>
<tr>
<td>GetSelection</td>
<td>Retrieves the range of the current selection.</td>
</tr>
<tr>
<td>GetThumbLength</td>
<td>Retrieves the length of the slider in the current trackbar control.</td>
</tr>
<tr>
<td>GetThumbRect</td>
<td>Retrieves the size of the slider control’s thumb.</td>
</tr>
<tr>
<td>GetTic</td>
<td>Retrieves the position of the specified tick mark.</td>
</tr>
<tr>
<td>GetTicArray</td>
<td>Retrieves the array of tick mark positions for a slider.</td>
</tr>
<tr>
<td>GetTicPos</td>
<td>Retrieves the position of the specified tick mark, in client coordinates.</td>
</tr>
<tr>
<td>GetToolTips</td>
<td>Retrieves the handle to the tooltip control assigned to the slider control, if any.</td>
</tr>
<tr>
<td>SetBuddy</td>
<td>Assigns a window as the buddy window for a slider control.</td>
</tr>
<tr>
<td>SetLineSize</td>
<td>Sets the line size of a slider control.</td>
</tr>
<tr>
<td>SetPageSize</td>
<td>Sets the page size of a slider control.</td>
</tr>
<tr>
<td>SetPos</td>
<td>Sets the current position of the slider.</td>
</tr>
<tr>
<td>SetRange</td>
<td>Sets the minimum and maximum positions for a slider.</td>
</tr>
<tr>
<td>SetRangeMax</td>
<td>Sets the maximum position for a slider.</td>
</tr>
<tr>
<td>SetRangeMin</td>
<td>Sets the minimum position for a slider.</td>
</tr>
<tr>
<td>SetSelection</td>
<td>Sets the range of the current selection.</td>
</tr>
<tr>
<td>SetThumbLength</td>
<td>Sets the length of the slider in the current trackbar control.</td>
</tr>
<tr>
<td>SetTic</td>
<td>Sets the position of the specified tick mark.</td>
</tr>
<tr>
<td>SetTicFreq</td>
<td>Sets the frequency of tick marks per slider control increment.</td>
</tr>
<tr>
<td>SetTipSide</td>
<td>Positions a tooltip control used by a trackbar control.</td>
</tr>
<tr>
<td>SetToolTips</td>
<td>Assigns a tooltip control to a slider control.</td>
</tr>
</tbody>
</table>

Let us look into a simple example by creating a new MFC dialog based project.

**Step 1:** Once the project is created you will see the TODO line which is the Caption of Text Control. Remove the Caption and set its ID to IDC_STATIC_TXT.

**Step 2:** Add a value variable m_strSliderVal for the Static Text control.
Welcome to the Add Member Variable Wizard

Access: public

Control variable

Variable type: CString

Variable name: m_strSliderVal

Category: Value

Control ID: IDC_STATIC_TEXT

Control type: CTEXT

Min value:

Max value:

In file:

 CPP file:

Comment (// notation not required):

Finish Cancel
Step 3: Drag the slider control from the Toolbox.
Step 4: Add a control variable `m_sliderCtrl` for slider.
**Step 5:** Go to the class view in solution.

**Step 6:** Select the CMFSliderControlDlg class.

**Step 7:** In the Properties window, click Messages.

**Step 8:** Scroll down to "WM_HSCROLL" and click on the drop-down menu. Click "<Add> OnHScroll".

**Step 9:** Initialize the Slider and Static Text control inside the OnInitDialog() function.

```cpp
BOOL CMFSliderControlDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);   // Set big icon
    SetIcon(m_hIcon, FALSE);  // Set small icon

    // TODO: Add extra initialization here
    m_sliderCtrl.SetRange(0, 100, TRUE);
}
```
m_sliderCtrl.SetPos(0);

m_strSliderVal.Format(_T("%d"), 0);

return TRUE; // return TRUE unless you set the focus to a control

Step 10: Add the following code inside the function code block for OnVScroll()
Scrollbars

A scrollbar is a graphical control element with which continuous text, pictures or anything else can be scrolled in two directions along a control by clicking an arrow. This control can assume one of two directions — horizontal or vertical. It is represented by CScrollBar class.

Here is the list of methods in CScrollBar class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Creates the Windows scroll bar and attaches it to the CScrollBar object.</td>
</tr>
<tr>
<td>EnableScrollBar</td>
<td>Enables or disables one or both arrows of a scroll bar.</td>
</tr>
<tr>
<td>GetScrollBarInfo</td>
<td>Retrieves information about the scroll bar using a SCROLLBARINFO structure.</td>
</tr>
<tr>
<td>GetScrollInfo</td>
<td>Retrieves information about the scroll bar.</td>
</tr>
<tr>
<td>GetScrollLimit</td>
<td>Retrieves the limit of the scroll bar.</td>
</tr>
<tr>
<td>GetScrollPos</td>
<td>Retrieves the current position of a scroll box.</td>
</tr>
<tr>
<td>GetScrollRange</td>
<td>Retrieves the current minimum and maximum scroll-bar positions for the given scroll bar.</td>
</tr>
<tr>
<td>SetScrollInfo</td>
<td>Sets information about the scroll bar.</td>
</tr>
<tr>
<td>SetScrollPos</td>
<td>Sets the current position of a scroll box.</td>
</tr>
<tr>
<td>SetScrollRange</td>
<td>Sets minimum and maximum position values for the given scroll bar.</td>
</tr>
<tr>
<td>ShowScrollBar</td>
<td>Shows or hides a scroll bar.</td>
</tr>
</tbody>
</table>
Let us look into a simple example of Scrollbar.

**Step 1:** To add either horizontal or vertical scrollbar, you need to set the following highlighted properties of the dialog box to True.
Step 2: When you run the above application, you will see that both horizontal and vertical scrollbars have been added.

**Tree Control**

A Tree View Control is a window that displays a hierarchical list of items, such as the headings in a document, the entries in an index, or the files and directories on a disk. Each item consists of a label and an optional bitmapped image, and each item can have a list of subitems associated with it. By clicking an item, the user can expand and collapse the associated list of subitems. It is represented by CTreeCtrl class.

Here is the list of methods in CTreeCtrl class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Creates a tree view control and attaches it to a CTreeCtrl object.</td>
</tr>
<tr>
<td>CreateDragImage</td>
<td>Creates a dragging bitmap for the specified tree view item.</td>
</tr>
<tr>
<td>CreateEx</td>
<td>Creates a tree control with the specified Windows extended styles and attaches it to a CTreeCtrl object.</td>
</tr>
<tr>
<td>DeleteAllItems</td>
<td>Deletes all items in a tree view control.</td>
</tr>
<tr>
<td>DeleteItem</td>
<td>Deletes a new item in a tree view control.</td>
</tr>
<tr>
<td>EditLabel</td>
<td>Edits a specified tree view item in-place.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EndEditLabelNow</td>
<td>Cancels the edit operation on the label of a tree-view item in the current tree-view control.</td>
</tr>
<tr>
<td>EnsureVisible</td>
<td>Ensures that a tree view item is visible in its tree view control.</td>
</tr>
<tr>
<td>Expand</td>
<td>Expands, or collapses, the child items of the specified tree view item.</td>
</tr>
<tr>
<td>GetBkColor</td>
<td>Retrieves the current background color of the control.</td>
</tr>
<tr>
<td>GetCheck</td>
<td>Retrieves the check state of a tree control item.</td>
</tr>
<tr>
<td>GetChildItem</td>
<td>Retrieves the child of a specified tree view item.</td>
</tr>
<tr>
<td>GetCount</td>
<td>Retrieves the number of tree items associated with a tree view control.</td>
</tr>
<tr>
<td>GetDropHighlight</td>
<td>Retrieves the target of a drag-and-drop operation.</td>
</tr>
<tr>
<td>GetEditControl</td>
<td>Retrieves the handle of the edit control used to edit the specified tree view item.</td>
</tr>
<tr>
<td>GetExtendedStyle</td>
<td>Retrieves the extended styles that the current tree-view control is using.</td>
</tr>
<tr>
<td>GetFirstVisibleItem</td>
<td>Retrieves the first visible item of the specified tree view item.</td>
</tr>
<tr>
<td>GetImageList</td>
<td>Retrieves the handle of the image list associated with a tree view control.</td>
</tr>
<tr>
<td>GetIndent</td>
<td>Retrieves the offset (in pixels) of a tree view item from its parent.</td>
</tr>
<tr>
<td>GetInsertMarkColor</td>
<td>Retrieves the color used to draw the insertion mark for the tree view.</td>
</tr>
<tr>
<td>GetItem</td>
<td>Retrieves the attributes of a specified tree view item.</td>
</tr>
<tr>
<td>GetItemData</td>
<td>Returns the 32-bit application-specific value associated with an item.</td>
</tr>
<tr>
<td>GetItemImageEx</td>
<td>Retrieves the index of the image to display when the specified item of the current tree-view control is in the expanded state.</td>
</tr>
<tr>
<td>GetItemImageHeight</td>
<td>Retrieves the current height of the tree view items.</td>
</tr>
<tr>
<td>GetItemImage</td>
<td>Retrieves the images associated with an item.</td>
</tr>
<tr>
<td>GetImagePartRect</td>
<td>Retrieves the bounding rectangle for a specified part of a specified item in the current tree-view control.</td>
</tr>
<tr>
<td>GetItemRect</td>
<td>Retrieves the bounding rectangle of a tree view item.</td>
</tr>
<tr>
<td>GetItemStateEx</td>
<td>Retrieves the extended state of the specified item in the current tree-view control.</td>
</tr>
<tr>
<td>GetItemText</td>
<td>Returns the text of an item.</td>
</tr>
<tr>
<td>GetLastVisibleItem</td>
<td>Retrieves the last expanded item in the current tree-view control.</td>
</tr>
<tr>
<td>GetLineColor</td>
<td>Retrieves the current line color for the tree view control.</td>
</tr>
<tr>
<td>GetNextItem</td>
<td>Retrieves the next tree view item that matches a specified relationship.</td>
</tr>
<tr>
<td>GetNextSiblingItem</td>
<td>Retrieves the next sibling of the specified tree view item.</td>
</tr>
<tr>
<td>GetNextVisibleItem</td>
<td>Retrieves the next visible item of the specified tree view item.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GetParentItem</td>
<td>Retrieves the parent of the specified tree view item.</td>
</tr>
<tr>
<td>GetPrevSiblingItem</td>
<td>Retrieves the previous sibling of the specified tree view item.</td>
</tr>
<tr>
<td>GetPrevVisibleItem</td>
<td>Retrieves the previous visible item of the specified tree view item.</td>
</tr>
<tr>
<td>GetRootItem</td>
<td>Retrieves the root of the specified tree view item.</td>
</tr>
<tr>
<td>GetScrollTime</td>
<td>Retrieves the maximum scroll time for the tree view control.</td>
</tr>
<tr>
<td>GetSelectedCount</td>
<td>Retrieves the number of selected items in the current tree-view control.</td>
</tr>
<tr>
<td>GetSelectedItem</td>
<td>Retrieves the currently selected tree view item.</td>
</tr>
<tr>
<td>GetTextColor</td>
<td>Retrieves the current text color of the control.</td>
</tr>
<tr>
<td>GetToolTips</td>
<td>Retrieves the handle to the child ToolTip control used by a tree view control.</td>
</tr>
<tr>
<td>GetVisibleCount</td>
<td>Retrieves the number of visible tree items associated with a tree view control.</td>
</tr>
<tr>
<td>HitTest</td>
<td>Returns the current position of the cursor related to the CTreeCtrl object.</td>
</tr>
<tr>
<td>InsertItem</td>
<td>Inserts a new item in a tree view control.</td>
</tr>
<tr>
<td>ItemHasChildren</td>
<td>Returns nonzero if the specified item has child items.</td>
</tr>
<tr>
<td>MapAccIdToItem</td>
<td>Maps the specified accessibility identifier to the handle to a tree-view item in the current tree-view control.</td>
</tr>
<tr>
<td>MapItemToAccID</td>
<td>Maps the specified handle to a tree-view item in the current tree-view control to an accessibility identifier.</td>
</tr>
<tr>
<td>Select</td>
<td>Selects, scrolls into view, or redraws a specified tree view item.</td>
</tr>
<tr>
<td>SelectDropTarget</td>
<td>Redraws the tree item as the target of a drag-and-drop operation.</td>
</tr>
<tr>
<td>SelectItem</td>
<td>Selects a specified tree view item.</td>
</tr>
<tr>
<td>SelectSetFirstVisible</td>
<td>Selects a specified tree view item as the first visible item.</td>
</tr>
<tr>
<td>SetAutoscrollInfo</td>
<td>Sets the autoscroll rate of the current tree-view control.</td>
</tr>
<tr>
<td>SetBkColor</td>
<td>Sets the background color of the control.</td>
</tr>
<tr>
<td>SetCheck</td>
<td>Sets the check state of a tree control item.</td>
</tr>
<tr>
<td>SetExtendedStyle</td>
<td>Sets the extended styles for the current tree-view control.</td>
</tr>
<tr>
<td>SetImageList</td>
<td>Sets the handle of the image list associated with a tree view control.</td>
</tr>
<tr>
<td>SetIndent</td>
<td>Sets the offset (in pixels) of a tree view item from its parent.</td>
</tr>
<tr>
<td>SetInsertMark</td>
<td>Sets the insertion mark in a tree view control.</td>
</tr>
<tr>
<td>SetInsertMarkColor</td>
<td>Sets the color used to draw the insertion mark for the tree view.</td>
</tr>
<tr>
<td>SetItem</td>
<td>Sets the attributes of a specified tree view item.</td>
</tr>
<tr>
<td>SetItemData</td>
<td>Sets the 32-bit application-specific value associated with an item.</td>
</tr>
<tr>
<td>SetItemExpandedImageIndex</td>
<td>Sets the index of the image to display when the specified item of the current tree-view control is in the expanded state.</td>
</tr>
<tr>
<td>Method</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SetItemHeight</td>
<td>Sets the height of the tree view items.</td>
</tr>
<tr>
<td>SetItemImage</td>
<td>Associates images with an item.</td>
</tr>
<tr>
<td>SetItemState</td>
<td>Sets the state of an item.</td>
</tr>
<tr>
<td>SetItemStateEx</td>
<td>Sets the extended state of the specified item in the current tree-view control.</td>
</tr>
<tr>
<td>SetItemText</td>
<td>Sets the text of an item.</td>
</tr>
<tr>
<td>SetLineColor</td>
<td>Sets the current line color for the tree view control.</td>
</tr>
<tr>
<td>SetScrollTime</td>
<td>Sets the maximum scroll time for the tree view control.</td>
</tr>
<tr>
<td>SetTextColor</td>
<td>Sets the text color of the control.</td>
</tr>
<tr>
<td>SetToolTips</td>
<td>Sets a tree view control's child ToolTip control.</td>
</tr>
<tr>
<td>ShowInfoTip</td>
<td>Displays the infotip for the specified item in the current tree-view control.</td>
</tr>
<tr>
<td>SortChildren</td>
<td>Sorts the children of a given parent item.</td>
</tr>
<tr>
<td>SortChildrenCB</td>
<td>Sorts the children of a given parent item using an application-defined sort function.</td>
</tr>
</tbody>
</table>

Let us look into a simple example by creating a new MFC dialog based project.

**Step 1:** Once the project is created you will see the TODO line, which is the Caption of Text Control. Remove the Caption and set its ID to IDC_STATIC_TXT.

**Step 2:** Add a value variable m_strTree for the Static Text control.
Step 3: From the Controls toolbox, drag the Tree Control.

Step 4: On the dialog box, click the Tree Control to select it. On the Properties window, set the Has Buttons, the Has Lines, the Lines At Root, the Client Edge and the Modal Frame properties to True.
**Step 5:** Add a control variable `m_treeCtrl` for Tree Control.

**Step 6:** Here is initialization of tree control in `OnInitDialog()`

```cpp
BOOL CMFCTreeControlDlg::OnInitDialog()
{
    CDlgEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);    // Set big icon
    SetIcon(m_hIcon, FALSE);   // Set small icon

    // TODO: Add extra initialization here
    HTREEITEM hItem, hCar;
    hItem = m_treeCtrl.InsertItem(L"Car Listing", TVI_ROOT);
    hCar = m_treeCtrl.InsertItem(L"Economy", hItem);
    m_treeCtrl.InsertItem(L"BH-733", hCar);
}```
m_treeCtrl.InsertItem(L"SD-397", hCar);
m_treeCtrl.InsertItem(L"JU-538", hCar);
m_treeCtrl.InsertItem(L"DI-285", hCar);
m_treeCtrl.InsertItem(L"AK-830", hCar);
hCar = m_treeCtrl.InsertItem(L"Compact", hItem);
m_treeCtrl.InsertItem(L"HG-490", hCar);
m_treeCtrl.InsertItem(L"PE-473", hCar);
hCar = m_treeCtrl.InsertItem(L"Standard", hItem);
m_treeCtrl.InsertItem(L"SO-398", hCar);
m_treeCtrl.InsertItem(L"DF-438", hCar);
m_treeCtrl.InsertItem(L"IS-833", hCar);
hCar = m_treeCtrl.InsertItem(L"Full Size", hItem);
m_treeCtrl.InsertItem(L"PD-304", hCar);
hCar = m_treeCtrl.InsertItem(L"Mini Van", hItem);
m_treeCtrl.InsertItem(L"ID-497", hCar);
m_treeCtrl.InsertItem(L"RU-304", hCar);
m_treeCtrl.InsertItem(L"DK-905", hCar);
hCar = m_treeCtrl.InsertItem(L"SUV", hItem);
m_treeCtrl.InsertItem(L"FE-948", hCar);
m_treeCtrl.InsertItem(L"AD-940", hCar);
hCar = m_treeCtrl.InsertItem(L"Truck", hItem);
m_treeCtrl.InsertItem(L"HD-394", hCar);

return TRUE; // return TRUE unless you set the focus to a control
}
Step 7: When the above code is compiled and executed, you will see the following output.

![List Control](https://via.placeholder.com/150)

**List Control**

Encapsulates the functionality of a List View Control, which displays a collection of items each consisting of an icon (from an image list) and a label. It is represented by `CListCtrl` class. A list control consists of using one of four views to display a list of items.

- Icons
- Small Icons
- List
- Report

Here is the list of methods in `CListCtrl` class.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ApproximateViewRect</td>
<td>Determines the width and height required to display the items of a list view control.</td>
</tr>
<tr>
<td>Arrange</td>
<td>Aligns items on a grid.</td>
</tr>
<tr>
<td>CancelEditLabel</td>
<td>Cancels item text editing operation.</td>
</tr>
<tr>
<td>Create</td>
<td>Creates a list control and attaches it to a CListCtrl object.</td>
</tr>
<tr>
<td>CreateDragImage</td>
<td>Creates a drag image list for a specified item.</td>
</tr>
<tr>
<td>CreateEx</td>
<td>Creates a list control with the specified Windows extended styles and attaches it to a CListCtrl object.</td>
</tr>
<tr>
<td>Method</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DeleteAllItems</td>
<td>Deletes all items from the control.</td>
</tr>
<tr>
<td>DeleteColumn</td>
<td>Deletes a column from the list view control.</td>
</tr>
<tr>
<td>DeleteItem</td>
<td>Deletes an item from the control.</td>
</tr>
<tr>
<td>DrawItem</td>
<td>Called when a visual aspect of an owner-draw control changes.</td>
</tr>
<tr>
<td>EditLabel</td>
<td>Begins in-place editing of an item's text.</td>
</tr>
<tr>
<td>EnableGroupView</td>
<td>Enables or disables whether the items in a list view control display as a group.</td>
</tr>
<tr>
<td>EnsureVisible</td>
<td>Ensures that an item is visible.</td>
</tr>
<tr>
<td>FindItem</td>
<td>Searches for a list view item having specified characteristics.</td>
</tr>
<tr>
<td>GetBkColor</td>
<td>Retrieves the background color of a list view control.</td>
</tr>
<tr>
<td>GetBkImage</td>
<td>Retrieves the current background image of a list view control.</td>
</tr>
<tr>
<td>GetCallbackMask</td>
<td>Retrieves the callback mask for a list view control.</td>
</tr>
<tr>
<td>GetCheck</td>
<td>Retrieves the current display status of the state image associated with an item.</td>
</tr>
<tr>
<td>GetColumn</td>
<td>Retrieves the attributes of a control's column.</td>
</tr>
<tr>
<td>GetColumnOrderArray</td>
<td>Retrieves the column order (left to right) of a list view control.</td>
</tr>
<tr>
<td>GetColumnWidth</td>
<td>Retrieves the width of a column in report view or list view.</td>
</tr>
<tr>
<td>GetCountPerPage</td>
<td>Calculates the number of items that can fit vertically in a list view control.</td>
</tr>
<tr>
<td>GetEditControl</td>
<td>Retrieves the handle of the edit control used to edit an item's text.</td>
</tr>
<tr>
<td>GetEmptyText</td>
<td>Retrieves the string to display if the current list-view control is empty.</td>
</tr>
<tr>
<td>GetExtendedStyle</td>
<td>Retrieves the current extended styles of a list view control.</td>
</tr>
<tr>
<td>GetFirstSelectedItemPosition</td>
<td>Retrieves the position of the first selected list view item in a list view control.</td>
</tr>
<tr>
<td>GetFocusedGroup</td>
<td>Retrieves the group that has the keyboard focus in the current list-view control.</td>
</tr>
<tr>
<td>GetGroupCount</td>
<td>Retrieves the number of groups in the current list-view control.</td>
</tr>
<tr>
<td>GetGroupInfo</td>
<td>Gets the information for a specified group of the list view control.</td>
</tr>
<tr>
<td>GetGroupInfoByIndex</td>
<td>Retrieves information about a specified group in the current list-view control.</td>
</tr>
<tr>
<td>GetGroupMetrics</td>
<td>Retrieves the metrics of a group.</td>
</tr>
<tr>
<td>GetGroupRect</td>
<td>Retrieves the bounding rectangle for a specified group in the current list-view control.</td>
</tr>
<tr>
<td>GetGroupState</td>
<td>Retrieves the state for a specified group in the current list-view control.</td>
</tr>
<tr>
<td>GetHeaderCtrl</td>
<td>Retrieves the header control of a list view control.</td>
</tr>
<tr>
<td>GetHotCursor</td>
<td>Retrieves the cursor used when hot tracking is enabled for a list view control.</td>
</tr>
<tr>
<td>GetHotItem</td>
<td>Retrieves the list view item currently under the cursor.</td>
</tr>
<tr>
<td>GetHoverTime</td>
<td>Retrieves the current hover time of a list view control.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GetImageList</td>
<td>Retrieves the handle of an image list used for drawing list view items.</td>
</tr>
<tr>
<td>GetInsertMark</td>
<td>Retrieves the current position of the insertion mark.</td>
</tr>
<tr>
<td>GetInsertMarkColor</td>
<td>Retrieves the current color of the insertion mark.</td>
</tr>
<tr>
<td>GetInsertMarkRect</td>
<td>Retrieves the rectangle that bounds the insertion point.</td>
</tr>
<tr>
<td>GetItem</td>
<td>Retrieves a list view item's attributes.</td>
</tr>
<tr>
<td>GetItemCount</td>
<td>Retrieves the number of items in a list view control.</td>
</tr>
<tr>
<td>GetItemData</td>
<td>Retrieves the application-specific value associated with an item.</td>
</tr>
<tr>
<td>GetItemImageRect</td>
<td>Retrieves the bounding rectangle for all or part of a subitem in the current list-view control.</td>
</tr>
<tr>
<td>GetItemPosition</td>
<td>Retrieves the position of a list view item.</td>
</tr>
<tr>
<td>GetItemRect</td>
<td>Retrieves the bounding rectangle for an item.</td>
</tr>
<tr>
<td>GetItemSpacing</td>
<td>Calculates the spacing between items in the current list-view control.</td>
</tr>
<tr>
<td>GetItemState</td>
<td>Retrieves the state of a list view item.</td>
</tr>
<tr>
<td>GetItemText</td>
<td>Retrieves the text of a list view item or subitem.</td>
</tr>
<tr>
<td>GetNextItem</td>
<td>Searches for a list view item with specified properties and with specified relationship to a given item.</td>
</tr>
<tr>
<td>GetNextItemIndex</td>
<td>Retrieves the index of the item in the current list-view control that has a specified set of properties.</td>
</tr>
<tr>
<td>GetNextSelectedItem</td>
<td>Retrieves the index of a list view item position, and the position of the next selected list view item for iterating.</td>
</tr>
<tr>
<td>GetNumberOfWorkAreas</td>
<td>Retrieves the current number of working areas for a list view control.</td>
</tr>
<tr>
<td>GetOrigin</td>
<td>Retrieves the current view origin for a list view control.</td>
</tr>
<tr>
<td>GetOutlineColor</td>
<td>Retrieves the color of the border of a list view control.</td>
</tr>
<tr>
<td>GetSelectedColumn</td>
<td>Retrieves the index of the currently selected column in the list control.</td>
</tr>
<tr>
<td>GetSelectedCount</td>
<td>Retrieves the number of selected items in the list view control.</td>
</tr>
<tr>
<td>GetSelectionMark</td>
<td>Retrieves the selection mark of a list view control.</td>
</tr>
<tr>
<td>GetStringWidth</td>
<td>Determines the minimum column width necessary to display all of a given string.</td>
</tr>
<tr>
<td>GetSubItemRect</td>
<td>Retrieves the bounding rectangle of an item in a list view control.</td>
</tr>
<tr>
<td>GetTextBkColor</td>
<td>Retrieves the text background color of a list view control.</td>
</tr>
<tr>
<td>GetTextColor</td>
<td>Retrieves the text color of a list view control.</td>
</tr>
<tr>
<td>GetTileInfo</td>
<td>Retrieves information about a tile in a list view control.</td>
</tr>
<tr>
<td>GetTileViewInfo</td>
<td>Retrieves information about a list view control in tile view.</td>
</tr>
<tr>
<td>GetToolTip</td>
<td>Retrieves the tooltip control that the list view control uses to display tooltips.</td>
</tr>
<tr>
<td>GetTopIndex</td>
<td>Retrieves the index of the topmost visible item.</td>
</tr>
<tr>
<td>GetView</td>
<td>Gets the view of the list view control.</td>
</tr>
<tr>
<td>GetViewRect</td>
<td>Retrieves the bounding rectangle of all items in the list view control.</td>
</tr>
<tr>
<td>Method</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GetWorkAreas</td>
<td>Retrieves the current working areas of a list view control.</td>
</tr>
<tr>
<td>HasGroup</td>
<td>Determines if the list view control has the specified group.</td>
</tr>
<tr>
<td>HitTest</td>
<td>Determines which list view item is at a specified position.</td>
</tr>
<tr>
<td>InsertColumn</td>
<td>Inserts a new column in a list view control.</td>
</tr>
<tr>
<td>InsertGroup</td>
<td>Inserts a group into the list view control.</td>
</tr>
<tr>
<td>InsertGroupSorted</td>
<td>Inserts the specified group into an ordered list of groups.</td>
</tr>
<tr>
<td>InsertItem</td>
<td>Inserts a new item in a list view control.</td>
</tr>
<tr>
<td>InsertMarkHitTest</td>
<td>Retrieves the insertion point closest to a specified point.</td>
</tr>
<tr>
<td>IsGroupViewEnabled</td>
<td>Determines whether group view is enabled for a list view control.</td>
</tr>
<tr>
<td>IsItemVisible</td>
<td>Indicates whether a specified item in the current list-view control is visible.</td>
</tr>
<tr>
<td>MapIDToIndex</td>
<td>Maps the unique ID of an item in the current list-view control to an index.</td>
</tr>
<tr>
<td>MapIndexToID</td>
<td>Maps the index of an item in the current list-view control to a unique ID.</td>
</tr>
<tr>
<td>MoveGroup</td>
<td>Moves the specified group.</td>
</tr>
<tr>
<td>MoveItemToGroup</td>
<td>Moves the specified group to the specified zero based index of the list view control.</td>
</tr>
<tr>
<td>RedrawItems</td>
<td>Forces a list view control to repaint a range of items.</td>
</tr>
<tr>
<td>RemoveAllGroups</td>
<td>Removes all groups from a list view control.</td>
</tr>
<tr>
<td>RemoveGroup</td>
<td>Removes the specified group from the list view control.</td>
</tr>
<tr>
<td>Scroll</td>
<td>Scrolls the content of a list view control.</td>
</tr>
<tr>
<td>SetBkColor</td>
<td>Sets the background color of the list view control.</td>
</tr>
<tr>
<td>SetBkImage</td>
<td>Sets the current background image of a list view control.</td>
</tr>
<tr>
<td>SetCallbackMask</td>
<td>Sets the callback mask for a list view control.</td>
</tr>
<tr>
<td>SetCheck</td>
<td>Sets the current display status of the state image associated with an item.</td>
</tr>
<tr>
<td>SetColumn</td>
<td>Sets the attributes of a list view column.</td>
</tr>
<tr>
<td>SetColumnOrderArray</td>
<td>Sets the column order (left to right) of a list view control.</td>
</tr>
<tr>
<td>SetColumnWidth</td>
<td>Changes the width of a column in report view or list view.</td>
</tr>
<tr>
<td>SetExtendedStyle</td>
<td>Sets the current extended styles of a list view control.</td>
</tr>
<tr>
<td>SetGroupInfo</td>
<td>Sets the information for the specified group of a list view control.</td>
</tr>
<tr>
<td>SetGroupMetrics</td>
<td>Sets the group metrics of a list view control.</td>
</tr>
<tr>
<td>SetHotCursor</td>
<td>Sets the cursor used when hot tracking is enabled for a list view control.</td>
</tr>
<tr>
<td>SetHotItem</td>
<td>Sets the current hot item of a list view control.</td>
</tr>
<tr>
<td>SetHoverTime</td>
<td>Sets the current hover time of a list view control.</td>
</tr>
<tr>
<td>SetIconSpacing</td>
<td>Sets the spacing between icons in a list view control.</td>
</tr>
<tr>
<td>SetImageList</td>
<td>Assigns an image list to a list view control.</td>
</tr>
<tr>
<td>SetInfoTip</td>
<td>Sets the tooltip text.</td>
</tr>
<tr>
<td>SetInsertMark</td>
<td>Sets the insertion point to the defined position.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SetInsertMarkColor</td>
<td>Sets the color of the insertion point.</td>
</tr>
<tr>
<td>SetItem</td>
<td>Sets some or all of a list view item's attributes.</td>
</tr>
<tr>
<td>SetItemCount</td>
<td>Prepares a list view control for adding a large number of items.</td>
</tr>
<tr>
<td>SetItemCountEx</td>
<td>Sets the item count for a virtual list view control.</td>
</tr>
<tr>
<td>SetItemData</td>
<td>Sets the item's application-specific value.</td>
</tr>
<tr>
<td>SetItemIndexState</td>
<td>Sets the state of an item in the current list-view control.</td>
</tr>
<tr>
<td>SetItemPosition</td>
<td>Moves an item to a specified position in a list view control.</td>
</tr>
<tr>
<td>SetItemState</td>
<td>Changes the state of an item in a list view control.</td>
</tr>
<tr>
<td>SetItemText</td>
<td>Changes the text of a list view item or subitem.</td>
</tr>
<tr>
<td>SetOutlineColor</td>
<td>Sets the color of the border of a list view control.</td>
</tr>
<tr>
<td>SetSelectedColumn</td>
<td>Sets the selected column of the list view control.</td>
</tr>
<tr>
<td>SetSelectionMark</td>
<td>Sets the selection mark of a list view control.</td>
</tr>
<tr>
<td>SetTextColor</td>
<td>Sets the background color of text in a list view control.</td>
</tr>
<tr>
<td>SetTextBkColor</td>
<td>Sets the text color of a list view control.</td>
</tr>
<tr>
<td>SetTileInfo</td>
<td>Sets the information for a tile of the list view control.</td>
</tr>
<tr>
<td>SetTileViewInfo</td>
<td>Sets information that a list view control uses in tile view.</td>
</tr>
<tr>
<td>SetToolTip</td>
<td>Sets the tooltip control that the list view control will use to display tooltips.</td>
</tr>
<tr>
<td>SetView</td>
<td>Sets the view of the list view control.</td>
</tr>
<tr>
<td>SetWorkAreas</td>
<td>Sets the area where icons can be displayed in a list view control.</td>
</tr>
<tr>
<td>SortGroups</td>
<td>Sorts the groups of a list view control with a user-defined function.</td>
</tr>
<tr>
<td>SortItems</td>
<td>Sorts list view items using an application-defined comparison function.</td>
</tr>
<tr>
<td>SortItemsEx</td>
<td>Sorts list view items using an application-defined comparison function.</td>
</tr>
<tr>
<td>SubItemHitTest</td>
<td>Determines which list view item, if any, is at a given position.</td>
</tr>
<tr>
<td>Update</td>
<td>Forces the control to repaint a specified item.</td>
</tr>
</tbody>
</table>

Let us look into a simple example by creating a new MFC dialog based application.

**Step 1:** Delete the TODO line and drag one List Control.

**Step 2:** In the Properties Window, you will see the different options in View dropdown list.
**Step 3:** Select the Report from the View field.

**Step 4:** Add control variable `m_listCtrl` for List Control.
Step 5: Initialize the List Control in OnInitDialog()

BOOL CMFCLListControlDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);    // Set big icon
    SetIcon(m_hIcon, FALSE);    // Set small icon

    // TODO: Add extra initialization here
    // Ask Mfc to create/insert a column
    m_listCtrl.InsertColumn(0, L"ID", LVCFMT_LEFT, 100);  // Rank/order of item
                                                      // Caption for this header
                                                      // Relative position of items under header
                                                      // Width of items under header
}
m_listCtrl.InsertColumn(1, L"Name", LVCFMT_CENTER, 80);
m_listCtrl.InsertColumn(2, L"Age", LVCFMT_LEFT, 100);
m_listCtrl.InsertColumn(3, L"Address", LVCFMT_LEFT, 80);

int nItem;

nItem = m_listCtrl.InsertItem(0, L"1");
m_listCtrl.SetItemText(nItem, 1, L"Mark");
m_listCtrl.SetItemText(nItem, 2, L"45");
m_listCtrl.SetItemText(nItem, 3, L"Address 1");

nItem = m_listCtrl.InsertItem(0, L"2");
m_listCtrl.SetItemText(nItem, 1, L"Allan");
m_listCtrl.SetItemText(nItem, 2, L"29");
m_listCtrl.SetItemText(nItem, 3, L"Address 2");

nItem = m_listCtrl.InsertItem(0, L"3");
m_listCtrl.SetItemText(nItem, 1, L"Ajay");
m_listCtrl.SetItemText(nItem, 2, L"37");
m_listCtrl.SetItemText(nItem, 3, L"Address 3");

return TRUE;  // return TRUE unless you set the focus to a control
**Step 6:** When the above code is compiled and executed, you will see the following output.

![User Interface](image-url)
An application is made of various objects. Most of the time, more than one application is running on the computer and the operating system is constantly asked to perform some assignments. Because there can be so many requests presented unpredictably, the operating system leaves it up to the objects to specify what they want, when they want it, and what behavior or result they expect.

Overview

- The Microsoft Windows operating system cannot predict what kinds of requests one object would need to be taken care of and what type of assignment another object would need.

- To manage all these assignments and requests, the objects send messages.

- Each object has the responsibility to decided what message to send and when.

- In order to send a message, a control must create an event.

- To make a distinction between the two, a message's name usually starts with WM_ which stands for Window Message.

- The name of an event usually starts with On which indicates an action.

- The event is the action of sending the message.

Map of Messages

Since Windows is a message-oriented operating system, a large portion of programming for the Windows environment involves message handling. Each time an event such as a keystroke or mouse click occurs, a message is sent to the application, which must then handle the event.

- For the compiler to manage messages, they should be included in the class definition.

- The DECLARE_MESSAGE_MAP macro should be provided at the end of the class definition as shown in the following code.

```cpp
class CMainFrame : public CFrameWnd
{
public:
    CMainFrame();
protected:
    DECLARE_MESSAGE_MAP();
}```
The actual messages should be listed just above the DECLARE_MESSAGE_MAP line.

To implement the messages, you need to create a table of messages that your program is using.

This table uses two delimiting macros;

Its starts with a BEGIN_MESSAGE_MAP and ends with an END_MESSAGE_MAP macros.

The BEGIN_MESSAGE_MAP macro takes two arguments, the name of your class and the MFC class you derived your class from as shown in the following code.

```cpp
#include <afxwin.h>

class CMainFrame : public CFrameWnd
{
public:
    CMainFrame();
protected:
    DECLARE_MESSAGE_MAP()
};
CMainFrame::CMainFrame()
{
    // Create the window's frame
    Create(NULL, L"MFC Messages Demo", WS_OVERLAPPEDWINDOW,
           CRect(120, 100, 700, 480), NULL);
}

class CMessagesApp : public CWinApp
{
public:
    BOOL InitInstance();
};
BEGIN_MESSAGE_MAP(CMainFrame, CFrameWnd)
END_MESSAGE_MAP()
BOOL CMessagesApp::InitInstance()
{
    m_pMainWnd = new CMainFrame;
    m_pMainWnd->ShowWindow(SW_SHOW);
    m_pMainWnd->UpdateWindow();
    return TRUE;
}
CMessagesApp theApp;
```
Let us look into a simple example by creating a new Win32 project.

**Step 1:** To create an MFC project, right-click on the project and select Properties.

**Step 2:** In the left section, click Configuration Properties -> General.

**Step 3:** Select the ‘Use MFC in Shared DLL’ option in Project Defaults section and click OK.

**Step 4:** We need to add a new source file.

**Step 5:** Right-click on your Project and select Add -> New Item.

**Step 6:** In the Templates section, click C++ File (.cpp).
Step 7: Click Add to Continue.

Step 8: Now, add the following code in the *.cpp file.

```cpp
#include <afxwin.h>

class CMainFrame : public CFrameWnd
{
    public:
        CMainFrame();
        DECLARE_MESSAGE_MAP()
    protected:
    // Create the window's frame
    Create(NULL, L"MFC Messages Demo", WS_OVERLAPPEDWINDOW,
                CRect(120, 100, 700, 480), NULL);
}

class CMessagesApp : public CWinApp
{
    public:
```
BOOL InitInstance();
};
BEGIN_MESSAGE_MAP(CMainFrame, CFrameWnd)
END_MESSAGE_MAP()
BOOL CMessagesApp::InitInstance()
{
    m_pMainWnd = new CMainFrame;
    m_pMainWnd->ShowWindow(SW_SHOW);
    m_pMainWnd->UpdateWindow();
    return TRUE;
}
CMessagesApp theApp;

## Windows Messages

There are different types of Windows messages like creating a window, showing a window etc. Here are some of the commonly used windows messages.

<table>
<thead>
<tr>
<th>Message</th>
<th>Map entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WM_ACTIVATE</td>
<td>ON_WM_ACTIVATE()</td>
<td>The framework calls this member function when a CWnd object is being activated or deactivated.</td>
</tr>
<tr>
<td>WM_ACTIVATEAPP</td>
<td>ON_WM_ACTIVATEAPP()</td>
<td>The framework calls this member function to all top-level windows of the task being activated and for all top-level windows of the task being deactivated.</td>
</tr>
<tr>
<td>WM_APPCOMMAND</td>
<td>ON_WM_APPCOMMAND()</td>
<td>The framework calls this member function when the user generates an application command event.</td>
</tr>
<tr>
<td>WM_CANCELMODE</td>
<td>ON_WM_CANCELMODE()</td>
<td>The framework calls this member function to inform CWnd to cancel any internal mode.</td>
</tr>
<tr>
<td>WM_CHILDACTIVATE</td>
<td>ON_WM_CHILDACTIVATE()</td>
<td>If the CWnd object is a multiple document interface (MDI) child window, OnChildActivate is called by the framework when the user clicks the window's title bar or when the window is activated, moved, or sized.</td>
</tr>
<tr>
<td>WM_CLIPBOARDUPDATE</td>
<td>ON_WM_CLIPBOARDUPDATE()</td>
<td>The framework calls this member function when the contents of the clipboard have changed.</td>
</tr>
<tr>
<td>WM_CLOSE</td>
<td>ON_WM_CLOSE()</td>
<td>The framework calls this member function as a signal that the CWnd or an application is to terminate.</td>
</tr>
<tr>
<td>WM_CONTEXTMENU</td>
<td>ON_WM_CONTEXTMEN()</td>
<td>Called by the framework when the user has clicked the right mouse button (right-clicked) in the window.</td>
</tr>
<tr>
<td>Message</td>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>WM_COPYDATA</td>
<td>ON_WM_COPYDATA()</td>
<td>This member function is called by the framework to copy data from one application to another.</td>
</tr>
<tr>
<td>WM_CREATE</td>
<td>ON_WM_CREATE()</td>
<td>The framework calls this member function when an application requests that the Windows window be created by calling the Create or CreateEx member function.</td>
</tr>
<tr>
<td>WM_CTLCOLOR</td>
<td>ON_WM_CTLCOLOR()</td>
<td>The framework calls this member function when a child control is about to be drawn.</td>
</tr>
<tr>
<td>WM_DELETEITEM</td>
<td>ON_WM_DELETEITEM()</td>
<td>The framework calls this member function to inform the owner of an owner-draw list box or combo box that the list box or combo box is destroyed or that items have been removed.</td>
</tr>
<tr>
<td>WM_DESTROY</td>
<td>ON_WM_DESTROY()</td>
<td>The framework calls this member function to inform the CWnd object that it is being destroyed.</td>
</tr>
<tr>
<td>WM_DRAWITEM</td>
<td>ON_WM_DRAWITEM()</td>
<td>The framework calls this member function for the owner of an owner-draw button control, combo-box control, list-box control, or menu when a visual aspect of the control or menu has changed.</td>
</tr>
<tr>
<td>WM_DROPFILES</td>
<td>ON_WM_DROPFILES()</td>
<td>The framework calls this member function when the user releases the left mouse button over a window that has registered itself as the recipient of dropped files.</td>
</tr>
<tr>
<td>WM_ENABLE</td>
<td>ON_WM_ENABLE()</td>
<td>The framework calls this member function when an application changes the enabled state of the CWnd object. Syntax</td>
</tr>
<tr>
<td>WM_HELPINFO</td>
<td>ON_WM_HELPINFO()</td>
<td>Handles F1 Help within the application (using the current context).</td>
</tr>
<tr>
<td>WM_HOTKEY</td>
<td>ON_WM_HOTKEY()</td>
<td>The framework calls this member function when the user presses a system-wide hot key.</td>
</tr>
<tr>
<td>WM_HSCROLL</td>
<td>ON_WM_HSCROLL()</td>
<td>The framework calls this member function when the user clicks a window's horizontal scroll bar.</td>
</tr>
<tr>
<td>WM_KEYDOWN</td>
<td>ON_WM_KEYDOWN()</td>
<td>The framework calls this member function when a nonsystem key is pressed.</td>
</tr>
<tr>
<td>WM_KEYUP</td>
<td>ON_WM_KEYUP()</td>
<td>The framework calls this member function when a nonsystem key is released.</td>
</tr>
<tr>
<td>WM_KILLFOCUS</td>
<td>ON_WM_KILLFOCUS()</td>
<td>The framework calls this member function immediately before losing the input focus.</td>
</tr>
<tr>
<td>WM_LBUTTONDOWN</td>
<td>ON_WM_LBUTTONDOWN()</td>
<td>The framework calls this member function when the user double-clicks the left mouse button.</td>
</tr>
<tr>
<td>WM_LBUTTONDOWN</td>
<td>ON_WM_LBUTTONDOWN()</td>
<td>The framework calls this member function when the user presses the left mouse button.</td>
</tr>
<tr>
<td>WM_LBUTTONUP</td>
<td>ON_WM_LBUTTONUP()</td>
<td>The framework calls this member function when the user releases the left mouse button.</td>
</tr>
<tr>
<td>WM_MBUTTONDOWN_CLICKED</td>
<td>ON_WM_MBUTTONDOWN_CLICKED()</td>
<td>The framework calls this member function when the user double-clicks the middle mouse button.</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>WM_MBUTTONDOWN_OWNER</td>
<td>ON_WM_MBUTTONDOWN_OWNER()</td>
<td>The framework calls this member function when the user presses the middle mouse button.</td>
</tr>
<tr>
<td>WM_MBUTTONDOWN_UP</td>
<td>ON_WM_MBUTTONDOWN_UP()</td>
<td>The framework calls this member function when the user releases the middle mouse button.</td>
</tr>
<tr>
<td>WM_MENUSELECT</td>
<td>ON_WM_MENUSELECT()</td>
<td>If the CWnd object is associated with a menu, OnMenuSelect is called by the framework when the user selects a menu item.</td>
</tr>
<tr>
<td>WM_MOUSEACTIVATE</td>
<td>ON_WM_MOUSEACTIVATE()</td>
<td>The framework calls this member function when the cursor is in an inactive window and the user presses a mouse button.</td>
</tr>
<tr>
<td>WM_MOUSEOVER</td>
<td>ON_WM_MOUSEOVER()</td>
<td>The framework calls this member function when the cursor hovers over the client area of the window for the period of time specified in a prior call to TrackMouseEvent.</td>
</tr>
<tr>
<td>WM_MOUSEWHEEL</td>
<td>ON_WM_MOUSEWHEEL()</td>
<td>The framework calls this member function when the current window is composed by the Desktop Window Manager (DWM), and that window is maximized.</td>
</tr>
<tr>
<td>WM_MOUSELEAVE</td>
<td>ON_WM_MOUSELEAVE()</td>
<td>The framework calls this member function when the cursor leaves the client area of the window specified in a prior call to TrackMouseEvent.</td>
</tr>
<tr>
<td>WM_MOUSEMOVE</td>
<td>ON_WM_MOUSEMOVE()</td>
<td>The framework calls this member function when the mouse cursor moves.</td>
</tr>
<tr>
<td>WM_MOVE</td>
<td>ON_WM_MOVE()</td>
<td>The framework calls this member function after the CWnd object has been moved.</td>
</tr>
<tr>
<td>WM_PAINT</td>
<td>ON_WM_PAINT()</td>
<td>The framework calls this member function when Windows or an application makes a request to repaint a portion of an application's window.</td>
</tr>
<tr>
<td>WM_SETFOCUS</td>
<td>ON_WM_SETFOCUS()</td>
<td>The framework calls this member function after gaining the input focus.</td>
</tr>
<tr>
<td>WM_SIZE()</td>
<td>ON_WM_SIZE()</td>
<td>The framework calls this member function after the window's size has changed.</td>
</tr>
<tr>
<td>WM_TIMER</td>
<td>ON_WM_TIMER()</td>
<td>The framework calls this member function after each interval specified in the SetTimer member function used to install a timer.</td>
</tr>
<tr>
<td>WM_VSCROLL</td>
<td>ON_WM_VSCROLL()</td>
<td>The framework calls this member function when the user clicks the window's vertical scroll bar.</td>
</tr>
<tr>
<td>WM_WINDOWPOS_CHANGED</td>
<td>ON_WM_WINDOWPOS_CHANGED()</td>
<td>The framework calls this member function when the size, position, or Z-order has changed as a result of a call to the SetWindowPos member function or another window-management function.</td>
</tr>
</tbody>
</table>
Let us look into a simple example of window creation.

**WM_CREATE:** When an object, called a window, is created, the frame that creates the objects sends a message identified as **ON_WM_CREATE**.

**Step 1:** To create ON_WM_CREATE, add `afx_msg int OnCreate(LPCREATESTRUCT lpCreateStruct);` before the `DECLARE_MESSAGE_MAP()` as shown below.

```cpp
class CMainFrame : public CFrameWnd
{
public:
    CMainFrame();
protected:
    afx_msg int OnCreate(LPCREATESTRUCT lpCreateStruct);
    DECLARE_MESSAGE_MAP()
};
```

**Step 2:** Add the `ON_WM_CREATE()` after the `BEGIN_MESSAGE_MAP(CMainFrame, CFrameWnd)` and before `END_MESSAGE_MAP()`

```cpp
BEGIN_MESSAGE_MAP(CMainFrame, CFrameWnd)
    ON_WM_CREATE()
END_MESSAGE_MAP()
```

**Step 3:** Here is the Implementation of OnCreate()

```cpp
int CMainFrame::OnCreate(LPCREATESTRUCT lpCreateStruct)
{
    // Call the base class to create the window
    if (CFrameWnd::OnCreate(lpCreateStruct) == 0)
    {
        // If the window was successfully created, let the user know
        MessageBox(L"The window has been created!!!");
        // Since the window was successfully created, return 0
        return 0;
    }
    // Otherwise, return -1
    return -1;
}
```
**Step 4:** Now your *.cpp file will look like as shown in the following code.

```cpp
#include <afxwin.h>
class CMainFrame : public CFrameWnd
{
public:
    CMainFrame();
protected:
    afx_msg int OnCreate(LPCREATESTRUCT lpCreateStruct);
    DECLARE_MESSAGE_MAP()
};
CMainFrame::CMainFrame()
{
    // Create the window's frame
    Create(NULL, L"MFC Messages Demo", WS_OVERLAPPEDWINDOW,
           CRect(120, 100, 700, 480), NULL);
}
class CMessagesApp : public CWinApp
{
public:
    BOOL InitInstance();
};
BEGIN_MESSAGE_MAP(CMainFrame, CFrameWnd)
    ON_WM_CREATE()
END_MESSAGE_MAP()
int CMainFrame::OnCreate(LPCREATESTRUCT lpCreateStruct)
{
    // Call the base class to create the window
    if (CFrameWnd::OnCreate(lpCreateStruct) == 0)
    {
        // If the window was successfully created, let the user know
        MessageBox(L"The window has been created!!!");
        // Since the window was successfully created, return 0
        return 0;
    }
    // Otherwise, return -1
    return -1;
}
```
BOOL CMessagesApp::InitInstance()
{  
m_pMainWnd = new CMainFrame;
    m_pMainWnd->ShowWindow(SW_SHOW);
    m_pMainWnd->UpdateWindow();
    return TRUE;
}
CMessagesApp theApp;

**Step 5:** When the above code is compiled and executed, you will see the following output.

**Step 6:** When you click OK, it will display the main window.
Command Messages

One of the main features of a graphical application is to present Windows controls and resources that allow the user to interact with the machine. Examples of controls that we will learn are buttons, list boxes, combo boxes, etc.

One type of resource we introduced in the previous lesson is the menu. Such controls and resources can initiate their own messages when the user clicks them. A message that emanates from a Windows control or a resource is called a command message.

Let us look into a simple example of Command messages.

To provide your application the ability to create a new document, the CWinApp class provides the OnFileNew() method.

```cpp
afx_msg void OnFileNew();

BEGIN_MESSAGE_MAP(CMainFrame, CFrameWnd)
   ON_COMMAND(ID_FILE_NEW, CMainFrame::OnFileNew)
END_MESSAGE_MAP()
```

Here is the method definition:

```cpp
void CMainFrame::OnFileNew()
{
   // Create New file
}
```

Keyboard Messages

A keyboard is a hardware object attached to the computer. By default, it is used to enter recognizable symbols, letters, and other characters on a control. Each key on the keyboard displays a symbol, a letter, or a combination of those, to give an indication of what the key could be used for. The user typically presses a key, which sends a signal to a program.

Each key has a code that the operating system can recognize. This code is known as the virtual key code. The virtual key codes are as follows:

<table>
<thead>
<tr>
<th>Constant/value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VK_LBUTTON</td>
<td>Left mouse button</td>
</tr>
<tr>
<td>VK_RBUTTON</td>
<td>Right mouse button</td>
</tr>
<tr>
<td>VK_CANCEL</td>
<td>Control-break processing</td>
</tr>
<tr>
<td>VK_MBUTTON</td>
<td>Middle mouse button (three-button mouse)</td>
</tr>
<tr>
<td>VK_BACK</td>
<td>BACKSPACE key</td>
</tr>
<tr>
<td>VK_TAB</td>
<td>TAB key</td>
</tr>
<tr>
<td>VK_CLEAR</td>
<td>CLEAR key</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------</td>
</tr>
<tr>
<td>VK_RETURN</td>
<td>ENTER key</td>
</tr>
<tr>
<td>VK_SHIFT</td>
<td>SHIFT key</td>
</tr>
<tr>
<td>VK_CONTROL</td>
<td>CTRL key</td>
</tr>
<tr>
<td>VK_MENU</td>
<td>ALT key</td>
</tr>
<tr>
<td>VK_PAUSE</td>
<td>PAUSE key</td>
</tr>
<tr>
<td>VK_CAPITAL</td>
<td>CAPS LOCK key</td>
</tr>
<tr>
<td>VK_ESCAPE</td>
<td>ESC key</td>
</tr>
<tr>
<td>VK_SPACE</td>
<td>SPACEBAR</td>
</tr>
<tr>
<td>VK_PRIOR</td>
<td>PAGE UP key</td>
</tr>
<tr>
<td>VK_NEXT</td>
<td>PAGE DOWN key</td>
</tr>
<tr>
<td>VK_END</td>
<td>END key</td>
</tr>
<tr>
<td>VK_HOME</td>
<td>HOME key</td>
</tr>
<tr>
<td>VK_LEFT</td>
<td>LEFT ARROW key</td>
</tr>
<tr>
<td>VK_UP</td>
<td>UP ARROW key</td>
</tr>
<tr>
<td>VK_RIGHT</td>
<td>RIGHT ARROW key</td>
</tr>
<tr>
<td>VK_DOWN</td>
<td>DOWN ARROW key</td>
</tr>
<tr>
<td>VK_SELECT</td>
<td>SELECT key</td>
</tr>
<tr>
<td>VK_PRINT</td>
<td>PRINT key</td>
</tr>
<tr>
<td>VK_EXECUTE</td>
<td>EXECUTE key</td>
</tr>
<tr>
<td>VK_SNAPSHOT</td>
<td>PRINT SCREEN key</td>
</tr>
<tr>
<td>VK_INSERT</td>
<td>INS key</td>
</tr>
<tr>
<td>VK_DELETE</td>
<td>DEL key</td>
</tr>
<tr>
<td>VK_NUMPAD0</td>
<td>Numeric keypad 0 key</td>
</tr>
<tr>
<td>VK_NUMPAD1</td>
<td>Numeric keypad 1 key</td>
</tr>
<tr>
<td>VK_NUMPAD2</td>
<td>Numeric keypad 2 key</td>
</tr>
<tr>
<td>VK_NUMPAD3</td>
<td>Numeric keypad 3 key</td>
</tr>
<tr>
<td>VK_NUMPAD4</td>
<td>Numeric keypad 4 key</td>
</tr>
<tr>
<td>VK_NUMPAD5</td>
<td>Numeric keypad 5 key</td>
</tr>
<tr>
<td>VK_NUMPAD6</td>
<td>Numeric keypad 6 key</td>
</tr>
<tr>
<td>VK_NUMPAD7</td>
<td>Numeric keypad 7 key</td>
</tr>
<tr>
<td>VK_NUMPAD8</td>
<td>Numeric keypad 8 key</td>
</tr>
<tr>
<td>VK_NUMPAD9</td>
<td>Numeric keypad 9 key</td>
</tr>
<tr>
<td>VK_MULTIPLY</td>
<td>Multiply key</td>
</tr>
<tr>
<td>VK_ADD</td>
<td>Add key</td>
</tr>
<tr>
<td>VK_SEPARATOR</td>
<td>Separator key</td>
</tr>
<tr>
<td>VK_SUBTRACT</td>
<td>Subtract key</td>
</tr>
<tr>
<td>VK_DECIMAL</td>
<td>Decimal key</td>
</tr>
<tr>
<td>VK_DIVIDE</td>
<td>Divide key</td>
</tr>
<tr>
<td>VK_F1</td>
<td>F1 key</td>
</tr>
<tr>
<td>VK_F2</td>
<td>F2 key</td>
</tr>
<tr>
<td>VK_F3</td>
<td>F3 key</td>
</tr>
<tr>
<td>VK_F4</td>
<td>F4 key</td>
</tr>
<tr>
<td>VK_F5</td>
<td>F5 key</td>
</tr>
<tr>
<td>VK_F6</td>
<td>F6 key</td>
</tr>
<tr>
<td>VK_F7</td>
<td>F7 key</td>
</tr>
<tr>
<td>VK_F8</td>
<td>F8 key</td>
</tr>
<tr>
<td>VK_F9</td>
<td>F9 key</td>
</tr>
<tr>
<td>VK_F10</td>
<td>F10 key</td>
</tr>
<tr>
<td>VK_F11</td>
<td>F11 key</td>
</tr>
<tr>
<td>VK_F12</td>
<td>F12 key</td>
</tr>
<tr>
<td>VK_NUMLOCK</td>
<td>NUM LOCK key</td>
</tr>
<tr>
<td>VK_SCROLL</td>
<td>SCROLL LOCK key</td>
</tr>
</tbody>
</table>
Pressing a key causes a WM_KEYDOWN or WM_SYSKEYDOWN message to be placed in the thread message. This can be defined as follows:

```cpp
afx_msg void OnKeyDown(UINT nChar, UINT nRepCnt, UINT nFlags);
```

Let us look into a simple example.

**Step 1:** Here is the message.

```cpp
BEGIN_MESSAGE_MAP(CMainFrame, CFrameWnd)
    ON_WM_CREATE()
    ON_WM_KEYDOWN()
END_MESSAGE_MAP()
```

**Step 2:** Here is the implementation of OnKeyDown().

```cpp
void CMainFrame::OnKeyDown(UINT nChar, UINT nRepCnt, UINT nFlags)
{
    switch (nChar)
    {
    case VK_RETURN:
        MessageBox(L"You pressed Enter");
        break;
    case VK_F1:
        MessageBox(L"Help is not available at the moment");
        break;
    case VK_DELETE:
        MessageBox(L"Can't Delete This");
        break;
    default:
        MessageBox(L"Whatever");
    }
}
```
Step 3: When the above code is compiled and executed, you will see the following output.

Step 4: When you press Enter, it will display the following message.

Mouse Messages

The mouse is another object that is attached to the computer allowing the user to interact with the machine.

- If the left mouse button was pressed, an ON_WM_LBUTTONDOWN message is sent. The syntax of this message is:
  o afx_msg void OnLButtonDown(UINT nFlags, CPoint point)

- If the right mouse button was pressed, an ON_WM_RBUTTONDOWN message is sent. Its syntax is:
  o afx_msg void OnRButtonDown(UINT nFlags, CPoint point)
Similarly if the left mouse is being released, the ON_WM_LBUTTONDOWN message is sent. Its syntax is:
  o afx_msg void OnLButtonDown(UINT nFlags, CPoint point)

If the right mouse is being released, the ON_WM_RBUTTONDOWN message is sent. Its syntax is:
  o afx_msg void OnRButtonDown(UINT nFlags, CPoint point)

Let us look into a simple example.

**Step 1:** Add the following two functions in CMainFrame class definition as shown in the following code.

```cpp
class CMainFrame : public CFrameWnd
{
public:
    CMainFrame();
protected:
    afx_msg void OnKeyDown(UINT nChar, UINT nRepCnt, UINT nFlags);
    afx_msg void OnLButtonDown(UINT nFlags, CPoint point);
    afx_msg void OnRButtonDown(UINT nFlags, CPoint point);
    DECLARE_MESSAGE_MAP()
};
```

**Step 2:** Add the following two Message Maps.

```cpp
BEGIN_MESSAGE_MAP(CMainFrame, CFrameWnd)
    ON_WM_KEYDOWN()  
    ON_WM_LBUTTONDOWN()  
    ON_WM_RBUTTONDOWN()
END_MESSAGE_MAP()
```

**Step 3:** Here is the functions definition.

```cpp
void CMainFrame::OnLButtonDown(UINT nFlags, CPoint point)
{
    CString MsgCoord;
    MsgCoord.Format(L"Left Button at P(%d, %d)", point.x, point.y);
    MessageBox(MsgCoord);
}

void CMainFrame::OnRButtonDown(UINT nFlags, CPoint point)
{
    MessageBox(L"Right Mouse Button Up");
}
```
Step 4: When you run this application, you will see the following output.

Step 5: When you click OK, you will see the following message.

Step 6: Right-click on this window. Now, when you release the right button of the mouse, it will display the following message.
An **ActiveX control container** is a parent program that supplies the environment for an ActiveX (formerly OLE) control to run.

- ActiveX control is a control using Microsoft ActiveX technologies.
- ActiveX is not a programming language, but rather a set of rules for how applications should share information.
- Programmers can develop ActiveX controls in a variety of languages, including C, C++, Visual Basic, and Java.
- You can create an application capable of containing ActiveX controls with or without MFC, but it is much easier to do with MFC.

Let us look into simple example of add ActiveX controls in your MFC dialog based application.

**Step 1:** Right-click on the dialog in the designer window and select Insert ActiveX Control.

![Insert ActiveX Control](image)

**Step 2:** Select the Microsoft Picture Clip Control and click OK.
Step 3: Resize the Picture control and in the Properties window, click the Picture field.

Step 4: Browse the folder that contains Pictures. Select any picture.

Step 5: When you run this application, you will see the following output.
Let us have a look into another simple example.

**Step 1:** Right-click on the dialog in the designer window.
Step 2: Select Insert ActiveX Control.

Step 3: Select the Microsoft ProgressBar Control 6.0, click OK.
Step 4: Select the progress bar and set its Orientation in the Properties Window to 1 – ccOrientationVertical.

Step 5: Add control variable for Progress bar.

Step 6: Add the following code in the OnInitDialog()

```cpp
m_progBarCtrl.SetScrollRange(0,100,TRUE);
m_progBarCtrl.Put_Value(53);
```
**Step 7:** When you run this application again, you will see the progress bar in Vertical direction as well.
In this chapter, we will discuss the various components of the file system.

### Drives

A **drive** is a physical device attached to a computer so it can store information. A logical disk, logical volume or virtual disk (VD or vdisk for short) is a virtual device that provides an area of usable storage capacity on one or more physical disk drive(s) in a computer system. A drive can be a hard disk, a CD ROM, a DVD ROM, a flash (USB) drive, a memory card, etc.

One of the primary operations you will want to perform is to get a list of drives on the computer.

Let us look into a simple example by creating a new MFC dialog based application.

**Step 1:** Drag one button from the toolbox, change its Caption to Get Drives Info.

**Step 2:** Remove the Caption of Static control (TODO line) and change its ID to IDC_STATIC_TEXT.
**Step 3:** Right-click on the button and select Add Event Handler.

![Event Handler Wizard](image)

**Step 4:** Select the BN_CLICKED message type and click the Add and Edit button.
**Step 5:** Add the value variable `m_strDrives` for Static Text control.

To support drives on a computer, the Win32 library provides the `GetLogicalDrives()` function of Microsoft Window, which will retrieve a list of all drives on the current computer.
**Step 6:** When the above code is compiled and executed, you will see the following output.

![Microsoft Foundation Classes](image1)

**Step 7:** When you click the button, you can see all the drives on your computer.

![Microsoft Foundation Classes](image2)
Directories

In computing, a directory is a file system cataloging structure which contains references to other computer files, and possibly other directories. Directory is a physical location. It can handle operations not available on a drive.

Let us look into a simple example by creating a new MFC dialog based application

**Step 1:** Drag three buttons from the toolbox. Change their Captions to Create Directory, Delete Directory and Move Directory.

**Step 2:** Change the IDs of these buttons to IDC_BUTTON_CREATE, IDC_BUTTON_DELETE and IDC_BUTTON_MOVE.

**Step 3:** Remove the TODO line.

**Step 4:** Add event handler for each button.

**Step 5:** To create a directory, you can call the CreateDirectory() method of the Win32 library.

**Step 6:** Here is the Create button event handler implementation in which we will create one directory and then two more sub directories.
void CMFCDirectoriesDemoDlg::OnBnClickedButtonCreate()
{
    // TODO: Add your control notification handler code here
    SECURITY_ATTRIBUTES saPermissions;

    saPermissions.nLength = sizeof(SEcurity_ATTRIBUTES);
    saPermissions.lpSecurityDescriptor = NULL;
    saPermissions.bInheritHandle = TRUE;

    if (CreateDirectory(L"D:\MFCDirectoryDEMO", &saPermissions) == TRUE)
        AfxMessageBox(L"The directory was created.");
    CreateDirectory(L"D:\MFCDirectoryDEMO\Dir1", NULL);
    CreateDirectory(L"D:\MFCDirectoryDEMO\Dir2", NULL);
}

**Step 7:** To get rid of a directory, you can call the `RemoveDirectory()` function of the Win32 library. Here is the implementation of delete button event handler.

```cpp
void CMFCDirectoriesDemoDlg::OnBnClickedButtonDelete()
{
    // TODO: Add your control notification handler code here
    if (RemoveDirectory(L"D:\MFCDirectoryDEMO\Dir1") == TRUE)
        AfxMessageBox(L"The directory has been deleted");
}
```

**Step 8:** If you want to move a directory, you can also call the same `MoveFile()` function. Here is the implementation of move button event handler in which we will create first new directory and then move the Dir2 to that directory.

```cpp
void CMFCDirectoriesDemoDlg::OnBnClickedButtonMove()
{
    // TODO: Add your control notification handler code here
    CreateDirectory(L"D:\MFCDirectory", NULL)

    if (MoveFile(L"D:\MFCDirectoryDEMO\Dir1",
                 L"D:\MFCDirectory\Dir1") == TRUE)
        AfxMessageBox(L"The directory has been moved");
}
```
**Step 9:** When the above code is compiled and executed, you will see the following output.

![Image of the MFCDirectoriesDemo window with buttons: Create Directory, Delete Directory, Move Directory, OK, and Cancel.]

**Step 10:** When you click the Create Directory button, it will create these directories.
Step 11: When you click on Delete Directory button, it will delete the Dir1.
File Processing

Most of the **file processing** in an MFC application is performed in conjunction with a class named **CArchive**. The CArchive class serves as a relay between the application and the medium used to either store data or make it available. It allows you to save a complex network of objects in a permanent binary form (usually disk storage) that persists after those objects are deleted.

Here is the list of methods in CArchive class:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Abort</strong></td>
<td>Closes an archive without throwing an exception.</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Flushes unwritten data and disconnects from the CFile.</td>
</tr>
<tr>
<td><strong>Flush</strong></td>
<td>Flushes unwritten data from the archive buffer.</td>
</tr>
<tr>
<td><strong>GetFile</strong></td>
<td>Gets the CFile object pointer for this archive.</td>
</tr>
<tr>
<td><strong>GetObjectSchema</strong></td>
<td>Called from the Serialize function to determine the version of the object that is being deserialized.</td>
</tr>
<tr>
<td><strong>IsBufferEmpty</strong></td>
<td>Determines whether the buffer has been emptied during a Windows Sockets receive process.</td>
</tr>
<tr>
<td><strong>IsLoading</strong></td>
<td>Determines whether the archive is loading.</td>
</tr>
<tr>
<td><strong>IsStoring</strong></td>
<td>Determines whether the archive is storing.</td>
</tr>
<tr>
<td><strong>MapObject</strong></td>
<td>Places objects in the map that are not serialized to the file, but that are available for subobjects to reference.</td>
</tr>
<tr>
<td><strong>Read</strong></td>
<td>Reads raw bytes.</td>
</tr>
<tr>
<td><strong>ReadClass</strong></td>
<td>Reads a class reference previously stored with WriteClass.</td>
</tr>
<tr>
<td><strong>ReadObject</strong></td>
<td>Calls an object's Serialize function for loading.</td>
</tr>
<tr>
<td><strong>ReadString</strong></td>
<td>Reads a single line of text.</td>
</tr>
<tr>
<td><strong>SerializeClass</strong></td>
<td>Reads or writes the class reference to the CArchive object depending on the direction of the CArchive.</td>
</tr>
<tr>
<td><strong>SetLoadParams</strong></td>
<td>Sets the size to which the load array grows. Must be called before any object is loaded or before MapObject or ReadObject is called.</td>
</tr>
<tr>
<td><strong>SetObjectSchema</strong></td>
<td>Sets the object schema stored in the archive object.</td>
</tr>
<tr>
<td><strong>SetStoreParams</strong></td>
<td>Sets the hash table size and the block size of the map used to identify unique objects during the serialization process.</td>
</tr>
<tr>
<td><strong>Write</strong></td>
<td>Writes raw bytes.</td>
</tr>
<tr>
<td><strong>WriteClass</strong></td>
<td>Writes a reference to the CRuntimeClass to the CArchive.</td>
</tr>
<tr>
<td><strong>WriteObject</strong></td>
<td>Calls an object's Serialize function for storing.</td>
</tr>
<tr>
<td><strong>WriteString</strong></td>
<td>Writes a single line of text.</td>
</tr>
</tbody>
</table>
Here is the list of operators used to store and retrieve data:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>operator &lt;&lt;</code></td>
<td>Stores objects and primitive types to the archive.</td>
</tr>
<tr>
<td><code>operator &gt;&gt;</code></td>
<td>Loads objects and primitive types from the archive.</td>
</tr>
</tbody>
</table>

Let us look into a simple example by creating a new MFC dialog based application.

**Step 1:** Drag one edit control and two buttons as shown in the following snapshot.

**Step 2:** Add control variable `m_editCtrl` and value variable `m_strEdit` for edit control.

**Step 3:** Add click event handler for Open and Save buttons.

**Step 4:** Here is the implementation of event handlers.

```cpp
void CMFCFileProcessingDlg::OnBnClickedButtonOpen()
{
    // TODO: Add your control notification handler code here
    UpdateData(TRUE);

    CFile file;

    file.Open(L"ArchiveText.rpr", CFile::modeRead);
    if(file)
        CArchive ar(&file, CArchive::load);
```
ar >> m_strEdit;

ar.Close();
file.Close();

UpdateData(FALSE);
}

void CMFCFileProcessingDlg::OnBnClickedButtonSave()
{
    // TODO: Add your control notification handler code here
    UpdateData(TRUE);

    if (m_strEdit.GetLength() == 0)
    {
        AfxMessageBox(L"You must enter the name of the text.");
        return;
    }

    CFile file;

    file.Open(L"ArchiveText.rpr", CFile::modeCreate | CFile::modeWrite);
    CArchive ar(&file, CArchive::store);

    ar << m_strEdit;

    ar.Close();
    file.Close();
}
Step 5: When the above code is compiled and executed, you will see the following output.

![MFCFileProcessing](image)

Step 6: Write something and click Save. It will save the data in binary format.

![MFCFileProcessing](image)

Step 7: Remove the test from edit control. As you click Open, observe that the same text is loaded again.
The MFC library provides its own version of file processing. This is done through a class named CStdioFile. The CStdioFile class is derived from CFile. It can handle the reading and writing of Unicode text files as well as ordinary multi-byte text files.

Here is the list of constructors, which can initialize a CStdioFile object:

```cpp
CStdioFile();
CStdioFile(CAtlTransactionManager* pTM);
CStdioFile(FILE* pOpenStream);
CStdioFile(LPCTSTR lpszFileName, UINT nOpenFlags);
CStdioFile(LPCTSTR lpszFileName, UINT nOpenFlags, CAtlTransactionManager* pTM);
```

Here is the list of methods in CStdioFile:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Overloaded. Open is designed for use with the default CStdioFile constructor (Overrides CFile::Open).</td>
</tr>
<tr>
<td>ReadString</td>
<td>Reads a single line of text.</td>
</tr>
<tr>
<td>Seek</td>
<td>Positions the current file pointer.</td>
</tr>
<tr>
<td>WriteString</td>
<td>Writes a single line of text.</td>
</tr>
</tbody>
</table>

Let us look into a simple example again by creating a new MFC dialog based application.

**Step 1:** Drag one edit control and two buttons as shown in the following snapshot.
Step 2: Add value variable `m_strEditCtrl` for edit control.
Step 3: Add click event handler for Open and Save buttons.

Step 4: Here is the implementation of event handlers.

```cpp
void CMFCStandardIODlg::OnBnClickedButtonOpen()
{
    // TODO: Add your control notification handler code here
    UpdateData(TRUE);

    CStdioFile file;
    file.Open(L"D:\MFCDirectoryDEMO\test.txt", CFile::modeRead | CFile::typeText);

    file.ReadString(m_strEditCtrl);
    file.Close();
    UpdateData(FALSE);
}

void CMFCStandardIODlg::OnBnClickedButtonSave()
```
```cpp
{
    // TODO: Add your control notification handler code here
    UpdateData(TRUE);
    CStdioFile file;
    if (m_strEditCtrl.GetLength() == 0)
    {
        AfxMessageBox(L"You must specify the text.");
        return;
    }
    file.Open(L"D:\MFCDirectoryDEMO\test.txt", CFile::modeCreate | CFile::modeWrite | CFile::typeText);
    file.WriteString(m_strEditCtrl);
    file.Close();
}
```

**Step 5:** When the above code is compiled and executed, you will see the following output.

![Image of MFCStandardIO window with a text field and buttons for 'Open' and 'Save']
Step 6: Write something and click Save. It will save the data in *.txt file.
**Step 7:** If you look at the location of the file, you will see that it contains the test.txt file.

![Image of file location and Notepad window]

**Step 8:** Now, close the application. Run the same application. When you click Open, the same text loads again.

**Step 9:** It starts by opening the file, reading the file, followed by updating the Edit Control.
The **Document/View architecture** is the foundation used to create applications based on the Microsoft Foundation Classes library. It allows you to make distinct the different parts that compose a computer program including what the user sees as part of your application and the document a user would work on. This is done through a combination of separate classes that work as an ensemble.

The parts that compose the Document/View architecture are a frame, one or more documents, and the view. Put together, these entities make up a usable application.

**View**

A **view** is the platform the user is working on to do his or her job. To let the user do anything on an application, you must provide a view, which is an object based on the CView class. You can either directly use one of the classes derived from CView or you can derive your own custom class from CView or one of its child classes.

**Document**

A **document** is similar to a bucket. For a computer application, a document holds the user's data. To create the document part of this architecture, you must derive an object from the CDocument class.

**Frame**

As the name suggests, a **frame** is a combination of the building blocks, the structure, and the borders of an item. A frame gives "physical" presence to a window. It also defines the location of an object with regards to the Windows desktop.

**Single Document Interface (SDI)**

The expression **Single Document Interface** or SDI refers to a document that can present only one view to the user. This means that the application cannot display more than one document at a time. If you want to view another type of document of the current application, you must create another instance of the application. Notepad and WordPad are examples of SDI applications.
Let us look into a simple example of single document interface or SDI by creating a new MFC dialog based application.

**Step 1:** Let us create a new MFC Application **MFCSDIDemo** with below mentioned settings.

![MFC Application Wizard - MFCSDIDemo](image)

**Step 2:** Select Single document from the Application type and MFC standard from Project Style.

**Step 3:** Click Finish to Continue.
Step 4: Once the project is created, run the application and you will see the following output.

![Application Output]

Multiple Document Interface (MDI)

An application is referred to as a **Multiple Document Interface**, or MDI, if the user can open more than one document in the application without closing it. To provide this functionality, the application provides a parent frame that acts as the main frame of the computer program. Inside this frame, the application allows creating views with individual frames, making each view distinct from the other.

Let us look into a simple example of single document interface or SDI by creating a new MFC dialog based application.
**Step 1:** Let us create a new MFC Application **MFCMDIDemo** with below mentioned settings.

![MFC Application Wizard - MFCMDIDemo](image)

**Step 2:** Select Single document from the Application type and MFC standard from Project Style.

**Step 3:** Click Finish to Continue.
**Step 4:** Once the project is created, run the application and you will see the following output.

![Application Output]

**Step 5:** When you click on File -> New menu option, it will create another child window as shown in the following snapshot.
Step 6: In Multiple Document Interface (MDI) applications, there is one main frame per application. In this case, a CMDIFrameWnd, and one CMDIChildWnd derived child frame for each document.
Strings are objects that represent sequences of characters. The C-style character string originated within the C language and continues to be supported within C++.

- This string is actually a one-dimensional array of characters which is terminated by a null character '\0'.

- A null-terminated string contains the characters that comprise the string followed by a null.

Here is the simple example of character array.

```c
```

Following is another way to represent it.

```c
char word[] = "Hello, World";
```

Microsoft Foundation Class (MFC) library provides a class to manipulate string called CString. Following are some important features of CString.

- CString does not have a base class.
- A CString object consists of a variable-length sequence of characters.
- CString provides functions and operators using a syntax similar to that of Basic.
- Concatenation and comparison operators, together with simplified memory management, make CString objects easier to use than ordinary character arrays.

Here is the constructor of CString.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CString</td>
<td>Constructs CString objects in various ways</td>
</tr>
</tbody>
</table>

Here is a list of Array Methods:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetLength</td>
<td>Returns the number of characters in a CString object.</td>
</tr>
<tr>
<td>IsEmpty</td>
<td>Tests whether a CString object contains no characters.</td>
</tr>
<tr>
<td>Empty</td>
<td>Forces a string to have 0 length.</td>
</tr>
<tr>
<td>GetAt</td>
<td>Returns the character at a specified position.</td>
</tr>
<tr>
<td>SetAt</td>
<td>Sets a character at a specified position.</td>
</tr>
</tbody>
</table>
Here is a list of Comparison Methods:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare</td>
<td>Compares two strings (case sensitive).</td>
</tr>
<tr>
<td>CompareNoCase</td>
<td>Compares two strings (case insensitive).</td>
</tr>
</tbody>
</table>

Here is a list of Extraction Methods:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid</td>
<td>Extracts the middle part of a string (like the Basic MID$ function).</td>
</tr>
<tr>
<td>Left</td>
<td>Extracts the left part of a string (like the Basic LEFT$ function).</td>
</tr>
<tr>
<td>Right</td>
<td>Extracts the right part of a string (like the Basic RIGHT$ function).</td>
</tr>
<tr>
<td>SpanIncluding</td>
<td>Extracts a substring that contains only the characters in a set.</td>
</tr>
<tr>
<td>SpanExcluding</td>
<td>Extracts a substring that contains only the characters not in a set.</td>
</tr>
</tbody>
</table>

Here is a list of Conversion Methods:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MakeUpper</td>
<td>Converts all the characters in this string to uppercase characters.</td>
</tr>
<tr>
<td>MakeLower</td>
<td>Converts all the characters in this string to lowercase characters.</td>
</tr>
<tr>
<td>MakeReverse</td>
<td>Reverses the characters in this string.</td>
</tr>
<tr>
<td>Format</td>
<td>Format the string as sprintf does.</td>
</tr>
<tr>
<td>TrimLeft</td>
<td>Trim leading white-space characters from the string.</td>
</tr>
<tr>
<td>TrimRight</td>
<td>Trim trailing white-space characters from the string.</td>
</tr>
</tbody>
</table>

Here is a list of Searching Methods:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find</td>
<td>Finds a character or substring inside a larger string.</td>
</tr>
<tr>
<td>ReverseFind</td>
<td>Finds a character inside a larger string; starts from the end.</td>
</tr>
<tr>
<td>FindOneOf</td>
<td>Finds the first matching character from a set.</td>
</tr>
</tbody>
</table>

Here is a list of Buffer Access Methods:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetBuffer</td>
<td>Returns a pointer to the characters in the CString.</td>
</tr>
<tr>
<td>GetBufferSetLength</td>
<td>Returns a pointer to the characters in the CString, truncating to the specified length.</td>
</tr>
<tr>
<td>ReleaseBuffer</td>
<td>Releases control of the buffer returned by GetBuffer.</td>
</tr>
</tbody>
</table>
**FreeExtra**
Removes any overhead of this string object by freeing any extra memory previously allocated to the string.

**LockBuffer**
Disables reference counting and protects the string in the buffer.

**UnlockBuffer**
Enables reference counting and releases the string in the buffer.

Here is a list of Windows-Specific Methods.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AllocSysString</td>
<td>Allocates a BSTR from CString data.</td>
</tr>
<tr>
<td>SetSysString</td>
<td>Sets an existing BSTR object with data from a CString object.</td>
</tr>
<tr>
<td>LoadString</td>
<td>Loads an existing CString object from a Windows CE resource.</td>
</tr>
</tbody>
</table>

Following are the different operations on CString objects:

### Create String
You can create a string by either using a string literal or creating an instance of CString class.

```cpp
BOOL CMFCStringDemoDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);     // Set big icon
    SetIcon(m_hIcon, FALSE);    // Set small icon

    CString string1 = _T("This is a string1");
    CString string2("This is a string2");

    m_strText.Append(string1 + L"\n");
    m_strText.Append(string2);

    UpdateData(FALSE);

    return TRUE;  // return TRUE unless you set the focus to a control
} 
```
When the above code is compiled and executed, you will see the following output.

![Output Screen](image)

**Empty String**

You can create an empty string by either using an empty string literal or by using `CString::Empty()` method. You can also check whether a string is empty or not using Boolean property `isEmpty`.

```cpp
BOOL CMFCStringDemoDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);    // Set big icon
    SetIcon(m_hIcon, FALSE);    // Set small icon

    CString string1 = _T("");
    CString string2;
```
When the above code is compiled and executed you will see the following output.
String Concatenation

To concatenate two or more strings, you can use + operator to concatenate two strings or a CString::Append() method.

```cpp
BOOL CMFCStringDemoDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);  // Set big icon
    SetIcon(m_hIcon, FALSE);  // Set small icon

    // To concatenate two CString objects
    CString s1 = _T("This ");  // Cascading concatenation
    s1 += _T("is a ");
    CString s2 = _T("test");
    CString message = s1;
    message.Append(_T("big ") + s2);
    // Message contains "This is a big test".

    m_strText = L"message: " + message;

    UpdateData(FALSE);

    return TRUE;  // return TRUE unless you set the focus to a control
}
```
When the above code is compiled and executed you will see the following output.

![Image of MFCStringDemo dialog box with message: This is a big test]

**String Length**

To find the length of the string you can use the `CString::GetLength()` method, which returns the number of characters in a `CString` object.

```cpp
BOOL CMFCStringDemoDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);  // Set big icon
    SetIcon(m_hIcon, FALSE);  // Set small icon

    CString string1 = _T("This is string 1");
    int length = string1.GetLength();
    CString strLen;
```
strLen.Format(L"\nString1 contains %d characters", length);
m_strText = string1 + strLen;

UpdateData(FALSE);

return TRUE;  // return TRUE unless you set the focus to a control

When the above code is compiled and executed you will see the following output.
String Comparison

To compare two strings variables you can use == operator

```cpp
BOOL CMFCStringDemoDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);   // Set big icon
    SetIcon(m_hIcon, FALSE);  // Set small icon

    CString string1 = _T("Hello");
    CString string2 = _T("World");

    CString string3 = _T("MFC Tutorial");
    CString string4 = _T("MFC Tutorial");

    if (string1 == string2)
        m_strText = "string1 and string1 are same\n";
    else
        m_strText = "string1 and string1 are not same\n";

    if (string3 == string4)
        m_strText += "string3 and string4 are same";
    else
        m_strText += "string3 and string4 are not same";

    UpdateData(FALSE);

    return TRUE;  // return TRUE unless you set the focus to a control
```
When the above code is compiled and executed you will see the following output.

![Output Display](image)
**CAr-ray** is a collection that is best used for data that is to be accessed in a random or non-sequential manner. CArray class supports arrays that are like C arrays, but can dynamically shrink and grow as necessary.

- Array indexes always start at position 0.

- You can decide whether to fix the upper bound or enable the array to expand when you add elements past the current bound.

- Memory is allocated contiguously to the upper bound, even if some elements are null.

Here is a list of CArray class methods.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Adds an element to the end of the array; grows the array if necessary.</td>
</tr>
<tr>
<td>Append</td>
<td>Appends another array to the array; grows the array if necessary.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies another array to the array; grows the array if necessary.</td>
</tr>
<tr>
<td>ElementAt</td>
<td>Returns a temporary reference to the element pointer within the array.</td>
</tr>
<tr>
<td>FreeExtra</td>
<td>Frees all unused memory above the current upper bound.</td>
</tr>
<tr>
<td>GetAt</td>
<td>Returns the value at a given index.</td>
</tr>
<tr>
<td>getCount</td>
<td>Gets the number of elements in this array.</td>
</tr>
<tr>
<td>GetData</td>
<td>Allows access to elements in the array. Can be NULL.</td>
</tr>
<tr>
<td>GetSize</td>
<td>Gets the number of elements in this array.</td>
</tr>
<tr>
<td>GetUpperBound</td>
<td>Returns the largest valid index.</td>
</tr>
<tr>
<td>InsertAt</td>
<td>Inserts an element (or all the elements in another array) at a specified index.</td>
</tr>
<tr>
<td>isEmpty</td>
<td>Determines whether the array is empty.</td>
</tr>
<tr>
<td>RemoveAll</td>
<td>Removes all the elements from this array.</td>
</tr>
<tr>
<td>RemoveAt</td>
<td>Removes an element at a specific index.</td>
</tr>
<tr>
<td>SetAt</td>
<td>Sets the value for a given index; array not allowed to grow.</td>
</tr>
<tr>
<td>SetAtGrow</td>
<td>Sets the value for a given index; grows the array if necessary.</td>
</tr>
<tr>
<td>setSize</td>
<td>Sets the number of elements to be contained in this array.</td>
</tr>
</tbody>
</table>
Following are the different operations on CArray objects:

**Create CArray Object**

To create a collection of CArray values or objects, you must first decide the type of values of the collection. You can use one of the existing primitive data types such as int, CString, double etc. as shown below;

```cpp
CArray<CString, CString> strArray;
```

**Add items**

To add an item you can use CArray::Add() function. It adds an item at the end of the array. In theOnInitDialog(), CArray object is created and three names are added as shown in the following code.

```cpp
CArray<CString, CString> strArray;

//Add names to CArray
strArray.Add(L"Ali");
strArray.Add(L"Ahmed");
strArray.Add(L"Mark");
```

**Retrieve Items**

To retrieve any item, you can use the CArray::GetAt() function. This function takes one integer parameter as an index of the array.

**Step 1:** Let us look at a simple example, which will retrieve all the names.

```cpp
//Retrive names from CArray
    for (int i = 0; i < strArray.GetSize(); i++)
    {
        m_strText.Append(strArray.GetAt(i) + L"\n");
    }
```

**Step 2:** Here is the complete implementation of CMFCCArrayDlg::OnInitDialog()

```cpp
BOOL CMFCCArrayDlg::OnInitDialog()
{
    CDIalogEx::OnInitDialog();
}
// Set the icon for this dialog. The framework does this automatically
// when the application's main window is not a dialog
SetIcon(m_hIcon, TRUE);    // Set big icon
SetIcon(m_hIcon, FALSE);   // Set small icon

// TODO: Add extra initialization here
CArray<CString, CString> strArray;

// Add names to CArray
strArray.Add(L"Ali");
strArray.Add(L"Ahmed");
strArray.Add(L"Mark");

// Retrieve names from CArray
for (int i = 0; i < strArray.GetSize(); i++)
{
    m_strText.Append(strArray.GetAt(i) + L"\n");
}

UpdateData(FALSE);
return TRUE; // return TRUE unless you set the focus to a control
**Step 3:** When the above code is compiled and executed, you will see the following output.

![Dialog Output](image)

**Add Items in the Middle**

To add item in the middle of array you can use the CArray::InsertAt() function. It takes two parameters — First, the index and Second, the value.

Let us insert a new item at index 1 as shown in the following code.

```cpp
BOOL CMFCCArrayDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
   setIcon(m_hIcon, TRUE); // Set big icon
    SetIcon(m_hIcon, FALSE); // Set small icon

    // TODO: Add extra initialization here
    CArray<CString, CString> strArray;
```
// Add names to CArray
strArray.Add(L"Ali");
strArray.Add(L"Ahmed");
strArray.Add(L"Mark");

strArray.InsertAt(1, L"Allan");

// Retrive names from CArray
for (int i = 0; i < strArray.GetSize(); i++)
{
    m_strText.Append(strArray.GetAt(i) + L"\n");
}

UpdateData(FALSE);
return TRUE; // return TRUE unless you set the focus to a control
When the above code is compiled and executed, you will see the following output. You can now see the name Allan dded as the second index.

![Image of MFCCArray window with names Ali, Allan, Ahmed, and Mark]

**Update Item Value**

To update item in the middle of array you can use the CArray::SetAt() function. It takes two parameters — First, the index and Second, the value.

Let us update the third element in the array as shown in the following code.

```cpp
BOOL CMFCCArrayDlg::OnInitDialog()
{
    CDialoEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE); // Set big icon
    SetIcon(m_hIcon, FALSE); // Set small icon

    // TODO: Add extra initialization here
    CArray<CString, CString> strArray;
}
```
//Add names to CArray
strArray.Add(L"Ali");
strArray.Add(L"Ahmed");
strArray.Add(L"Mark");
strArray.InsertAt(1, L"Allan");
strArray.SetAt(2, L"Salman");

//Retrieve names from CArray
for (int i = 0; i < strArray.GetSize(); i++)
{
    m_strText.Append(strArray.GetAt(i) + L"
");
}

UpdateData(FALSE);
return TRUE; // return TRUE unless you set the focus to a control

When the above code is compiled and executed, you will see the following output. You can now see that the value of third element is updated.
Copy Array

To copy the entire array into another CArray object, you can use CArray::Copy() function.

**Step 1:** Let us create another array and copy all the elements from first array as shown in the following code.

```cpp
BOOL CMFCCArrayDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Add "About..." menu item to system menu.

    // IDM_ABOUTBOX must be in the system command range.
    ASSERT((IDM_ABOUTBOX & 0xFFF0) == IDM_ABOUTBOX);
    ASSERT(IDM_ABOUTBOX < 0xF000);
    CMenu* pSysMenu = GetSystemMenu(FALSE);
    if (pSysMenu != NULL)
    {
        BOOL bNameValid;
        CString strAboutMenu;
```
bNameValid = strAboutMenu.LoadString(IDS_ABOUTBOX);
ASSERT(bNameValid);
if (!strAboutMenu.IsEmpty())
{
    pSysMenu->AppendMenu(MF_SEPARATOR);
    pSysMenu->AppendMenu(MF_STRING, IDM_ABOUTBOX, strAboutMenu);
}

// Set the icon for this dialog. The framework does this automatically when the application's main window is not a dialog
SetIcon(m_hIcon, TRUE); // Set big icon
SetIcon(m_hIcon, FALSE); // Set small icon

// TODO: Add extra initialization here
CArray<CString, CString> strArray;
// Add names to CArray
strArray.Add(L"Ali");
strArray.Add(L"Ahmed");
strArray.Add(L"Mark");

strArray.InsertAt(1, L"Allan");
strArray.SetAt(2, L"Salman");

CArray<CString, CString> strArray2;
strArray2.Copy(strArray);
// Retrieve names from CArray
for (int i = 0; i < strArray2.GetSize(); i++)
{
    m_strText.Append(strArray2.GetAt(i) + L"\n");
}

UpdateData(FALSE);
return TRUE; // return TRUE unless you set the focus to a control
You can now see that we have retrieved element from the 2\textsuperscript{nd} array and the output is the same because we have used the copy function.

Remove Items

To remove any particular item, you can use CArray::RemoveAt() function. To remove all the element from the list, CArray::RemoveAll() function can be used.

Let us remove the second element from an array.

```cpp
BOOL CMFCCArrayDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    SetIcon(m_hIcon, TRUE); // Set big icon
    SetIcon(m_hIcon, FALSE); // Set small icon

    // TODO: Add extra initialization here
    CArray<CString, CString> strArray;

    // Add names to CArray
```
strArray.Add(L"Ali");
strArray.Add(L"Ahmed");
strArray.Add(L"Mark");

strArray.InsertAt(1, L"Allan");

strArray.SetAt(2, L"Salman");

CArray<CString, CString> strArray2;
strArray2.Copy(strArray);

strArray2.RemoveAt(1);

// Retrive names from CArray
for (int i = 0; i < strArray2.GetSize(); i++)
{
    m_strText.Append(strArray2.GetAt(i) + L"\n");
}

UpdateData(FALSE);
return TRUE; // return TRUE unless you set the focus to a control
When the above code is compiled and executed, you will see the following output. You can now see that the name Allan is no longer part of the array.
A **linked list** is a linear data structure where each element is a separate object. Each element (we will call it a node) of a list comprises two items — the data and a reference to the next node. The last node has a reference to null.

A linked list is a data structure consisting of a group of nodes which together represent a sequence. It is a way to store data with structures so that the programmer can automatically create a new place to store data whenever necessary. Some of its salient features are:

- Linked List is a sequence of links which contains items.
- Each link contains a connection to another link.
- Each item in the list is called a node.
- If the list contains at least one node, then a new node is positioned as the last element in the list.
- If the list has only one node, that node represents the first and the last item.

There are two types of link list:

**Singly Linked List**

Singly Linked Lists are a type of data structure. In a singly linked list, each node in the list stores the contents of the node and a pointer or reference to the next node in the list.

![Singly Linked List Diagram](image)

**Doubly Linked List**

A doubly linked list is a linked data structure that consists of a set of sequentially linked records called nodes. Each node contains two fields that are references to the previous and to the next node in the sequence of nodes.
**CList Class**

MFC provides a class `CList` which is a template linked list implementation and works perfectly. CList lists behave like doubly-linked lists. A variable of type POSITION is a key for the list. You can use a POSITION variable as an iterator to traverse a list sequentially and as a bookmark to hold a place.

Here is the list of methods in CList class.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AddHead</td>
<td>Adds an element (or all the elements in another list) to the head of the list (makes a new head).</td>
</tr>
<tr>
<td>AddTail</td>
<td>Adds an element (or all the elements in another list) to the tail of the list (makes a new tail).</td>
</tr>
<tr>
<td>Find</td>
<td>Gets the position of an element specified by pointer value.</td>
</tr>
<tr>
<td>FindIndex</td>
<td>Gets the position of an element specified by a zero-based index.</td>
</tr>
<tr>
<td>GetAt</td>
<td>Gets the element at a given position.</td>
</tr>
<tr>
<td>GetCount</td>
<td>Returns the number of elements in this list.</td>
</tr>
<tr>
<td>GetHead</td>
<td>Returns the head element of the list (cannot be empty).</td>
</tr>
<tr>
<td>GetHeadPosition</td>
<td>Returns the position of the head element of the list.</td>
</tr>
<tr>
<td>GetNext</td>
<td>Gets the next element for iterating.</td>
</tr>
<tr>
<td>GetPrev</td>
<td>Gets the previous element for iterating.</td>
</tr>
<tr>
<td>GetSize</td>
<td>Returns the number of elements in this list.</td>
</tr>
<tr>
<td>GetTail</td>
<td>Returns the tail element of the list (cannot be empty).</td>
</tr>
<tr>
<td>GetTailPosition</td>
<td>Returns the position of the tail element of the list.</td>
</tr>
<tr>
<td>InsertAfter</td>
<td>Inserts a new element after a given position.</td>
</tr>
<tr>
<td>InsertBefore</td>
<td>Inserts a new element before a given position.</td>
</tr>
<tr>
<td>IsEmpty</td>
<td>Tests for the empty list condition (no elements).</td>
</tr>
<tr>
<td>RemoveAll</td>
<td>Removes all the elements from this list.</td>
</tr>
<tr>
<td>RemoveAt</td>
<td>Removes an element from this list, specified by position.</td>
</tr>
<tr>
<td>RemoveHead</td>
<td>Removes the element from the head of the list.</td>
</tr>
<tr>
<td>RemoveTail</td>
<td>Removes the element from the tail of the list.</td>
</tr>
<tr>
<td>SetAt</td>
<td>Sets the element at a given position.</td>
</tr>
</tbody>
</table>
Following are the different operations on CList objects:

**Create CList Object**

To create a collection of CList values or objects, you must first decide the type of values of the collection. You can use one of the existing primitive data types such as int, CString, double etc. as shown below in the following code.

```cpp
CList<double, double> m_list;
```

**Add items**

To add an item, you can use CList::AddTail() function. It adds an item at the end of the list. To add an element at the start of the list, you can use the CList::AddHead() function. In the OnInitDialog() CList, object is created and four values are added as shown in the following code.

```cpp
CList<double, double> m_list;

// Add items to the list
m_list.AddTail(100.75);
m_list.AddTail(85.26);
m_list.AddTail(95.78);
m_list.AddTail(90.1);
```

**Retrieve Items**

A variable of type POSITION is a key for the list. You can use a POSITION variable as an iterator to traverse a list sequentially.

**Step 1:** To retrieve the element from the list, we can use the following code which will retrieve all the values.

```cpp
// iterate the list
POSITION pos = m_list.GetHeadPosition();
while (pos)
{
    double nData = m_list.GetNext(pos);
    CString strVal;
    strVal.Format(L"%.2f\n", nData);
    m_strText.Append(strVal);
}
```
Step 2: Here is the complete CMFCCListDemoDlg::OnInitDialog() function.

```cpp
BOOL CMFCCListDemoDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);    // Set big icon
    SetIcon(m_hIcon, FALSE);   // Set small icon

    // TODO: Add extra initialization here
    CList<double, double> m_list;

    // Add items to the list
    m_list.AddTail(100.75);
    m_list.AddTail(85.26);
    m_list.AddTail(95.78);
    m_list.AddTail(90.1);

    // Iterate the list
    POSITION pos = m_list.GetHeadPosition();
    while (pos)
    {
        double nData = m_list.GetNext(pos);
        CString strVal;
        strVal.Format(_T("%.f\n"), nData);
        m_strText.Append(strVal);
    }
    UpdateData(FALSE);

    return TRUE;  // return TRUE unless you set the focus to a control
}
```
Step 3: When the above code is compiled and executed, you will see the following output.

Add Items in the Middle

To add item in the middle of the list, you can use the CList::InsertAfter() and CList::InsertBefore() functions. It takes two parameters — First, the position (where it can be added) and Second, the value.

Step 1: Let us insert a new item as shown in the following code.

```cpp
BOOL CMFCCListDemoDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);     // Set big icon
    SetIcon(m_hIcon, FALSE);    // Set small icon

    // TODO: Add extra initialization here
```
CList<double, double> m_list;

//Add items to the list
m_list.AddTail(100.75);
m_list.AddTail(85.26);
m_list.AddTail(95.78);
m_list.AddTail(90.1);

POSITION position = m_list.Find(85.26);
m_list.InsertBefore(position, 200.0);
m_list.InsertAfter(position, 300.0);

//iterate the list
POSITION pos = m_list.GetHeadPosition();
while (pos)
{
    double nData = m_list.GetNext(pos);
    CString strVal;
    strVal.Format(L"%.2f\n", nData);
    m_strText.Append(strVal);
}
UpdateData(FALSE);

return TRUE; // return TRUE unless you set the focus to a control

Step 2: You can now see see that we first retrieved the position of value 85.26 and then inserted one element before and one element after that value.
**Step 3:** When the above code is compiled and executed, you will see the following output.

![Output Image]

**Update Item Value**

To update item at the middle of array, you can use the CArray::SetAt() function. It takes two parameters — First, the position and Second, the value.

Let us update the 300.00 to 400 in the list as shown in the following code.

```cpp
BOOL CMFCCListDemoDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);    // Set big icon
    SetIcon(m_hIcon, FALSE);   // Set small icon

    // TODO: Add extra initialization here
    Clist<double, double> m_list;
}
// Add items to the list
m_list.AddTail(100.75);
m_list.AddTail(85.26);
m_list.AddTail(95.78);
m_list.AddTail(90.1);

POSITION position = m_list.Find(85.26);
m_list.InsertBefore(position, 200.0);
m_list.InsertAfter(position, 300.0);

position = m_list.Find(300.00);
m_list.SetAt(position, 400.00);

// iterate the list
POSITION pos = m_list.GetHeadPosition();
while (pos)
{
    double nData = m_list.GetNext(pos);
    CString strVal;
    strVal.Format(L"%.2f\n", nData);
    m_strText.Append(strVal);
}
UpdateData(FALSE);

return TRUE; // return TRUE unless you set the focus to a control
When the above code is compiled and executed, you will see the following output. You can now see that the value of 300.00 is updated to 400.00.

Remove Items

To remove any particular item, you can use CList::RemoveAt() function. To remove all the element from the list, CList::RemoveAll() function can be used.

Let us remove the element, which has 95.78 as its value.

```cpp
BOOL CMFCListDemoDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);          // Set big icon
    SetIcon(m_hIcon, FALSE);        // Set small icon

    // TODO: Add extra initialization here
    CList<double, double> m_list;
```
// Add items to the list
m_list.AddTail(100.75);
m_list.AddTail(85.26);
m_list.AddTail(97.78);
m_list.AddTail(90.1);

POSITION position = m_list.Find(85.26);
m_list.InsertBefore(position, 200.0);
m_list.InsertAfter(position, 300.0);

position = m_list.Find(300.00);
m_list.SetAt(position, 400.00);

position = m_list.Find(95.78);
m_list.RemoveAt(position);

// Iterate the list
POSITION pos = m_list.GetHeadPosition();
while (pos)
{
    double nData = m_list.GetNext(pos);
    CString strVal;
    strVal.Format(L"%.2f\n", nData);
    m_strText.Append(strVal);
}

UpdateData(FALSE);

return TRUE; // return TRUE unless you set the focus to a control

When the above code is compiled and executed, you will see the following output. You can now see that the value of 95.78 is no longer part of the list.
100.75
200.00
85.26
400.00
90.10
A **database** is a collection of information that is organized so that it can easily be accessed, managed, and updated. The MFC database classes based on ODBC are designed to provide access to any database for which an ODBC driver is available. Because the classes use ODBC, your application can access data in many different data formats and different local/remote configurations.

You do not have to write special-case code to handle different database management systems (DBMSs). As long as your users have an appropriate ODBC driver for the data they want to access, they can use your program to manipulate data in tables stored there. A data source is a specific instance of data hosted by some database management system (DBMS). Examples include Microsoft SQL Server, Microsoft Access, etc.

## CDatabase

MFC provides a class **CDatabase** which represents a connection to a data source, through which you can operate on the data source. You can have one or more CDatabase objects active at a time in your application.

Here is the list of methods in CDatabase class.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BeginTrans</td>
<td>Starts a &quot;transaction&quot; — a series of reversible calls to the AddNew, Edit, Delete, and Update member functions of class CRecordset — on the connected data source. The data source must support transactions for BeginTrans to have any effect.</td>
</tr>
<tr>
<td>BindParameters</td>
<td>Allows you to bind parameters before calling ExecuteSQL.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels an asynchronous operation or a process from a second thread.</td>
</tr>
<tr>
<td>CanTransact</td>
<td>Returns nonzero if the data source supports transactions.</td>
</tr>
<tr>
<td>CanUpdate</td>
<td>Returns nonzero if the CDatabase object is updatable (not read-only).</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the data source connection.</td>
</tr>
<tr>
<td>CommitTrans</td>
<td>Completes a transaction begun by BeginTrans. Commands in the transaction that alter the data source are carried out.</td>
</tr>
<tr>
<td>ExecuteSQL</td>
<td>Executes a SQL statement. No data records are returned.</td>
</tr>
<tr>
<td>GetBookmarkPersistence</td>
<td>Identifies the operations through which bookmarks persist on recordset objects.</td>
</tr>
<tr>
<td>GetConnect</td>
<td>Returns the ODBC connection string used to connect the CDatabase object to a data source.</td>
</tr>
<tr>
<td>GetCursorCommitBehavior</td>
<td>Identifies the effect of committing a transaction on an open recordset object.</td>
</tr>
<tr>
<td>GetCursorRollbackBehavior</td>
<td>Identifies the effect of rolling back a transaction on an open recordset object.</td>
</tr>
<tr>
<td>GetDatabaseName</td>
<td>Returns the name of the database currently in use.</td>
</tr>
<tr>
<td>IsOpen</td>
<td>Returns nonzero if the CDatabase object is currently connected to a data source.</td>
</tr>
</tbody>
</table>
OnSetOptions

Called by the framework to set standard connection options. The default implementation sets the query timeout value. You can establish these options ahead of time by calling SetQueryTimeout.

Open

Establishes a connection to a data source (through an ODBC driver).

OpenEx

Establishes a connection to a data source (through an ODBC driver).

Rollback

Reverses changes made during the current transaction. The data source returns to its previous state, as defined at the BeginTrans call, unaltered.

SetLoginTimeout

Sets the number of seconds after which a data source connection attempt will time out.

SetQueryTimeout

Sets the number of seconds after which database query operations will time out. Affects all subsequent recordset Open, AddNew, Edit, and Delete calls.

Let us look into a simple example by creating a new MFC dialog based application.

Step 1: Change the caption of TODO line to Retrieve Data from Database and drag one button and one List control as shown in the following snapshot.

Step 2: Add click event handler for button and control variable m_ListControl for List Control.
**Step 3:** We have simple database which contains one Employees table with some records as shown in the following snapshot.

![Employee Table Snapshot](image)

**Step 4:** We need to include the following headers file so that we can use CDatabase class.

```cpp
#include "odbcinst.h"
#include "afxdb.h"
```

**Insert Query**

The SQL INSERT INTO Statement is used to add new rows of data to a table in the database.

To add new records, we will use the `ExecuteSQL()` function of CDatabase class as shown in the following code.

```cpp
CDatabase database;
CString SqlString;
CString strID, strName, strAge;
CString sDriver = L"MICROSOFT ACCESS DRIVER (*.mdb)";
CString sDsn;
CString sFile = L"D:\Test.mdb";
```
// You must change above path if it's different
int iRec = 0;

// Build ODBC connection string
sDsn.Format(L"ODBC;DRIVER={%s};DSN='';DBQ=%s", sDriver, sFile);
TRY
{
    // Open the database
    database.Open(NULL, false, false, sDsn);

    SqlString = L"INSERT INTO Employees (ID,Name,age) VALUES (5,'Sanjay',69)";
database.ExecuteSQL(SqlString);
    // Close the database
database.Close();
}
CATCH(CDBException, e)
{
    // If a database exception occurred, show error msg
    AfxMessageBox(L"Database error: " + e->m_strError);
}
END_CATCH;
Step 2: When the above code is compiled and executed, you will see that a new record is added in your database.

Retrieve Record

To retrieve the above table in MFC application, we implement the database related operations in the button event handler as shown in the following steps.

Step 1: To use CDatabase, construct a CDatabase object and call its Open() function. This will open the connection.

Step 2: Construct CRecordset objects for operating on the connected data source, pass the recordset constructor a pointer to your CDatabase object.

Step 3: After using the connection, call the Close function and destroy the CDatabase object.

```cpp
void CMFCDatabaseDemoDlg::OnBnClickedButtonRead()
{
    // TODO: Add your control notification handler code here
    CDatabase database;
    CString SqlString;
    CString strID, strName, strAge;
    CString sDriver = "MICROSOFT ACCESS DRIVER (*.mdb)";
```
CString sDsn;
CString sFile = L"D:\\Test.mdb";
// You must change above path if it's different
int iRec = 0;

// Build ODBC connection string
sDsn.Format("ODBC;DRIVER=%s;DSN='';DBQ=%s", sDriver, sFile);
TRY
{
    // Open the database
database.Open(NULL, false, false, sDsn);

    // Allocate the recordset
CRecordset recset( &database );

    // Build the SQL statement
SqlString = "SELECT ID, Name, Age 
    "FROM Employees";

    // Execute the query
recset.Open(CRecordset::forwardOnly, SqlString, CRecordset::readOnly);
    // Reset List control if there is any data
ResetListControl();
    // populate Grids
ListView_SetExtendedListViewStyle(m_ListControl, LVS_EX_GRIDLINES);

    // Column width and heading
m_ListControl.InsertColumn(0, "Emp ID", LVCFMT_LEFT, -1, 0);
m_ListControl.InsertColumn(1, "Name", LVCFMT_LEFT, -1, 1);
m_ListControl.InsertColumn(2, "Age", LVCFMT_LEFT, -1, 1);
m_ListControl.SetColumnWidth(0, 120);
m_ListControl.SetColumnWidth(1, 200);
m_ListControl.SetColumnWidth(2, 200);

    // Loop through each record
while( !recset.IsEOF() )
{

// Copy each column into a variable
recset.GetFieldValue("ID",strID);
recset.GetFieldValue("Name",strName);
recset.GetFieldValue("Age", strAge);

// Insert values into the list control
iRec = m_ListControl.InsertItem(0,strID,0);
m_ListControl.SetItemText(0,1,strName);
m_ListControl.SetItemText(0, 2, strAge);

// goto next record
recset.MoveNext();
}

// Close the database
database.Close();
}
CATCH(CDBException, e)
{
    // If a database exception occurred, show error msg
    AfxMessageBox("Database error: "+e->m_strError);
}
END_CATCH;

// Reset List control
void CMFCDatabaseDemoDlg::ResetListControl()
{
    m_ListControl.DeleteAllItems();
    int iNbrOfColumns;
    CHeaderCtrl* pHeader = (CHeaderCtrl*)m_ListControl.GetDlgItem(0);
    if (pHeader)
    {
        iNbrOfColumns = pHeader->GetItemCount();
    }
    for (int i = iNbrOfColumns; i >= 0; i--)
    {
        m_ListControl.DeleteColumn(i);
    }
}
**Step 4:** Here is the header file.

```cpp
// MFCDatabaseDemoDlg.h : header file

#pragma once
#include "afxcmn.h"

// CMFCDatabaseDemoDlg dialog
class CMFCDatabaseDemoDlg : public CDialogEx
{
    // Construction
    public:
        CMFCDatabaseDemoDlg(CWnd* pParent = NULL); // standard constructor

    // Dialog Data
    #ifdef AFX_DESIGN_TIME
        enum { IDD = IDD_MFCDATABASEDEMO_DIALOG };  
    #endif

        protected:
            virtual void DoDataExchange(CDataExchange* pDX); // DDX/DDV support
            void ResetListControl();

    // Implementation
    protected:
        HICON m_hIcon;

        // Generated message map functions
        virtual BOOL OnInitDialog();
        afx_msg void OnPaint();
        afx_msg HCURSOR OnQueryDragIcon();
        DECLARE_MESSAGE_MAP()

    public:
        CListCtrl m_ListControl;
        afx_msg void OnBnClickedButtonRead();
};
```
**Step 5:** When the above code is compiled and executed, you will see the following output.

![Screenshot of MFCDatabaseDemo window](image)

**Step 6:** Press the Read button to execute the database operations. It will retrieve the Employees table.
Update Record

The SQL UPDATE Query is used to modify the existing records in a table. You can use WHERE clause with UPDATE query to update selected rows otherwise all the rows would be affected.

**Step 1:** Let us look into a simple example by updating the Age where ID is equal to 5.

```sql
SqlString = L"UPDATE Employees SET Age = 59 WHERE ID = 5;"
database.ExecuteSQL(SqlString);
```

**Step 2:** Here is the complete code of button click event.

```cpp
void CMFCDatabaseDemoDlg::OnBnClickedButtonRead()
{
    // TODO: Add your control notification handler code here
    CDatabase database;
    CString SqlString;
    CString strID, strName, strAge;
    CString sDriver = L"MICROSOFT ACCESS DRIVER (*.mdb)";
    CString sDsn;
    CString sFile = L"C:\Users\Muhammad.Waqas\Downloads\Compressed\ReadDB_demo\Test.mdb";
    // You must change above path if it's different
```
int iRec = 0;

// Build ODBC connection string
sDsn.Format(L"ODBC;DRIVER={%s};DSN='';DBQ=%s", sDriver, sFile);
TRY
{
    // Open the database
database.Open(NULL,false,false,sDsn);

    // Allocate the recordset
    CRecordset recset(&database);

    strSql = L"UPDATE Employees SET Age = 59 WHERE ID = 5;";
    database.ExecuteSQL(strSql);

    strSql = L"SELECT ID, Name, Age FROM Employees";

    // Build the SQL statement
    strSql = L"SELECT ID, Name, Age FROM Employees";

    // Execute the query
    recset.Open(CRecordset::forwardOnly,strSql,CRecordset::readOnly);

    // Reset List control if there is any data
    ResetListControl();

    // populate Grids
    ListView_SetExtendedListViewStyle(m_listCtrl,LVS_EX_GRIDLINES);

    // Column width and heading
    m_listCtrl.InsertColumn(0,L"Emp ID",LVCFMT_LEFT,-1,0);
    m_listCtrl.InsertColumn(1,L"Name",LVCFMT_LEFT,-1,1);
    m_listCtrl.InsertColumn(2, L"Age", LVCFMT_LEFT, -1, 1);
    m_listCtrl.SetColumnWidth(0, 120);
    m_listCtrl.SetColumnWidth(1, 200);
m_listCtrl.SetColumnWidth(2, 200);

// Loop through each record
while(!recset.IsEOF())
{
   // Copy each column into a variable
   recset.GetFieldValue(L"ID",strID);
   recset.GetFieldValue(L"Name",strName);
   recset.GetFieldValue(L"Age", strAge);

   // Insert values into the list control
   iRec = m_listCtrlInsertItem(0,strID,0);
   m_listCtrl.SetText(0,1,strName);
   m_listCtrl.SetText(0, 2, strAge);

   // goto next record
   recset.MoveNext();
}
// Close the database
database.Close();

CATCH(CDBException, e)
{
   // If a database exception occured, show error msg
   AfxMessageBox(L"Database error: " + e->m_strError);
}
END_CATCH;

**Step 3:** When the above code is compiled and executed, you will see the following output.
**Step 4:** Press the Read button to execute the database operations. It will retrieve the following Employees table.
Step 5: You can now see that age is updated from 69 to 59.

Delete Record

The SQL DELETE Query is used to delete the existing records from a table. You can use WHERE clause with DELETE query to delete selected rows, otherwise all the records would be deleted.

Step 1: Let us look into a simple example by deleting the record where ID is equal to 3.

```sql
CString strSql = L"DELETE FROM Employees WHERE ID = 3;";

database.ExecuteSQL strSql;
```

Step 2: Here is the complete code of button click event.

```cpp
void CMFCDatabaseDemoDlg::OnBnClickedButtonRead()
{
    // TODO: Add your control notification handler code here
    CDatabase database;
    CString strSql;
```
CString strID, strName, strAge;
CString sDriver = L"MICROSOFT ACCESS DRIVER (*.mdb)";
CString sDsn;
CString sFile = L"C:\\Users\\Muhammad.Waqas\\Downloads\\Compressed\\ReadDB_demo\\Test.mdb";
// You must change above path if it's different
int iRec = 0;

// Build ODBC connection string
sDsn.Format(L"ODBC;DRIVER={%s};DSN='';DBQ=%s", sDriver, sFile);
TRY
{
    // Open the database
database.Open(NULL, false, false, sDsn);

    // Allocate the recordset
    CRecordset recset(&database);

    strSql = L"DELETE FROM Employees WHERE ID = 3;";
    database.ExecuteSQL(strSql);

    strSql = L"SELECT ID, Name, Age FROM Employees";

    // Build the SQL statement
    strSql = L"SELECT ID, Name, Age FROM Employees";

    // Execute the query
    recset.Open(CRecordset::forwardOnly, strSql, CRecordset::readOnly);

    // Reset List control if there is any data
    ResetLlistControl();
    // populate Grids
    ListView_SetExtendedListViewStyle(m_listCtrl, LVS_EX_GRIDLINES);
// Column width and heading
m_listCtrl.InsertColumn(0, L"Emp ID", LVCFMT_LEFT, -1, 0);
m_listCtrl.InsertColumn(1, L"Name", LVCFMT_LEFT, -1, 1);
m_listCtrl.InsertColumn(2, L"Age", LVCFMT_LEFT, -1, 1);
m_listCtrl.SetColumnWidth(0, 120);
m_listCtrl.SetColumnWidth(1, 200);
m_listCtrl.SetColumnWidth(2, 200);

// Loop through each record
while (!recset.IsEOF()) {
    // Copy each column into a variable
    recset.GetFieldValue(L"ID", strID);
    recset.GetFieldValue(L"Name", strName);
    recset.GetFieldValue(L"Age", strAge);

    // Insert values into the list control
    iRec = m_listCtrl.InsertItem(0, strID, 0);
    m_listCtrl.SetItemText(0, 1, strName);
    m_listCtrl.SetItemText(0, 2, strAge);

    // goto next record
    recset.MoveNext();
}

// Close the database
database.Close();

CATCH(CDBException, e) {
    // If a database exception occurred, show error msg
    AfxMessageBox(L"Database error: " + e->m_strError);
}

END_CATCH;
**Step 3:** When the above code is compiled and executed, you will see the following output.

![Image of MFCDatabaseDemo window](image)

**Step 4:** Press the Read button to execute the database operations. It will retrieve the Employees table.
<table>
<thead>
<tr>
<th>Emp ID</th>
<th>Name</th>
<th>Age</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Ahmed</td>
<td>37</td>
</tr>
<tr>
<td>2</td>
<td>Allan</td>
<td>33</td>
</tr>
<tr>
<td>5</td>
<td>Sanjay</td>
<td>59</td>
</tr>
<tr>
<td>1</td>
<td>Mark</td>
<td>29</td>
</tr>
</tbody>
</table>
Serialization is the process of writing or reading an object to or from a persistent storage medium such as a disk file. Serialization is ideal for situations where it is desired to maintain the state of structured data (such as C++ classes or structures) during or after the execution of a program.

When performing file processing, the values are typically of primitive types (char, short, int, float, or double). In the same way, we can individually save many values, one at a time. This technique doesn't include an object created from (as a variable of) a class.

The MFC library has a high level of support for serialization. It starts with the CObject class that is the ancestor to most MFC classes, which is equipped with a Serialize() member function.

Let us look into a simple example by creating a new MFC project.

**Step 1:** Remove the TODO line and design your dialog box as shown in the following snapshot.
**Step 2:** Add value variables for all the edit controls. For Emp ID and Age mentioned, the value type is an integer as shown in the following snapshot.

**Step 3:** Add the event handler for both the buttons.

**Step 4:** Let us now add a simple Employee class, which we need to serialize. Here is the declaration of Employee class in header file.

```cpp
class CEmployee : public CObject
{
public:
    int empID;
    CString empName;
    int age;
    CEmployee(void);
    ~CEmployee(void);
private:

public:
    void Serialize(CArchive& ar);
    DECLARE_SERIAL(CEmployee);
};
```
**Step 5:** Here is the definition of Employee class in source (*.cpp) file.

```
IMPLEMENT_SERIAL(CEmployee, CObject, 0)
CEmployee::CEmployee(void)
{
}
CEmployee::~CEmployee(void)
{
}

void CEmployee::Serialize(CArchive& ar)
{
    CObject::Serialize(ar);

    if (ar.IsStoring())
        ar << empID << empName << age;
    else
        ar >> empID >> empName >> age;
}
```

**Step 6:** Here is the implementation of Save button event handler.

```
void CMFCSerializationDlg::OnBnClickedButtonSave()
{
    // TODO: Add your control notification handler code here
    UpdateData(TRUE);
    CEmployee employee;
    CFile file;
    file.Open(L"EmployeeInfo.hse", CFile::modeCreate | CFile::modeWrite);
    CArchive ar(&file, CArchive::store);
    employee.empID = m_id;
    employee.empName = m_strName;
    employee.age = m_age;
    employee.Serialize(ar);
    ar.Close();
}
Step 7: Here is the implementation of Open button event handler.

```cpp
void CMFCSerializationDlg::OnBnClickedButtonOpen()
{
    // TODO: Add your control notification handler code here
    UpdateData(TRUE);

    CFile file;
    file.Open(L"EmployeeInfo.hse", CFile::modeRead);
    CArchive ar(&file, CArchive::load);
    CEmployee employee;

    employee.Serialize(ar);

    m_id = employee.empID;
    m_strName = employee.empName;
    m_age = employee.age;
    ar.Close();
    file.Close();

    UpdateData(FALSE);
}
```
Step 8: When the above code is compiled and executed, you will see the following output.

![Image of MFCSerialization dialog box]

Step 9: Enter the info in all the fields and click Save and close this program.
Step 10: It will save the data. Run the application again and click open. It will load the Employee information.
The Microsoft Foundation Class (MFC) library provides support for multithreaded applications. A thread is a path of execution within a process. When you start Notepad, the operating system creates a process and begins executing the primary thread of that process. When this thread terminates, so does the process.

You can create additional threads in your application if you want. All threads in MFC applications are represented by CWinThread objects. In most situations, you do not even have to explicitly create these objects; instead call the framework helper function AfxBeginThread, which creates the CWinThread object for you.

Let us look into a simple example by creating a new MFC dialog based application.

**Step 1:** Change the Caption and ID of Static control to **Click on Start Thread button** and **IDC_STATIC_TEXT** respectively.

**Step 2:** Drag two buttons and add click event handlers for these buttons.

**Step 3:** Add control variable for static text control.
**Step 4:** Now add the following three global variables at the start of CMFCMultithreadingDlg.cpp file

```cpp
int currValue;
int maxValue;
BOOL stopNow;
```

**Step 5:** Add the WM_TIMER message in CMFCMultithreadingDlg class.

Here is the implementation of OnTimer()

```cpp
void CMFCMultithreadingDlg::OnTimer(UINT_PTR nIDEvent)
{
    // TODO: Add your message handler code here and/or call default
    CString sStatusMsg;
    sStatusMsg.Format(L"Running: %d", currValue);
    m_ctrlStatus.SetWindowText(sStatusMsg);

    CDialogEx::OnTimer(nIDEvent);
}
```

**Step 6:** Now add a sample function for using in AfxBeginThread in CMFCMultithreadingDlg class.

```cpp
UINT MyThreadProc(LPVOID Param)
{
    while (!stopNow && (currValue < maxValue))
    {
        currValue++;
        Sleep(50); // would do some work here
    }

    return TRUE;
}
```

**Step 7:** Here is the implementation of event handler for Start Thread button, which will start the thread.

```cpp
void CMFCMultithreadingDlg::OnBnClickedButtonStart()
```
{  
    // TODO: Add your control notification handler code here  
    currValue = 0;  
    maxValue = 5000;  
    stopNow = 0;  
    m_ctrlStatus.SetWindowText(L"Starting...");  
    SetTimer(1234, 333, 0); // 3 times per second  

    AfxBeginThread(MyThreadProc, 0); // <<== START THE THREAD
}

**Step 8:** Here is the implementation of event handler for Stop Thread button, which will stop the thread.

```cpp
void CMFCMultithreadingDlg::OnBnClickedButtonStop()
{
    // TODO: Add your control notification handler code here
    stopNow = TRUE;  
    KillTimer(1234);  
    m_ctrlStatus.SetWindowText(L"Stopped");  
}
```

**Step 9:** Here is the complete source file.

```cpp
// MFCMultithreadingDlg.cpp : implementation file
//  
#include "stdafx.h"  
#include "MFCMultithreading.h"  
#include "MFCMultithreadingDlg.h"  
#include "afxdialogex.h"

#ifdef _DEBUG
#define new DEBUG_NEW
#endif
```
// CMFCMultithreadingDlg dialog

int currValue;
int maxValue;
BOOL stopNow;

CMFCMultithreadingDlg::CMFCMultithreadingDlg(CWnd* pParent /*=NULL*/)
    : CDialogEx(IDD_MFCMULTITHREADING_DIALOG, pParent)
{
    m_hIcon = AfxGetApp()->LoadIcon(IDR_MAINFRAME);
}

void CMFCMultithreadingDlg::DoDataExchange(CDataExchange* pDX)
{
    CDialogEx::DoDataExchange(pDX);
    DDX_Control(pDX, IDC_STATIC_TEXT, m_ctrlStatus);
}

BEGIN_MESSAGE_MAP(CMFCMultithreadingDlg, CDialogEx)
    ON_WM_PAINT()
    ON_WM_QUERYDRAGICON()
    ON_BN_CLICKED(IDC_BUTTON_START,
        &CMFCMultithreadingDlg::OnBnClickedButtonStart)
    ON_WM_TIMER()
    ON_BN_CLICKED(IDC_BUTTON_STOP,
        &CMFCMultithreadingDlg::OnBnClickedButtonStop)
END_MESSAGE_MAP()

// CMFCMultithreadingDlg message handlers

BOOL CMFCMultithreadingDlg::OnInitDialog()
{
    CDialogEx::OnInitDialog();

    // Set the icon for this dialog. The framework does this automatically
    // when the application's main window is not a dialog
    SetIcon(m_hIcon, TRUE);          // Set big icon
SetIcon(m_hIcon, FALSE); // Set small icon

// TODO: Add extra initialization here

return TRUE; // return TRUE unless you set the focus to a control

// If you add a minimize button to your dialog, you will need the code below
// to draw the icon. For MFC applications using the document/view model,
// this is automatically done for you by the framework.

void CMFCMultithreadingDlg::OnPaint()
{
    if (IsIconic())
    {
        CPaintDC dc(this); // device context for painting

        SendMessage(WM_ICONERASEBKGND,
                    reinterpret_cast<WPARAM>(dc.GetSafeHdc()), 0);

        // Center icon in client rectangle
        int cxIcon = GetSystemMetrics(SM_CXICON);
        int cyIcon = GetSystemMetrics(SM_CYICON);
        CRect rect;
        GetClientRect(&rect);
        int x = (rect.Width() - cxIcon + 1) / 2;
        int y = (rect.Height() - cyIcon + 1) / 2;

        // Draw the icon
        dc.DrawIcon(x, y, m_hIcon);
    }
    else
    {
        CDialogEx::OnPaint();
    }
}
// The system calls this function to obtain the cursor to display while the
// user drags
// the minimized window.
HCURSOR CMFCMultithreadingDlg::OnQueryDragIcon()
{
    return static_cast<HCURSOR>(m_hIcon);
}

UINT /*CThreadDlg::*MyThreadProc(LPVOID Param) //Sample function for using in
AfxBeginThread
{
    while (!stopNow && (currValue < maxValue))
    {
        currValue++;
        Sleep(50); // would do some work here
    }

    return TRUE;
}

void CMFCMultithreadingDlg::OnClickedButtonStart()
{
    // TODO: Add your control notification handler code here
    currValue = 0;
    maxValue = 5000;
    stopNow = 0;
    m_ctrlStatus.SetWindowText(L"Starting...");
    SetTimer(1234, 333, 0); // 3 times per second

    AfxBeginThread(MyThreadProc, 0); // == START THE THREAD
}

void CMFCMultithreadingDlg::OnTimer(UINT_PTR nIDEvent)
{
    // TODO: Add your message handler code here and/or call default
    CString sStatusMsg;
    sStatusMsg.Format(L"Running: %d", currValue);
m_ctrlStatus.SetWindowText(sStatusMsg);

CDialogEx::OnTimer(nIDEvent);
}

void CMFCMultithreadingDlg::OnBnClickedButtonStop()
{
    // TODO: Add your control notification handler code here
    stopNow = TRUE;
    KillTimer(1234);
    m_ctrlStatus.SetWindowText(L"Stopped");
}

**Step 10:** When the above code is compiled and executed, you will see the following output.

![Image](image_url)

**Step 11:** Now click on Start Thread button.
Step 12: Click the Stop Thread button. It will stop the thread.
Microsoft provides many APIs for programming both client and server applications. Many new applications are being written for the Internet, and as technologies, browser capabilities, and security options change, new types of applications will be written. Your custom application can retrieve information and provide data on the Internet.

MFC provides a class `CSocket` for writing network communications programs with Windows Sockets.

Here is a list of methods in CSocket class.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attach</td>
<td>Attaches a SOCKET handle to a CSocket object.</td>
</tr>
<tr>
<td>CancelBlockingCall</td>
<td>Cancels a blocking call that is currently in progress.</td>
</tr>
<tr>
<td>Create</td>
<td>Creates a socket.</td>
</tr>
<tr>
<td>FromHandle</td>
<td>Returns a pointer to a CSocket object, given a SOCKET handle.</td>
</tr>
<tr>
<td>IsBlocking</td>
<td>Determines whether a blocking call is in progress.</td>
</tr>
</tbody>
</table>

Let us look into a simple example by creating a MFS SDI application.
**Step 1:** Enter MFCServer in the name field and click OK.

![Advanced Features](image)

**Step 2:** On Advanced Features tab, check the Windows sockets option.

**Step 3:** Once the project is created, add a new MFC class CServerSocket.
Step 4: Select the CSocket as base class and click Finish.
Step 5: Add more MFC class CReceivingSocket.

Step 6: CReceivingSocket will receive incoming messages from client.

In CMFCServerApp, the header file includes the following files:

```c
#include "ServerSocket.h"
#include "MFCServerView.h"
```

Step 7: Add the following two class variables in CMFCServerApp class.

```c
CServerSocket m_serverSocket;
CMFCServerView m_pServerView;
```

Step 8: In CMFCServerApp::OnInitInstance() method, create the socket and specify the port and then call the Listen method as shown below.

```c
m_serverSocket.Create(6666);
m_serverSocket.Listen();
```
**Step 9:** Include the following header file in CMFCServerView header file.

```cpp
#include "MFCServerDoc.h"
```

**Step 10:** Override the OnAccept function from Socket class.

**Step 11:** Select CServerSocket in class view and the highlighted icon in Properties window. Now, Add OnAccept. Here is the implementation of OnAccept function.

```cpp
void CServerSocket::OnAccept(int nErrorCode)
{
    // TODO: Add your specialized code here and/or call the base class
    AfxMessageBox(L"Connection accepted");
    CSocket::OnAccept(nErrorCode);
}
```

**Step 12:** Add OnReceive() function.

```cpp
void CServerSocket::OnReceive(int nErrorCode)
```
```cpp
{    // TODO: Add your specialized code here and/or call the base class
    AfxMessageBox(L"Data Received");
    CSocket::OnReceive(nErrorCode);
}
```

**Step 13:** Add OnReceive() function in CReceivingSocket class.

Right-click on the CMFCServerView class in solution explorer and select Add -> Add Function.

![Add Member Function Wizard](image)

**Step 14:** Enter the above mentioned information and click finish.

**Step 15:** Add the following CStringArray variable in CMFCServerView header file.

```cpp
CStringArray m_msgArray;
```
**Step 16:** Here is the implementation of `AddMsg()` function.

```cpp
void CMFCServerView::AddMsg(CString message)
{
    m_msgArray.Add(message);
    Invalidate();
}
```

**Step 17:** Update the constructor as shown in the following code.

```cpp
CMFCServerView::CMFCServerView()
{
    ((CMFCServerApp*)AfxGetApp())->m_pServerView = this;
}
```

**Step 18:** Here is the implementation of `OnDraw()` function, which display messages.

```cpp
void CMFCServerView::OnDraw(CDC* pDC)
{
    int y = 100;
    for (int i = 0; m_msgArray.GetSize(); i++)
    {
        pDC->TextOut(100, y, m_msgArray.GetAt(i));
        y += 50;
    }
    CMFCServerDoc* pDoc = GetDocument();
    ASSERT_VALID(pDoc);
    if (!pDoc)
        return;

    // TODO: add draw code for native data here
}
```
Step 19: The server side is now complete. It will receive message from the client.

Create Client Side Application

Step 1: Let us create a new MFC dialog based application for client side application.
Step 2: On Advanced Features tab, check the Windows sockets option as shown above.
**Step 3:** Once the project is created, design your dialog box as shown in the following snapshot.

![Dialog Box Snapshot](image)

**Step 4:** Add event handlers for Connect and Send buttons.
**Step 5:** Add value variables for all the three edit controls. For port edit control, select the variable type UINT.

**Step 6:** Add MFC class for connecting and sending messages.
Step 7: Include the header file of CClientSocket class in the header file CMFCClientDemoApp class and add the class variable. Similarly, add the class variable in CMFCClientDemoDlg header file as well.

```cpp
CClientSocket m_clientSocket;
```

Step 8: Here is the implementation of Connect button event handler.

```cpp
void CMFCClientDemoDlg::OnBnClickedButtonConnect()
{
    // TODO: Add your control notification handler code here
    UpdateData(TRUE);
    m_clientSocket.Create();
    if (m_clientSocket.Connect(m_ipAddress, m_port))
    {
        AfxMessageBox(L"Connection Successfull");
    }
    else
```
{  
    AfxMessageBox(L"Connection Failed");
}
DWORD error = GetLastError();
}

**Step 9:** Here is the implementation of Send button event handler.

```cpp
void CMFCClientDemoDlg::OnBnClickedButtonSend()
{
    // TODO: Add your control notification handler code here
    UpdateData(TRUE);
    if (m_clientSocket.Send(m_message.GetBuffer(m_message.GetLength()),
                             m_message.GetLength()))
    {
    }
    else
    {
        AfxMessageBox(L"Failed to send message");
    }
}
```

**Step 10:** First run the Server application and then the client application. Enter the local host ip and port and click Connect.
Step 11: You will now see the message on Server side as shown in the following snapshot.
Windows provides a variety of drawing tools to use in device contexts. It provides pens to draw lines, brushes to fill interiors, and fonts to draw text. MFC provides graphic-object classes equivalent to the drawing tools in Windows.

**Drawing**

A device context is a Windows data structure containing information about the drawing attributes of a device such as a display or a printer. All drawing calls are made through a device-context object, which encapsulates the Windows APIs for drawing lines, shapes, and text.

Device contexts allow device-independent drawing in Windows. Device contexts can be used to draw to the screen, to the printer, or to a metafile.

**CDC** is the most fundamental class to draw in MFC. The CDC object provides member functions to perform the basic drawing steps, as well as members for working with a display context associated with the client area of a window.

Here is a list of methods in CDC class.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AbortDoc</td>
<td>Terminates the current print job, erasing everything the application has written to the device since the last call of the StartDoc member function.</td>
</tr>
<tr>
<td>AbortPath</td>
<td>Closes and discards any paths in the device context.</td>
</tr>
<tr>
<td>AddMetaFileComment</td>
<td>Copies the comment from a buffer into a specified enhanced-format metafile.</td>
</tr>
<tr>
<td>AlphaBlend</td>
<td>Displays bitmaps that have transparent or semitransparent pixels.</td>
</tr>
<tr>
<td>AngleArc</td>
<td>Draws a line segment and an arc, and moves the current position to the ending point of the arc.</td>
</tr>
<tr>
<td>Arc</td>
<td>Draws an elliptical arc.</td>
</tr>
<tr>
<td>ArcTo</td>
<td>Draws an elliptical arc. This function is similar to Arc, except that the current position is updated.</td>
</tr>
<tr>
<td>Attach</td>
<td>Attaches a Windows device context to this CDC object.</td>
</tr>
<tr>
<td>BeginPath</td>
<td>Opens a path bracket in the device context.</td>
</tr>
<tr>
<td>BitBlt</td>
<td>Copies a bitmap from a specified device context.</td>
</tr>
<tr>
<td>Chord</td>
<td>Draws a chord (a closed figure bounded by the intersection of an ellipse and a line segment).</td>
</tr>
<tr>
<td>CloseFigure</td>
<td>Closes an open figure in a path.</td>
</tr>
<tr>
<td>CreateCompatibleDC</td>
<td>Creates a memory-device context that is compatible with another device context. You can use it to prepare images in memory.</td>
</tr>
<tr>
<td>CreateDC</td>
<td>Creates a device context for a specific device.</td>
</tr>
<tr>
<td>CreateIC</td>
<td>Creates an information context for a specific device. This provides a fast way to get information about the device without creating a device context.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DeleteDC</td>
<td>Deletes the Windows device context associated with this CDC object.</td>
</tr>
<tr>
<td>DeleteTempMap</td>
<td>Called by the CWinApp idle-time handler to delete any temporary CDC object created by FromHandle. Also detaches the device context.</td>
</tr>
<tr>
<td>Detach</td>
<td>Detaches the Windows device context from this CDC object.</td>
</tr>
<tr>
<td>DPToHIMETRIC</td>
<td>Converts device units into HIMETRIC units.</td>
</tr>
<tr>
<td>DPToLP</td>
<td>Converts device units into logical units.</td>
</tr>
<tr>
<td>Draw3dRect</td>
<td>Draws a three-dimensional rectangle.</td>
</tr>
<tr>
<td>DrawDragRect</td>
<td>Erases and redraws a rectangle as it is dragged.</td>
</tr>
<tr>
<td>DrawEdge</td>
<td>Draws the edges of a rectangle.</td>
</tr>
<tr>
<td>DrawEscape</td>
<td>Accesses drawing capabilities of a video display that are not directly available through the graphics device interface (GDI).</td>
</tr>
<tr>
<td>DrawFocusRect</td>
<td>Draws a rectangle in the style used to indicate focus.</td>
</tr>
<tr>
<td>DrawFrameControl</td>
<td>Draw a frame control.</td>
</tr>
<tr>
<td>DrawIcon</td>
<td>Draws an icon.</td>
</tr>
<tr>
<td>DrawState</td>
<td>Displays an image and applies a visual effect to indicate a state.</td>
</tr>
<tr>
<td>DrawText</td>
<td>Draws formatted text in the specified rectangle.</td>
</tr>
<tr>
<td>DrawTextEx</td>
<td>Draws formatted text in the specified rectangle using additional formats.</td>
</tr>
<tr>
<td>Ellipse</td>
<td>Draws an ellipse.</td>
</tr>
<tr>
<td>EndDoc</td>
<td>Ends a print job started by the StartDoc member function.</td>
</tr>
<tr>
<td>EndPage</td>
<td>Informs the device driver that a page is ending.</td>
</tr>
<tr>
<td>EndPath</td>
<td>Closes a path bracket and selects the path defined by the bracket into the device context.</td>
</tr>
<tr>
<td>EnumObjects</td>
<td>Enumerates the pens and brushes available in a device context.</td>
</tr>
<tr>
<td>Escape</td>
<td>Allows applications to access facilities that are not directly available from a particular device through GDI. Also allows access to Windows escape functions. Escape calls made by an application are translated and sent to the device driver.</td>
</tr>
<tr>
<td>ExcludeClipRect</td>
<td>Creates a new clipping region that consists of the existing clipping region minus the specified rectangle.</td>
</tr>
<tr>
<td>ExcludeUpdateRgn</td>
<td>Prevents drawing within invalid areas of a window by excluding an updated region in the window from a clipping region.</td>
</tr>
<tr>
<td>ExtFloodFill</td>
<td>Fills an area with the current brush. Provides more flexibility than the FloodFill member function.</td>
</tr>
<tr>
<td>ExtTextOut</td>
<td>Writes a character string within a rectangular region using the currently selected font.</td>
</tr>
<tr>
<td>FillPath</td>
<td>Closes any open figures in the current path and fills the path's interior by using the current brush and polygon-filling mode.</td>
</tr>
<tr>
<td>FillRect</td>
<td>Fills a given rectangle by using a specific brush.</td>
</tr>
<tr>
<td>FillRgn</td>
<td>Fills a specific region with the specified brush.</td>
</tr>
<tr>
<td>FillSolidRect</td>
<td>Fills a rectangle with a solid color.</td>
</tr>
<tr>
<td>FlattenPath</td>
<td>Transforms any curves in the path selected into the current device context, and turns each curve into a sequence of lines.</td>
</tr>
<tr>
<td>FloodFill</td>
<td>Fills an area with the current brush.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FrameRect</td>
<td>Draws a border around a rectangle.</td>
</tr>
<tr>
<td>FrameRgn</td>
<td>Draws a border around a specific region using a brush.</td>
</tr>
<tr>
<td>FromHandle</td>
<td>Returns a pointer to a CDC object when given a handle to a device context.</td>
</tr>
<tr>
<td>FromHandle</td>
<td>If a CDC object is not attached to the handle, a temporary CDC object is created and attached.</td>
</tr>
<tr>
<td>GetArcDirection</td>
<td>Returns the current arc direction for the device context.</td>
</tr>
<tr>
<td>GetAspectRatioFilter</td>
<td>Retrieves the setting for the current aspect-ratio filter.</td>
</tr>
<tr>
<td>GetBkColor</td>
<td>Retrieves the current background color.</td>
</tr>
<tr>
<td>GetBkMode</td>
<td>Retrieves the background mode.</td>
</tr>
<tr>
<td>GetBoundsRect</td>
<td>Returns the current accumulated bounding rectangle for the specified device context.</td>
</tr>
<tr>
<td>GetBrushOrg</td>
<td>Retrieves the origin of the current brush.</td>
</tr>
<tr>
<td>GetCharABCWidths</td>
<td>Retrieves the widths, in logical units, of consecutive characters in a given range from the current font.</td>
</tr>
<tr>
<td>GetCharABCWidthsI</td>
<td>Retrieves the widths, in logical units, of consecutive glyph indices in a specified range from the current TrueType font.</td>
</tr>
<tr>
<td>GetCharacterPlacement</td>
<td>Retrieves various types of information on a character string.</td>
</tr>
<tr>
<td>GetCharWidth</td>
<td>Retrieves the fractional widths of consecutive characters in a given range from the current font.</td>
</tr>
<tr>
<td>GetCharWidthI</td>
<td>Retrieves the widths, in logical coordinates, of consecutive glyph indices in a specified range from the current font.</td>
</tr>
<tr>
<td>GetClipBox</td>
<td>Retrieves the dimensions of the tightest bounding rectangle around the current clipping boundary.</td>
</tr>
<tr>
<td>GetColorAdjustment</td>
<td>Retrieves the color adjustment values for the device context.</td>
</tr>
<tr>
<td>GetCurrentBitmap</td>
<td>Returns a pointer to the currently selected CBitmap object.</td>
</tr>
<tr>
<td>GetCurrentBrush</td>
<td>Returns a pointer to the currently selected CBrush object.</td>
</tr>
<tr>
<td>GetCurrentFont</td>
<td>Returns a pointer to the currently selected CFont object.</td>
</tr>
<tr>
<td>GetCurrentPalette</td>
<td>Returns a pointer to the currently selected CPalette object.</td>
</tr>
<tr>
<td>GetCurrentPen</td>
<td>Returns a pointer to the currently selected CPen object.</td>
</tr>
<tr>
<td>GetCurrentPosition</td>
<td>Retrieves the current position of the pen (in logical coordinates).</td>
</tr>
<tr>
<td>GetDCBrushColor</td>
<td>Retrieves the current brush color.</td>
</tr>
<tr>
<td>GetDCPenColor</td>
<td>Retrieves the current pen color.</td>
</tr>
<tr>
<td>GetDeviceCaps</td>
<td>Retrieves a specified kind of device-specific information about a given display device's capabilities.</td>
</tr>
<tr>
<td>GetFontData</td>
<td>Retrieves font metric information from a scalable font file. The information to retrieve is identified by specifying an offset into the font file and the length of the information to return.</td>
</tr>
<tr>
<td>GetFontLanguageInfo</td>
<td>Returns information about the currently selected font for the specified display context.</td>
</tr>
<tr>
<td>GetGlyphOutline</td>
<td>Retrieves the outline curve or bitmap for an outline character in the current font.</td>
</tr>
<tr>
<td>GetGraphicsMode</td>
<td>Retrieves the current graphics mode for the specified device context.</td>
</tr>
<tr>
<td>GetHalftoneBrush</td>
<td>Retrieves a halftone brush.</td>
</tr>
<tr>
<td>GetKerningPairs</td>
<td>Retrieves the character kerning pairs for the font that is currently selected in the specified device context.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GetLayout</td>
<td>Retrieves the layout of a device context (DC). The layout can be either left to right (default) or right to left (mirrored).</td>
</tr>
<tr>
<td>GetMapMode</td>
<td>Retrieves the current mapping mode.</td>
</tr>
<tr>
<td>GetMiterLimit</td>
<td>Returns the miter limit for the device context.</td>
</tr>
<tr>
<td>GetNearestColor</td>
<td>Retrieves the closest logical color to a specified logical color that the given device can represent.</td>
</tr>
<tr>
<td>GetOutlineTextMetrics</td>
<td>Retrieves font metric information for TrueType fonts.</td>
</tr>
<tr>
<td>GetOutputCharWidth</td>
<td>Retrieves the widths of individual characters in a consecutive group of characters from the current font using the output device context.</td>
</tr>
<tr>
<td>GetOutputTabbedTextExt</td>
<td>Computes the width and height of a character string on the output device context.</td>
</tr>
<tr>
<td>GetOutputTextExtent</td>
<td>Computes the width and height of a line of text on the output device context using the current font to determine the dimensions.</td>
</tr>
<tr>
<td>GetOutputTextMetrics</td>
<td>Retrieves the metrics for the current font from the output device context.</td>
</tr>
<tr>
<td>GetPath</td>
<td>Retrieves the coordinates defining the endpoints of lines and the control points of curves found in the path that is selected into the device context.</td>
</tr>
<tr>
<td>GetPixel</td>
<td>Retrieves the RGB color value of the pixel at the specified point.</td>
</tr>
<tr>
<td>GetPolyFillMode</td>
<td>Retrieves the current polygon-filling mode.</td>
</tr>
<tr>
<td>GetROP2</td>
<td>Retrieves the current drawing mode.</td>
</tr>
<tr>
<td>GetSafeHdc</td>
<td>Returns m_hDC, the output device context.</td>
</tr>
<tr>
<td>GetStretchBltMode</td>
<td>Retrieves the current bitmap-stretching mode.</td>
</tr>
<tr>
<td>GetTabbedTextExtent</td>
<td>Computes the width and height of a character string on the attribute device context.</td>
</tr>
<tr>
<td>GetTextAlign</td>
<td>Retrieves the text-alignment flags.</td>
</tr>
<tr>
<td>GetTextCharacterExtra</td>
<td>Retrieves the current setting for the amount of intercharacter spacing.</td>
</tr>
<tr>
<td>GetTextColor</td>
<td>Retrieves the current text color.</td>
</tr>
<tr>
<td>GetTextExtent</td>
<td>Computes the width and height of a line of text on the attribute device context using the current font to determine the dimensions.</td>
</tr>
<tr>
<td>GetTextExtentExPointI</td>
<td>Retrieves the number of characters in a specified string that will fit within a specified space and fills an array with the text extent for each of those characters.</td>
</tr>
<tr>
<td>GetTextExtentPointI</td>
<td>Retrieves the width and height of the specified array of glyph indices.</td>
</tr>
<tr>
<td>GetTextFace</td>
<td>Copies the typeface name of the current font into a buffer as a null-terminated string.</td>
</tr>
<tr>
<td>GetTextMetrics</td>
<td>Retrieves the metrics for the current font from the attribute device context.</td>
</tr>
<tr>
<td>GetViewportExt</td>
<td>Retrieves the x- and y-extents of the viewport.</td>
</tr>
<tr>
<td>GetViewportOrg</td>
<td>Retrieves the x- and y-coordinates of the viewport origin.</td>
</tr>
<tr>
<td>GetWindow</td>
<td>Returns the window associated with the display device context.</td>
</tr>
<tr>
<td>GetWindowExt</td>
<td>Retrieves the x- and y-extents of the associated window.</td>
</tr>
<tr>
<td>GetWindowOrg</td>
<td>Retrieves the x- and y-coordinates of the origin of the associated window.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GetWorldTransform</td>
<td>Retrieves the current world-space to page-space transformation.</td>
</tr>
<tr>
<td>GradientFill</td>
<td>Fills rectangle and triangle structures with a gradating color.</td>
</tr>
<tr>
<td>GrayString</td>
<td>Draws dimmed (grayed) text at the given location.</td>
</tr>
<tr>
<td>HIMETRICtoDP</td>
<td>Converts HIMETRIC units into device units.</td>
</tr>
<tr>
<td>HIMETRICtoLP</td>
<td>Converts HIMETRIC units into logical units.</td>
</tr>
<tr>
<td>IntersectClipRect</td>
<td>Creates a new clipping region by forming the intersection of the current region and a rectangle.</td>
</tr>
<tr>
<td>InvertRect</td>
<td>Inverts the contents of a rectangle.</td>
</tr>
<tr>
<td>InvertRgn</td>
<td>Inverts the colors in a region.</td>
</tr>
<tr>
<td>IsPrinting</td>
<td>Determines whether the device context is being used for printing.</td>
</tr>
<tr>
<td>LineTo</td>
<td>Draws a line from the current position up to, but not including, a point.</td>
</tr>
<tr>
<td>LPtoDP</td>
<td>Converts logical units into device units.</td>
</tr>
<tr>
<td>LPtoHIMETRIC</td>
<td>Converts logical units into HIMETRIC units.</td>
</tr>
<tr>
<td>MaskBlt</td>
<td>Combines the color data for the source and destination bitmaps using the given mask and raster operation.</td>
</tr>
<tr>
<td>ModifyWorldTransform</td>
<td>Changes the world transformation for a device context using the specified mode.</td>
</tr>
<tr>
<td>MoveTo</td>
<td>Moves the current position.</td>
</tr>
<tr>
<td>OffsetClipRgn</td>
<td>Moves the clipping region of the given device.</td>
</tr>
<tr>
<td>OffsetViewportOrg</td>
<td>Modifies the viewport origin relative to the coordinates of the current viewport origin.</td>
</tr>
<tr>
<td>OffsetWindowOrg</td>
<td>Modifies the window origin relative to the coordinates of the current window origin.</td>
</tr>
<tr>
<td>PaintRgn</td>
<td>Fills a region with the selected brush.</td>
</tr>
<tr>
<td>PatBlt</td>
<td>Creates a bit pattern.</td>
</tr>
<tr>
<td>Pie</td>
<td>Draws a pie-shaped wedge.</td>
</tr>
<tr>
<td>PlayMetaFile</td>
<td>Plays the contents of the specified metafile on the given device. The enhanced version of PlayMetaFile displays the picture stored in the given enhanced-format metafile. The metafile can be played any number of times.</td>
</tr>
<tr>
<td>PlgBlt</td>
<td>Performs a bit-block transfer of the bits of color data from the specified rectangle in the source device context to the specified parallelogram in the given device context.</td>
</tr>
<tr>
<td>PolyBezier</td>
<td>Draws one or more Bzier splines. The current position is neither used nor updated.</td>
</tr>
<tr>
<td>PolyBezierTo</td>
<td>Draws one or more Bzier splines, and moves the current position to the ending point of the last Bzier spline.</td>
</tr>
<tr>
<td>PolyDraw</td>
<td>Draws a set of line segments and Bzier splines. This function updates the current position.</td>
</tr>
<tr>
<td>Polygon</td>
<td>Draws a polygon consisting of two or more points (vertices) connected by lines.</td>
</tr>
<tr>
<td>Polyl ine</td>
<td>Draws a set of line segments connecting the specified points.</td>
</tr>
<tr>
<td>PolylineTo</td>
<td>Draws one or more straight lines and moves the current position to the ending point of the last line.</td>
</tr>
<tr>
<td>PolyPolygon</td>
<td>Creates two or more polygons that are filled using the current polygon-filling mode. The polygons may be disjoint or they may overlap.</td>
</tr>
<tr>
<td>Procedure</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PolyPolyline</td>
<td>Draws multiple series of connected line segments. The current position is neither used nor updated by this function.</td>
</tr>
<tr>
<td>PtVisible</td>
<td>Specifies whether the given point is within the clipping region.</td>
</tr>
<tr>
<td>RealizePalette</td>
<td>Maps palette entries in the current logical palette to the system palette.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Draws a rectangle using the current pen and fills it using the current brush.</td>
</tr>
<tr>
<td>RectVisible</td>
<td>Determines whether any part of the given rectangle lies within the clipping region.</td>
</tr>
<tr>
<td>ReleaseAttribDC</td>
<td>Releases <code>m_hAttribDC</code>, the attribute device context.</td>
</tr>
<tr>
<td>ReleaseOutputDC</td>
<td>Releases <code>m_hDC</code>, the output device context.</td>
</tr>
<tr>
<td>ResetDC</td>
<td>Updates the <code>m_hAttribDC</code> device context.</td>
</tr>
<tr>
<td>RestoreDC</td>
<td>Restores the device context to a previous state saved with <code>SaveDC</code>.</td>
</tr>
<tr>
<td>RoundRect</td>
<td>Draws a rectangle with rounded corners using the current pen and filled using the current brush.</td>
</tr>
<tr>
<td>SaveDC</td>
<td>Saves the current state of the device context.</td>
</tr>
<tr>
<td>ScaleViewportExt</td>
<td>Modifies the viewport extent relative to the current values.</td>
</tr>
<tr>
<td>ScaleWindowExt</td>
<td>Modifies the window extents relative to the current values.</td>
</tr>
<tr>
<td>ScrollDC</td>
<td>Scrolls a rectangle of bits horizontally and vertically.</td>
</tr>
<tr>
<td>SelectClipPath</td>
<td>Selects the current path as a clipping region for the device context, combining the new region with any existing clipping region by using the specified mode.</td>
</tr>
<tr>
<td>SelectClipRgn</td>
<td>Combines the given region with the current clipping region by using the specified mode.</td>
</tr>
<tr>
<td>SelectObject</td>
<td>Selects a GDI drawing object such as a pen.</td>
</tr>
<tr>
<td>SelectPalette</td>
<td>Selects the logical palette.</td>
</tr>
<tr>
<td>SelectStockObject</td>
<td>Selects one of the predefined stock pens, brushes, or fonts provided by Windows.</td>
</tr>
<tr>
<td>SetAbortProc</td>
<td>Sets a programmer-supplied callback function that Windows calls if a print job must be aborted.</td>
</tr>
<tr>
<td>SetArcDirection</td>
<td>Sets the drawing direction to be used for arc and rectangle functions.</td>
</tr>
<tr>
<td>SetAttribDC</td>
<td>Sets <code>m_hAttribDC</code>, the attribute device context.</td>
</tr>
<tr>
<td>SetBkColor</td>
<td>Sets the current background color.</td>
</tr>
<tr>
<td>SetBkMode</td>
<td>Sets the background mode.</td>
</tr>
<tr>
<td>Set Bounds Rect</td>
<td>Controls the accumulation of bounding-rectangle information for the specified device context.</td>
</tr>
<tr>
<td>SetBrushOrg</td>
<td>Specifies the origin for the next brush selected into a device context.</td>
</tr>
<tr>
<td>SetColorAdjustment</td>
<td>Sets the color adjustment values for the device context using the specified values.</td>
</tr>
<tr>
<td>SetDCBrushColor</td>
<td>Sets the current brush color.</td>
</tr>
<tr>
<td>SetDCPenColor</td>
<td>Sets the current pen color.</td>
</tr>
<tr>
<td>SetGraphicsMode</td>
<td>Sets the current graphics mode for the specified device context.</td>
</tr>
<tr>
<td>SetLayout</td>
<td>Changes the layout of a device context (DC).</td>
</tr>
<tr>
<td>SetMapMode</td>
<td>Sets the current mapping mode.</td>
</tr>
<tr>
<td>SetMapperFlags</td>
<td>Alters the algorithm that the font mapper uses when it maps logical fonts to physical fonts.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SetMiterLimit</td>
<td>Sets the limit for the length of miter joins for the device context.</td>
</tr>
<tr>
<td>SetOutputDC</td>
<td>Sets m_hDC, the output device context.</td>
</tr>
<tr>
<td>SetPixel</td>
<td>Sets the pixel at the specified point to the closest approximation of the specified color.</td>
</tr>
<tr>
<td>SetPixelIV</td>
<td>Sets the pixel at the specified coordinates to the closest approximation of the specified color. SetPixelIV is faster than SetPixel because it does not need to return the color value of the point actually painted.</td>
</tr>
<tr>
<td>SetPolyFillMode</td>
<td>Sets the polygon-filling mode.</td>
</tr>
<tr>
<td>SetROP2</td>
<td>Sets the current drawing mode.</td>
</tr>
<tr>
<td>SetStretchBltMode</td>
<td>Sets the bitmap-stretching mode.</td>
</tr>
<tr>
<td>SetTextAlign</td>
<td>Sets the text-alignment flags.</td>
</tr>
<tr>
<td>SetTextColor</td>
<td>Sets the text color.</td>
</tr>
<tr>
<td>SetTextCharacterExtra</td>
<td>Sets the amount of intercharacter spacing.</td>
</tr>
<tr>
<td>SetTextJustification</td>
<td>Adds space to the break characters in a string.</td>
</tr>
<tr>
<td>SetViewportExt</td>
<td>Sets the x- and y-extents of the viewport.</td>
</tr>
<tr>
<td>SetViewportOrg</td>
<td>Sets the viewport origin.</td>
</tr>
<tr>
<td>SetWindowExt</td>
<td>Sets the x- and y-extents of the associated window.</td>
</tr>
<tr>
<td>SetWindowOrg</td>
<td>Sets the window origin of the device context.</td>
</tr>
<tr>
<td>SetWorldTransform</td>
<td>Sets the current world-space to page-space transformation.</td>
</tr>
<tr>
<td>StartDoc</td>
<td>Informs the device driver that a new print job is starting.</td>
</tr>
<tr>
<td>StartPage</td>
<td>Informs the device driver that a new page is starting.</td>
</tr>
<tr>
<td>StretchBlt</td>
<td>Moves a bitmap from a source rectangle and device into a destination rectangle, stretching or compressing the bitmap if necessary to fit the dimensions of the destination rectangle.</td>
</tr>
<tr>
<td>StrokeAndFillPath</td>
<td>Closes any open figures in a path, strikes the outline of the path by using the current pen, and fills its interior by using the current brush.</td>
</tr>
<tr>
<td>StrokePath</td>
<td>Renders the specified path by using the current pen.</td>
</tr>
<tr>
<td>TabbedTextOut</td>
<td>Writes a character string at a specified location, expanding tabs to the values specified in an array of tab-stop positions.</td>
</tr>
<tr>
<td>TextOut</td>
<td>Writes a character string at a specified location using the currently selected font.</td>
</tr>
<tr>
<td>TransparentBlt</td>
<td>Transfers a bit-block of color data from the specified source device context into a destination device context, rendering a specified color transparent in the transfer.</td>
</tr>
<tr>
<td>UpdateColors</td>
<td>Updates the client area of the device context by matching the current colors in the client area to the system palette on a pixel-by-pixel basis.</td>
</tr>
<tr>
<td>WidenPath</td>
<td>Redefines the current path as the area that would be painted if the path were stroked using the pen currently selected into the device context.</td>
</tr>
</tbody>
</table>

**Lines**

**Step 1:** Let us look into a simple example by creating a new MFC based single document project with **MFCGDidemo** name.
Step 2: Once the project is created, go to the Solution Explorer and double click on the `MFCGDIDemoView.cpp` file under the Source Files folder.

Step 3: Draw the line as shown below in `CMFCGDIDemoView::OnDraw()` method.

```cpp
void CMFCGDIDemoView::OnDraw(CDC* pDC)
{
    pDC->MoveTo(95, 125);
    pDC->LineTo(230, 125);
    CMFCGDIDemoDoc* pDoc = GetDocument();
    ASSERT_VALID(pDoc);
    if (!pDoc)
        return;

    // TODO: add draw code for native data here
}
```
Step 4: Run this application. You will see the following output.

![Image of a window with a line drawn in it]

Step 5: The CDC::MoveTo() method is used to set the starting position of a line.

When using LineTo(), the program starts from the MoveTo() point to the LineTo() end.

After LineTo() when you do not call MoveTo(), and call again LineTo() with other point value, the program will draw a line from the previous LineTo() to the new LineTo() point.

Step 6: To draw different lines, you can use this property as shown in the following code.

```cpp
void CMFCGDIDemoView::OnDraw(CDC* pDC)
{
    pDC->MoveTo(95, 125);
    pDC->LineTo(230, 125);
    pDC->LineTo(230, 225);
    pDC->LineTo(95, 325);
    CMFCGDIDemoDoc* pDoc = GetDocument();
    ASSERT_VALID(pDoc);
    if (!pDoc)
        return;
    // TODO: add draw code for native data here }
```
**Step 7:** Run this application. You will see the following output.

![Output Image](image-url)

**Polylines**

A **polyline** is a series of connected lines. The lines are stored in an array of POINT or CPoint values. To draw a polyline, you use the CDC::Polyline() method. To draw a polyline, at least two points are required. If you define more than two points, each line after the first would be drawn from the previous point to the next point until all points have been included.

**Step 1:** Let us look into a simple example.

```cpp
define CMFCGDIDemoView::OnDraw(CDC* pDC)
{
    CPoint Pt[7];
    Pt[0] = CPoint(20, 150);
    Pt[1] = CPoint(180, 150);
    Pt[2] = CPoint(180, 20);
```
pDC->Polyline(Pt, 3);

CMFCGDIDemoDoc* pDoc = GetDocument();
ASSERT_VALID(pDoc);
if (!pDoc)
    return;

    // TODO: add draw code for native data here

Step 2: When you run this application, you will see the following output.

Rectangles
A rectangle is a geometric figure made of four sides that compose four right angles. Like the line, to draw a rectangle, you must define where it starts and where it ends. To draw a rectangle, you can use the CDC::Rectangle() method.
Step 1: Let us look into a simple example.

```cpp
void CMFCGDIDemoView::OnDraw(CDC* pDC)
{
    pDC->Rectangle(15, 15, 250, 160);
    CMFCGDIDemoDoc* pDoc = GetDocument();
    ASSERT_VALID(pDoc);
    if (!pDoc)
        return;
    // TODO: add draw code for native data here
}
```

Step 2: When you run this application, you will see the following output.

![Screenshot of application output](image-url)
Squares

A square is a geometric figure made of four sides that compose four right angles, but each side must be equal in length.

Let us look into a simple example.

```cpp
void CMFCGDIDemoView::OnDraw(CDC* pDC)
{
    pDC->Rectangle(15, 15, 250, 250);

    CMFCGDIDemoDoc* pDoc = GetDocument();
    ASSERT_VALID(pDoc);
    if (!pDoc)
        return;

    // TODO: add draw code for native data here
}
```

When you run this application, you will see the following output.
Pies

A pie is a fraction of an ellipse delimited by two lines that span from the center of the ellipse to one side each. To draw a pie, you can use the CDC::Pie() method as shown below:

BOOL Pie(int x1, int y1, int x2, int y2, int x3, int y3, int x4, int y4);

- The (x1, y1) point determines the upper-left corner of the rectangle in which the ellipse that represents the pie fits. The (x2, y2) point is the bottom-right corner of the rectangle.
The \((x_3, y_3)\) point specifies the starting corner of the pie in a default counterclockwise direction.

The \((x_4, y_4)\) point specifies the end point of the pie.

Let us look into a simple example.

```cpp
void CMFCGDIDemoView::OnDraw(CDC* pDC)
{
    pDC->Pie(40, 20, 226, 144, 155, 32, 202, 115);

    CMFCGDIDemoDoc* pDoc = GetDocument();
    ASSERT_VALID(pDoc);
    if (!pDoc)
        return;

    // TODO: add draw code for native data here
}
```
**Step 2:** When you run this application, you will see the following output.

![Image of application output](image)

**Arcs**

An arc is a portion or segment of an ellipse, meaning an arc is a non-complete ellipse. To draw an arc, you can use the `CDC::Arc()` method.

```cpp
BOOL Arc(int x1, int y1, int x2, int y2, int x3, int y3, int x4, int y4);
```

![Diagram of arc](image)

The CDC class is equipped with the `SetArcDirection()` method.
Here is the syntax:

```
int SetArcDirection(int nArcDirection)
```

<table>
<thead>
<tr>
<th>Value</th>
<th>Orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD_CLOCKWISE</td>
<td>The figure is drawn clockwise</td>
</tr>
<tr>
<td>AD_COUNTERCLOCKWISE</td>
<td>The figure is drawn counterclockwise</td>
</tr>
</tbody>
</table>

**Step 1:** Let us look into a simple example.

```cpp
void CMFCGDIDemoView::OnDraw(CDC* pDC)
{
    pDC->SetArcDirection(AD_COUNTERCLOCKWISE);
    pDC->Arc(20, 20, 226, 144, 202, 115, 105, 32);

    CMFCGDIDemoDoc* pDoc = GetDocument();
    ASSERT_VALID(pDoc);
    if (!pDoc)
        return;

    // TODO: add draw code for native data here
}
```

**Step 2:** When you run this application, you will see the following output.
Chords

The arcs we have drawn so far are considered open figures because they are made of a line that has a beginning and an end (unlike a circle or a rectangle that do not). A chord is an arc whose two ends are connected by a straight line.

To draw a chord, you can use the CDC::Chord() method.

BOOL Chord(int x1, int y1, int x2, int y2, int x3, int y3, int x4, int y4);

Let us look into a simple example.

```cpp
void CMFCGDIDemoView::OnDraw(CDC* pDC)
{
    pDC->SetArcDirection(AD_CLOCKWISE);
    pDC->Chord(20, 20, 226, 144, 202, 115, 105, 32);
}
```
When you run the above application, you will see the following output.

The arc direction in this example is set clockwise.

**Colors**

The *color* is one the most fundamental objects that enhances the aesthetic appearance of an object. The color is a non-spatial object that is added to an object to modify some of its visual aspects. The MFC library, combined with the Win32 API, provides various actions you can use to take advantage of the various aspects of colors.
The RGB macro behaves like a function and allows you to pass three numeric values separated by a comma. Each value must be between 0 and 255 as shown in the following code.

```cpp
text
void CMFCGDIDemoView::OnDraw(CDC* pDC)
{
    COLORREF color = RGB(239, 15, 225);
}
```

Let us look into a simple example.

```cpp
text
void CMFCGDIDemoView::OnDraw(CDC* pDC)
{
    COLORREF color = RGB(239, 15, 225);
    pDC->SetTextColor(color);
    pDC->TextOut(100, 80, L"MFC GDI Tutorial", 16);

    CMFCGDIDemoDoc* pDoc = GetDocument();
    ASSERT_VALID(pDoc);
    if (!pDoc)
        return;

    // TODO: add draw code for native data here
}
```

When you run this application, you will see the following output.
Fonts

CFont encapsulates a Windows graphics device interface (GDI) font and provides member functions for manipulating the font. To use a CFont object, construct a CFont object and attach a Windows font to it, and then use the object's member functions to manipulate the font.

Here is a list of methods in CFont class.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CreateFont</td>
<td>Initializes a CFont with the specified characteristics.</td>
</tr>
<tr>
<td>CreateFontIndirect</td>
<td>Initializes a CFont object with the characteristics given in a LOGFONT structure.</td>
</tr>
<tr>
<td>CreatePointFont</td>
<td>Initializes a CFont with the specified height, measured in tenths of a point, and typeface.</td>
</tr>
<tr>
<td>CreatePointFontIndirect</td>
<td>Same as CreateFontIndirect except that the font height is measured in tenths of a point rather than logical units.</td>
</tr>
<tr>
<td>FromHandle</td>
<td>Returns a pointer to a CFont object when given a Windows HFONT.</td>
</tr>
<tr>
<td>GetLogFont</td>
<td>Fills a LOGFONT with information about the logical font attached to the CFont object.</td>
</tr>
</tbody>
</table>
Let us look into a simple example.

```cpp
void CMFCGDIDemoView::OnDraw(CDC* pDC)
{
    CFont font;
    font.CreatePointFont(920, L"Garamond");
    CFont *pFont = pDC->SelectObject(&font);
    COLORREF color = RGB(239, 15, 225);
    pDC->SetTextColor(color);
    pDC->TextOut(100, 80, L"MFC GDI Tutorial", 16);
    pDC->SelectObject(pFont);
    font.DeleteObject();

    CMFCGDIDemoDoc* pDoc = GetDocument();
    ASSERT_VALID(pDoc);
    if (!pDoc)
        return;

    // TODO: add draw code for native data here
}
```

When you run the above application, you will see the following output.
Pens

A **pen** is a tool used to draw lines and curves on a device context. In the graphics programming, a pen is also used to draw the borders of a geometric closed shape such as a rectangle or a polygon. Microsoft Windows considers two types of pens — cosmetic and geometric.

A pen is referred to as cosmetic when it can be used to draw only simple lines of a fixed width, less than or equal to 1 pixel. A pen is geometric when it can assume different widths and various ends. MFC provides a class **CPen** which encapsulates a Windows graphics device interface (GDI) pen.

Here is a list of methods in CPen class.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CreatePen</td>
<td>Creates a logical cosmetic or geometric pen with the specified style, width, and brush attributes, and attaches it to the CPen object.</td>
</tr>
<tr>
<td>CreatePenIndirect</td>
<td>Creates a pen with the style, width, and color given in a LOGPEN structure, and attaches it to the CPen object.</td>
</tr>
<tr>
<td>FromHandle</td>
<td>Returns a pointer to a CPen object when given a Windows HPEN.</td>
</tr>
<tr>
<td>GetExtLogPen</td>
<td>Gets an EXTLOGPEN underlying structure.</td>
</tr>
<tr>
<td>GetLogPen</td>
<td>Gets a LOGPEN underlying structure.</td>
</tr>
</tbody>
</table>

Here the different style values for pen:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PS_SOLID</td>
<td>A continuous solid line.</td>
</tr>
<tr>
<td>PS_DASH</td>
<td>A continuous line with dashed interruptions.</td>
</tr>
<tr>
<td>PS_DOT</td>
<td>A line with a dot interruption at every other pixel.</td>
</tr>
<tr>
<td>PS_DASHDOT</td>
<td>A combination of alternating dashed and dotted points.</td>
</tr>
<tr>
<td>PS_DASHDOTDOT</td>
<td>A combination of dash and double dotted interruptions.</td>
</tr>
<tr>
<td>PS_NULL</td>
<td>No visible line.</td>
</tr>
<tr>
<td>PS_INSIDEFRAME</td>
<td>A line drawn just inside of the border of a closed shape.</td>
</tr>
</tbody>
</table>

Let us look into a simple example.

```cpp
void CMFCGDIDemoView::OnDraw(CDC* pDC)
{
    CPen pen;
    pen.CreatePen(PS_DASHDOTDOT, 1, RGB(160, 75, 90));
    pDC->SelectObject(&pen);
    pDC->Rectangle(25, 35, 250, 125);
}```
CMFCGIDemoDoc* pDoc = GetDocument();
ASSERT_VALID(pDoc);
if (!pDoc)
    return;

// TODO: add draw code for native data here
}

When you run the above application, you will see the following output.

**Brushes**

A **brush** is a drawing tool used to fill out closed shaped or the interior of lines. A brush behaves like picking up a bucket of paint and pouring it somewhere. MFC provides a class **CBrush** which encapsulates a Windows graphics device interface (GDI) brush.
Here is a list of methods in CBrush class.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CreateBrushIndirect</td>
<td>Initializes a brush with the style, color, and pattern specified in a LOGBRUSH structure.</td>
</tr>
<tr>
<td>CreateDIBPatternBrush</td>
<td>Initializes a brush with a pattern specified by a device-independent bitmap (DIB).</td>
</tr>
<tr>
<td>CreateHatchBrush</td>
<td>Initializes a brush with the specified hatched pattern and color.</td>
</tr>
<tr>
<td>CreatePatternBrush</td>
<td>Initializes a brush with a pattern specified by a bitmap.</td>
</tr>
<tr>
<td>CreateSolidBrush</td>
<td>Initializes a brush with the specified solid color.</td>
</tr>
<tr>
<td>CreateSysColorBrush</td>
<td>Creates a brush that is the default system color.</td>
</tr>
<tr>
<td>FromHandle</td>
<td>Returns a pointer to a CBrush object when given a handle to a Windows HBRUSH object.</td>
</tr>
<tr>
<td>GetLogBrush</td>
<td>Gets a LOGBRUSH structure.</td>
</tr>
</tbody>
</table>

Let us look into a simple example.

```cpp
void CMFCGDIDemoView::OnDraw(CDC* pDC) {
    CBrush brush(RGB(100, 150, 200));
    CBrush *pBrush = pDC->SelectObject(&brush);
    pDC->Rectangle(25, 35, 250, 125);
    pDC->SelectObject(pBrush);

    CMFCGDIDemoDoc* pDoc = GetDocument();
    ASSERT_VALID(pDoc);
    if (!pDoc)
        return;

    // TODO: add draw code for native data here
}
```
When you run this application, you will see the following output.
A **library** is a group of functions, classes, or other resources that can be made available to programs that need already implemented entities without the need to know how these functions, classes, or resources were created or how they function. A library makes it easy for a programmer to use functions, classes, and resources etc. created by another person or company and trust that this external source is reliable and efficient. Some unique features related to libraries are:

- A library is created and functions like a normal regular program, using functions or other resources and communicating with other programs.

- To implement its functionality, a library contains functions that other programs would need to complete their functionality.

- At the same time, a library may use some functions that other programs would not need.

- The program that uses the library, are also called the clients of the library.

There are two types of functions you will create or include in your libraries:

- An internal function is one used only by the library itself and clients of the library will not need access to these functions.

- External functions are those that can be accessed by the clients of the library.

There are two broad categories of libraries you will deal with in your programs:

- Static libraries
- Dynamic libraries

**Static Library**

A **static library** is a file that contains functions, classes, or resources that an external program can use to complement its functionality. To use a library, the programmer has to create a link to it. The project can be a console application, a Win32 or an MFC application. The library file has the lib extension.
**Step 1:** Let us look into a simple example of static library by creating a new Win32 Project.
Step 2: On Application Wizard dialog box, choose the Static Library option.

Step 3: Click Finish to continue.
Step 4: Right-click on the project in solution explorer and add a header file from Add -> New Item... menu option.
Step 5: Enter Calculator.h in the Name field and click Add.

Add the following code in the header file:

```c
#pragma once

#ifndef _CALCULATOR_H_
#define _CALCULATOR_H_
double Min(const double *Numbers, const int Count);
double Max(const double *Numbers, const int Count);
double Sum(const double *Numbers, const int Count);
double Average(const double *Numbers, const int Count);
long GreatestCommonDivisor(long Nbr1, long Nbr2);
#endif // _CALCULATOR_H_
```

Step 6: Add a source (*.cpp) file in the project.
Step 7: Enter Calculator.cpp in the Name field and click Add.

Step 8: Add the following code in the *.cpp file:

```cpp
#include "StdAfx.h"
#include "Calculator.h"

double Min(const double *Nbr, const int Total)
{
    double Minimum = Nbr[0];
    for (int i = 0; i < Total; i++)
        if (Minimum > Nbr[i])
            Minimum = Nbr[i];
    return Minimum;
}

double Max(const double *Nbr, const int Total)
{
    double Maximum = Nbr[0];
    for (int i = 0; i < Total; i++)
        if (Maximum < Nbr[i])
            Maximum = Nbr[i];
    return Maximum;
```
double Sum(const double *Nbr, const int Total)
{
    double S = 0;
    for (int i = 0; i < Total; i++)
        S += Nbr[i];
    return S;
}

double Average(const double *Nbr, const int Total)
{
    double avg, S = 0;
    for (int i = 0; i < Total; i++)
        S += Nbr[i];
    avg = S / Total;
    return avg;
}

long GreatestCommonDivisor(long Nbr1, long Nbr2)
{
    while (true)
    {
        Nbr1 = Nbr1 % Nbr2;
        if (Nbr1 == 0)
            return Nbr2;
        Nbr2 = Nbr2 % Nbr1;
        if (Nbr2 == 0)
            return Nbr1;
    }
}

Step 9: Build this library from the main menu, by clicking Build -> Build MFCLib.
Step 10: When library is built successfully, it will display the above message.

Step 11: To use these functions from the library, let us add another MFC dialog application based from File -> New -> Project.
**Step 12:** Go to the MFCLib\Debug folder and copy the header file and \*.lib files to the MFCLibTest project as shown in the following snapshot.
**Step 13:** To add the library to the current project, on the main menu, click **Project -> Add Existing Item** and select **MFCLib.lib**.

**Step 14:** Design your dialog box as shown in the following snapshot.
Step 15: Add value variable for both edit controls of value type double.
Step 16: Add value variable for Static text control, which is at the end of the dialog box.
Step 17: Add the event handler for Calculate button.

To add functionality from the library, we need to include the header file in CMFCLibTestDlg.cpp file.

```cpp
#include "stdafx.h"
#include "MFCLibTest.h"
#include "MFCLibTestDlg.h"
#include "afxdialogex.h"
#include "Calculator.h"
```

Step 18: Here is the implementation of button event handler.

```cpp
void CMFCLibTestDlg::OnBnClickedButtonCal()
{
    // TODO: Add your control notification handler code here
    UpdateData(TRUE);

    CString strTemp;
```
double numbers[2];
numbers[0] = m_Num1;
numbers[1] = m_Num2;
strTemp.Format(L"%.2f", Max(numbers, 2));
m_strText.Append(L"Max is:\t" + strTemp);

strTemp.Format(L"%.2f", Min(numbers, 2));
m_strText.Append(L"\nMin is:\t" + strTemp);

strTemp.Format(L"%.2f", Sum(numbers, 2));
m_strText.Append(L"\nSum is:\t" + strTemp);

strTemp.Format(L"%.2f", Average(numbers, 2));
m_strText.Append(L"\nAverage is:\t" + strTemp);

strTemp.Format(L"%d", GreatestCommonDivisor(m_Num1, m_Num2));
m_strText.Append(L"\nGDC is:\t" + strTemp);

UpdateData(FALSE);
}

**Step 19:** When the above code is compiled and executed, you will see the following output.
**Step 20:** Enter two values in the edit field and click Calculate. You will now see the result after calculating from the library.

![MFCLibTest](image)

**Dynamic Library**

A Win32 DLL is a library that can be made available to programs that run on a Microsoft Windows computer. As a normal library, it is made of functions and/or other resources grouped in a file.

The DLL abbreviation stands for Dynamic Link Library. This means that, as opposed to a static library, a DLL allows the programmer to decide on when and how other applications will be linked to this type of library.

For example, a DLL allows difference applications to use its library as they see fit and as necessary. In fact, applications created on different programming environments can use functions or resources stored in one particular DLL. For this reason, an application dynamically links to the library.
**Step 1:** Let us look into a simple example by creating a new Win32 Project.
**Step 2:** In the Application Type section, click the DLL radio button.

![Win32 Application Wizard - MFCDynamicLib](image)

**Step 3:** Click Finish to continue.

**Step 4:** Add the following functions in MFCDynamicLib.cpp file and expose its definitions by using:

```c
extern "C" _declspec(dllexport)
```

**Step 5:** Use the _declspec(dllexport) modifier for each function that will be accessed outside the DLL.

```c
// MFCDynamicLib.cpp : Defines the exported functions for the DLL application.
//

#include "stdafx.h"

extern "C" _declspec(dllexport) double Min(const double *Numbers, const int Count);
extern "C" _declspec(dllexport) double Max(const double *Numbers, const int Count);
```
extern "C" _declspec(dllexport) double Sum(const double *Numbers, const int Count);

extern "C" _declspec(dllexport) double Average(const double *Numbers, const int Count);

extern "C" _declspec(dllexport) long GreatestCommonDivisor(long Nbr1, long Nbr2);

double Min(const double *Nbr, const int Total)
{
    double Minimum = Nbr[0];
    for (int i = 0; i < Total; i++)
    {
        if (Minimum > Nbr[i])
            Minimum = Nbr[i];
    }
    return Minimum;
}

double Max(const double *Nbr, const int Total)
{
    double Maximum = Nbr[0];
    for (int i = 0; i < Total; i++)
    {
        if (Maximum < Nbr[i])
            Maximum = Nbr[i];
    }
    return Maximum;
}

double Sum(const double *Nbr, const int Total)
{
    double S = 0;
    for (int i = 0; i < Total; i++)
    {
        S += Nbr[i];
    }
    return S;
}

double Average(const double *Nbr, const int Total)
{
    double avg, S = 0;
    for (int i = 0; i < Total; i++)
    {
        S += Nbr[i];
    }
    avg = S / Total;
    return avg;
}
long GreatestCommonDivisor(long Nbr1, long Nbr2)
{
    while (true)
    {
        Nbr1 = Nbr1 % Nbr2;
        if (Nbr1 == 0)
            return Nbr2;
        Nbr2 = Nbr2 % Nbr1;
        if (Nbr2 == 0)
            return Nbr1;
    }
}

**Step 6:** To create the DLL, on the main menu, click **Build > Build MFCDynamicLib** from the main menu.

**Step 7:** Once the DLL is successfully created, you will see a message display in output window.
Step 8: Open Windows Explorer and then the Debug folder of the current project.

Step 9: Notice that a file with dll extension and another file with lib extension has been created.

Step 10: To test this file with dll extension, we need to create a new MFC dialog based application from File -> New --> Project.
Step 11: Go to the MFCDynamicLib\Debug folder and copy the *.dll and *.lib files to the MFCLibTest project as shown in the following snapshot.
Step 12: To add the DLL to the current project, on the main menu, click Project -> Add Existing Item and then, select MFCDynamicLib.lib file.

Step 13: Design your dialog box as shown in the following snapshot.
**Step 14:** Add value variable for both edit controls of value type double.
**Step 15:** Add value variable for Static text control, which is at the end of the dialog box.

![Add Member Variable Wizard](image)

**Step 16:** Add the event handler for Calculate button.

**Step 17:** In the project that is using the DLL, each function that will be accessed must be declared using the _declspec(dllexport) modifier.

**Step 18:** Add the following function declaration in MFCLibTestDlg.cpp file.

```cpp
extern "C" _declspec(dllexport) double Min(const double *Numbers, const int Count);
extern "C" _declspec(dllexport) double Max(const double *Numbers, const int Count);
extern "C" _declspec(dllexport) double Sum(const double *Numbers, const int Count);
extern "C" _declspec(dllexport) double Average(const double *Numbers, const int Count);
extern "C" _declspec(dllexport) long GreatestCommonDivisor(long Nbr1, long Nbr2);
```
**Step 19:** Here is the implementation of button event handler.

```cpp
void CMFCLibTestDlg::OnBnClickedButtonCal()
{
    // TODO: Add your control notification handler code here
    UpdateData(TRUE);

    CString strTemp;
    double numbers[2];
    numbers[0] = m_Num1;
    numbers[1] = m_Num2;
    strTemp.Format(L"%.2f", Max(numbers, 2));
    m_strText.Append(L"Max is:\t" + strTemp);

    strTemp.Format(L"%.2f", Min(numbers, 2));
    m_strText.Append(L"\nMin is:\t" + strTemp);

    strTemp.Format(L"%.2f", Sum(numbers, 2));
    m_strText.Append(L"\nSum is:\t" + strTemp);

    strTemp.Format(L"%.2f", Average(numbers, 2));
    m_strText.Append(L"\nAverage is:\t" + strTemp);

    strTemp.Format(L%d", GreatestCommonDivisor(m_Num1, m_Num2));
    m_strText.Append(L"\nGDC is:\t" + strTemp);

    UpdateData(FALSE);
}
```
Step 20: When the above code is compiled and executed, you will see the following output.

Step 21: Enter two values in the edit field and click Calculate. You will now see the result after calculating from the DLL.